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Typographic Conventions

Typographic Conventions

Type Style Description

Example Words or characters quoted from the screen. These include field names, screen titles,
pushbuttons labels, menu names, menu paths, and menu options.
Textual cross-references to other documents.

Example Emphasized words or expressions.

EXAMPLE Technical names of system objects. These include report names, program names,
transaction codes, table names, and key concepts of a programming language when they
are surrounded by body text, for example, SELECT and INCLUDE.

Example Output on the screen. This includes file and directory names and their paths, messages,
names of variables and parameters, source text, and names of installation, upgrade and
database tools.

Example Exact user entry. These are words or characters that you enter in the system exactly as
they appear in the documentation.

<Example> Variable user entry. Angle brackets indicate that you replace these words and characters
with appropriate entries to make entries in the system.

EXAMPLE Keys on the keyboard, for example, F2  or ENTER .
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1 Introduction

The SAP Business One Administrator's Guide, version for SAP HANA provides a central point of guidance for the
technical implementation of SAP Business One, version for SAP HANA. Use this guide for reference and
instructions before and during the implementation project.

 Note
Visit sappartneredge.com and select SAP Business One in your profile to ensure you receive the latest
information about SAP Business One directly on your home page.

1.1 Application Architecture

SAP Business One, version for SAP HANA is a client-server application that comprises a fat client and a database
server. The SAP Business One schema not only stores data, but also uses triggers, as well as views, especially for
reporting and upgrade purposes.
As more customers require Business Intelligence (BI), SAP introduced the SAP High-Performance Analytical
Appliance (HANA) technology to SAP Business One. SAP HANA technology relies on main memory for computer
data storage, providing faster and more predictable performance than database management systems that
employ a disk storage mechanism.
The following figure provides an overview of the architecture of SAP Business One, version for SAP HANA:

SAP Business One, version for SAP HANA Architecture

http://sappartneredge.com/
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1.2 Application Components Overview

This section provides a description of the software components of SAP Business One, version for SAP HANA and
how they are used by the business processes of SAP Business One.

1.2.1 Server Components

The following figure illustrates the server architecture of SAP Business One, version for SAP HANA:

SAP Business One Server Architecture, version for SAP HANA

Some server components are essential to the system landscape and are thus mandatory, while the others are
optional and you can install them if there's a business need.
Similarly, some of the server components are Linux-based, while the others are Windows-based.

Linux-Based Server Components

Component Description Mandatory?

SLD (System
Landscape
Directory)

Authenticates users and manages an entire SAP Business One
landscape. Precondition for all other components.

Yes

License Service Manages license requests. Yes

Extension Manager Manages deployment of lightweight add-ons and apps powered
by SAP HANA.

No

Job Service Manages alert settings and SBO Mailer settings on the server
side.

No
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Component Description Mandatory?

The SBO Mailer allows you to send documents directly from the
client application through email.

Mobile Service Enables you to use mobile apps (for example, SAP Business One
Sales) based on the Service Layer.

No

App Framework Enables you to build server applications that run on SAP HANA
without the need for additional application servers.

Yes

Backup Service Enables you to export and import company schemas, as well as
backing up and recovering SAP HANA database instances.

No

SAP Business One
Server

· Common database SBOCOMMON that holds system data,
version information, and upgrade information.
Unlike company schemas, SBOCOMMON does not store any
business or transactional data.

· Shared folder b1_shf that contains central configuration
data as well as installation files for various client components.

Yes

· Online help files in all supported languages.
· Demo databases for various localizations.
· Microsoft Outlook integration server, which includes

Microsoft Office templates required for the Microsoft Outlook
integration add-on and the standalone version.

No

Analytics Platform Includes various analytics features powered by SAP HANA (for
example, enterprise search).

Yes

Service Layer An application server that provides Web access to SAP Business
One services and objects.

No

Windows-Based Services and Server Components

Component Description Mandatory?

Browser Access
Service

Enables you to access the SAP Business One client application in
a Web browser.

No

Workflow Service Enables you to implement user-defined business processes. No

Data Interface
Server (DI Server)

Supports high-volume data integration and enables multiple
clients to access and manipulate SAP Business One company
schemas.

No

Integration
Framework

A set of business scenarios that enable integration of the SAP
Business One application with third-party software and mobile
devices.
The integration packages include:
· Mobile Solution
· DATEV HR (Germany only)
· Electronic Invoices (Mexico only)

No
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Component Description Mandatory?

· Support for Document Approval (Portugal only)
· Support for SAP Customer Checkout
· Support for SAP Anywhere

Remote Support
Platform (RSP)

Proactively monitors the health of an SAP Business One
installation and provides automated healing, backup support, and
download of software patches.

Yes

1.2.2 Client Components

The following figure illustrates the client architecture of SAP Business One, version for SAP HANA:

SAP Business One Client Architecture, version for SAP HANA

Component Description Mandatory?

SAP Business One
Client

The application executable. You can also install the client
application on a terminal server or in a Citrix environment.

Yes

SAP Business One
Client Agent

· Performs actions that require administrator rights on the
local system (for example, upgrading the SAP Business One
client and add-ons).

· Moves SAP Business One log files to the central log folder in
the shared folder.

Yes
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Component Description Mandatory?

 Note
The client agent is part of the client installation process
and is installed by default.

DI API Data interface API, a COM-based API and an applicative DLL file
(OBSever.dll) that enables add-ons to access and use SAP
Business One business objects.

Yes

UI API User interface API, a COM-based API that is connected to the
running application and which enables add-ons to perform
runtime manipulation and enhancement of the SAP Business One
GUI and its flow.

Yes

Excel Report and
Interactive Analysis

Enables you to create or view reports in Microsoft Excel based on
deployed semantic layers.

No

Software
Development Kit

Documentation and samples for the SAP Business One SDK. No

DTW Data transfer workbench which enables importing and updating
data in large volumes.

No

SAP Business One
Studio Suite

An integrated development environment based on the Microsoft
.NET Framework, which supports you in developing extensions on
top of SAP Business One.

No

1.2.3 Compatibility Between 32-bit and 64-bit Components
and Applications

Both 32-bit and 64-bit versions are available for some SAP Business One client components. As a general rule, 32-
bit components work with 32-bit components and external applications; 64-bit components work with 64-bit
components and external applications.

SAP HANA Database Client

To communicate with the SAP HANA database, you must install the SAP HANA database client on your
workstations, and the client must be the same version as the SAP Business One components. For example, for the
32-bit SAP Business One client and 32-bit DTW, you must install the 32-bit SAP HANA database client.

SAP Business One Client

While it is possible to install and run both versions of SAP Business One client on the same machine running a 64-
bit operating system, in order to reduce complexity and avoid potential problems during future upgrades, we
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strongly recommend that you install only one version of the SAP Business One client application on the same
machine.
A 64-bit SAP Business One client can work only with 64-bit add-ons; likewise, a 32-bit SAP Business One client
can work only with 32-bit add-ons.

Excel Report and Interactive Analysis

To install and use Excel Report and Interactive Analysis, you must ensure the following combination:

Microsoft Windows Operating
System

Microsoft Office Microsoft Visual Studio Tools for
Office Runtime

32-bit 32-bit 32-bit

64-bit 32-bit 64-bit

64-bit 64-bit

Data Transfer Workbench (DTW)

To use the DTW, you must ensure that the following components and external applications have the same system
type (for example, 32-bit):
· SAP Business One DI API
· SAP Business One DTW
· Microsoft Office
· [Applicable only if you have selected ODBC as the connection type) ODBC driver

If you are using a 64-bit operating system, ensure that you have added the data source (HDBODBC) in the
ODBC Data Source Administrator window of the correct system type.

 Note
Microsoft Windows 7 does not provide a menu entry for the ODBC Data Source Administrator (32-bit)
window. To open this window, open the odbcad32 file in the path C:\Windows\SysWOW64.

Microsoft Outlook Integration Add-on and Standalone Version

To use the Microsoft Outlook integration add-on or the standalone version, you must ensure that the following
components and external applications have the same system type (for example, 32-bit):
· SAP Business One DI API
· Microsoft Outlook integration add-on or the standalone version of SAP Business One
· Microsoft Office
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SAP Crystal Reports, Version for the SAP Business One Application

To use the SAP Business One add-ins in SAP Crystal Reports for SAP Business One, you must ensure that you
have installed the 32-bit DI API on the same machine.

1.3 Software Download

Download the SAP Business One product package (installation package or upgrade package) from the SAP
Support Portal, as follows:

Go to the SAP Business One Software Download Center on the SAP Support Portal at
https://support.sap.com/b1software.
Do one of the following:

To download an installation package, click Installation.
To download an upgrade package, click Updates.

Navigate to and select the relevant download objects.

 Note
The package may be divided into several download objects. In this case, select and download all objects
under the same patch level designation.

Add the selected objects to the download basket.
We recommend that you read the Info file for the selected download objects.
Download the selected objects from your download basket.
Extract files from the downloaded objects (archives) to your computer.

 Note
If you've downloaded the archives to a Linux machine and want to extract the files directly there, use
either of the following commands:
o If it is a single-part archive: unrar e <FileName>.rar
o If it is a multi-part (spanned) archive: unrar e <FileName>.part01.rar

This extracts files from all parts of the archive.
If you experience problems when downloading software, send a message to SAP as follows:

Go to the SAP Business One support center on sappartneredge.com.
In the left navigation panel, click Partner Support Dashboard.
Use SAP Message Wizard to write the message and assign it to component SBO-CRO-SUP.

 Note
If your download fails due to an unstable internet connection, try using the SAP Download Manager, which
supports resumable downloads. In the SAP Business One Software Center, first move your objects into
Download Basket and then download them with the SAP Download Manager. To install the SAP Download
Manager, click the Get the SAP Download Manager link in the left navigation pane.

https://support.sap.com/software/business-one.html
https://support.sap.com/b1software
http://sappartneredge.com/
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1.4 Related Documentation

In addition to the online help and the documentation within the product package (for example, this
Administrator's Guide and the License Guide), SAP Business One provides complementary documentation in the
form of how-to guides and SAP Notes.
The following tables list the documentation for system implementation, third-party development and integration.
You can search for functional how-to guides in the SAP Business One area on sappartneredge.com.

System Implementation

Topic Documentation Title Description Delivery Channel

Hardware
Configuration

How to Configure Hardware
Platforms for SUSE Linux
Enterprise Server

Provides instructions on how to
configure various certified
hardware models.

sappartneredge.com

Installation of
SLES Image
for SAP
Business One

How to Install SUSE Linux
Enterprise Server for SAP
Business One Products on
SAP HANA

Provides instructions on
installing the SUSE Linux
Enterprise Server using the
slesb14hana image (tailored to
SAP Business One needs) and
installing SAP HANA and SAP
Business One using the SAP
Product Installer.

sappartneredge.com

Browser
Access setup

How to Deploy SAP Business
One with Browser Access

Provides instructions such as
how to set up the Browser
Access service so that users can
work with SAP Business One in a
Web browser in the office or
from outside the office.

sappartneredge.com

SAP HANA
Modeling

How to Export and Package
SAP HANA Models for SAP
Business One

Provides a model packaging tool
and a guide.

SAP Note 2008991 and
sappartneredge.com

SQL
Converter

How to Convert SQL from the
Microsoft SQL Server
Database to the SAP HANA
Database

Includes the SQL converter tool
and a guide.
The guide describes how to
convert structured query
language (SQL) in the Microsoft
SQL Server database (using T-
SQL grammar) to SQL that can
be used in the SAP HANA™
database (using ANSI-SQL
grammar) using the SQL
converter.

sappartneredge.com,
Customer Portal, and
SCN

http://sappartneredge.com/
http://sappartneredge.com/
http://sappartneredge.com/
http://sappartneredge.com/
https://service.sap.com/sap/support/notes/2008991
http://sappartneredge.com/
http://sappartneredge.com/
http://service.sap.com/smb/sbocustomer/documentation
http://scn.sap.com/community/business-one/blog/2013/04/10/how-to-convert-sql-from-ms-sql-server-to-sap-hana
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Topic Documentation Title Description Delivery Channel

Pervasive
Analytics

How to Work with Pervasive
Analytics

Provides instructions on how to
use the following tools:

Key Performance Indicators
(KPIs)
Pervasive dashboard
Advanced dashboard

sappartneredge.com
and Customer Portal

Excel Report
and
Interactive
Analysis

How to Work with Excel
Report and Interactive
Analysis

Provides information about Excel
Report and Interactive Analysis
and step-by-step instructions of
the designer.

sappartneredge.com
and the Excel Report
and Interactive Analysis
add-in Help menu in
Microsoft Excel

Mobile
solution

How to Work with SAP
Business One Sales, mobile
app for iOS
How to Work with SAP
Business One Sales, mobile
app for Android

With the SAP Business One
Sales app you can work with
activities, view business content,
manage customer data, monitor
sales opportunities, and much
more.

sappartneredge.com

High
Availability

SAP Business One, version
for SAP HANA High
Availability Installation Guide

Includes a manual failover script,
configuration files and a guide.
This high-availability solution is
based on the slesb14hana
image.

SAP Note 1944415 and
sappartneredge.com

SAP HANA High Availability
Guide for SAP Business One

Includes an automatic setup &
failover script, configuration files
and a guide.
This solution is based on the
standard SUSE Linux Enterprise
Server for SAP Applications.

SAP Note 1944415 and
sappartneredge.com

Third-Party Development

Topic Documentation Title Description Delivery Channel

Service
Layer

Service Layer API
Reference

Documents all entities and
actions exposed through
the Service Layer API.

https://<Load Balancer
Address>:<Load Balancer
Port>/index.html

Working with SAP
Business One Service
Layer

Describes the basic
usages of SAP Business
One Service Layer and
explains the technical
details of building a stable
and scalable Web service

https://<Load Balancer
Address>:<Load Balancer
Port>/index.html,
sappartneredge.com and Customer
Portal

http://sappartneredge.com/
http://service.sap.com/smb/sbocustomer/documentation
http://sappartneredge.com/
http://sappartneredge.com/
https://service.sap.com/sap/support/notes/1944415
http://sappartneredge.com/
https://service.sap.com/sap/support/notes/1944415
http://sappartneredge.com/
http://sappartneredge.com/
http://service.sap.com/smb/sbocustomer/documentation
http://service.sap.com/smb/sbocustomer/documentation
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Topic Documentation Title Description Delivery Channel

using SAP Business One
Service Layer.

App
Framework

Working with App
Framework for SAP
Business One

Describes how to set up
your SAP Business One
App development
environment and how to
develop, package and
deploy your apps.

sappartneredge.com and Customer
Portal

Semantic
Layers

How to Work with
Semantic Layers

Includes a reference guide
and a how-to guide for
working with semantic
layers.

sappartneredge.com and Customer
Portal

Workflow How to Configure the
Workflow Service and
Design the Workflow
Process Templates

The package “How to
Configure the Workflow
Service” includes the
following:
· A  how-to guide for

working with the
workflow function

· An API reference
document

· Some workflow
samples

sappartneredge.com and Customer
Portal

Integration Framework

Topic Documentation Title Delivery Channel

Mobile
Solution

· User Guide: SAP Business One mobile app for
iOS

· User Guide: SAP Business One mobile app for
Android

sappartneredge.com and within the
mobile app

DATEV HR Leitfaden zur Personalabrechnung mit DATEV HR
(German only)

Product package: \Documentation\B1
Integration Component\DATEV-
HR\DATEV-HR.pdf

Electronic
Invoices

MX - Electronic Documents (CFDI Model) SAP Note 1580236

Support for
Document
Approval

PT - Electronic communication of transport
documents and invoices to tax authority

SAP Note 1886319

Support for
SAP

Integration with SAP Customer Checkout To display the guide in the integration
framework, choose Scenarios ® Control

http://sappartneredge.com/
http://service.sap.com/smb/sbocustomer/documentation
http://sappartneredge.com/
http://service.sap.com/smb/sbocustomer/documentation
http://service.sap.com/smb/sbocustomer/documentation
http://sappartneredge.com/
http://service.sap.com/smb/sbocustomer/documentation
http://sappartneredge.com/
https://service.sap.com/sap/support/notes/1580236
https://service.sap.com/sap/support/notes/1886319
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Topic Documentation Title Delivery Channel

Customer
Checkout

and for sap.CustomerCheckout, choose
the Docu button.

Important SAP Notes

SAP Note Title Remarks

2216144 Central Note for SAP Business One 9.2, version for
SAP HANA

References Overview Notes of all 9.2
patch levels and some other important
SAP Notes.

2216195 Release Update Note for SAP Business One 9.2,
version for SAP HANA

Describes limitations that exist in release
9.2.

2216208 Collective Note for SAP Business One 9.2, version
for SAP HANA Upgrade Issues

References SAP Notes that describe
issues that you may encounter during the
upgrade to release 9.2.

2216266 Collective Note for SAP Business One 9.2, version
for SAP HANA General Issues

References SAP Notes that describe
general issues of release 9.2 that are
neither limitations nor about upgrade.

2027458 Collective Consulting Note for HANA-related Topics
of SAP Business One, version for SAP HANA

References important SAP Notes for SAP
HANA-related topics, for example, a
troubleshooting guide and a schema
import/export guide.

1602674 SAP Business One mobile app for iOS -
Troubleshooting and compatibility information

Provides troubleshooting guidance for
setting up or using the SAP Business One
mobile app for iOS.

1924930 SAP Business One mobile app for Android -
Troubleshooting and compatibility information

Provides troubleshooting guidance for
setting up or using the SAP Business One
mobile app for Android.

https://service.sap.com/sap/support/notes/2216144
https://service.sap.com/sap/support/notes/2216195
https://service.sap.com/sap/support/notes/2216208
https://service.sap.com/sap/support/notes/2216266
https://service.sap.com/sap/support/notes/2027458
https://service.sap.com/sap/support/notes/1602674
https://service.sap.com/sap/support/notes/1924930
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2 Prerequisites

Before installing SAP Business One, version for SAP HANA, ensure that you have fulfilled certain prerequisites.
For compatibility information regarding SAP Business One and SAP Business One Cloud, see SAP Note 1756002.

2.1 Host Machine Prerequisites

 Recommendations
o For security reasons, we recommend that you set up a strong password for the SYSTEM user right

after installing the SAP HANA database server. Alternatively, as a safer option, create another
database user account as a substitute for the SYSTEM user. For the required database privileges, see
Database Privileges for Installing, Upgrading, and Using SAP Business One.

o Do not run third-party Tomcat Web applications on the host machine.
o Assign a static IP address to the host machine where the SAP HANA database server and the SLD

service will be installed.

Hardware Platform

· Ensure that your hardware platform is certified by SAP Business One. To configure your hardware platform,
follow the instructions in the guide attached to SAP Note 1944415.
For more information, see the Platform Support Matrix for SAP Business One, version for SAP HANA on
sappartneredge.com.

· Ensure that you have assigned the appropriate hostname and IP address to the Linux server before installing
SAP HANA and SAP Business One, version for SAP HANA. After the installation, do not change the hostname
and IP address unless necessary.
If you are forced to change the hostname or IP address (for example, due to company policy) of the SAP
HANA server, follow the instructions in SAP Note 1780950 to reconfigure SAP HANA.

· If you have been using SAP Business One (SQL) in conjunction with SAP Business One analytics powered by
SAP HANA, and plan to migrate your company databases to SAP HANA, you cannot simply reuse your
existing SAP HANA server. Instead, you must first use the sizing tool for SAP Business One, version for SAP
HANA to resize your company databases and determine the hardware requirements. According to the sizing
results, you may need to upgrade your SAP HANA server.
You can find the sizing tool for SAP Business One, version for SAP HANA on sappartneredge.com.

Software and Libraries

Ensure that the following components and libraries are installed on the Linux server:

http://service.sap.com/sap/bc/bsp/spn/smb_searchnotes/display2.htm?note_langu=E&note_numm=1756002
https://service.sap.com/sap/support/notes/1944415
http://sappartneredge.com/
https://service.sap.com/sap/support/notes/1780950
http://sappartneredge.com/
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Installation Notes

Operating System:
SUSE Linux Enterprise Server
(SLES):
· 11 SP3 (x86_64)
· 11 SP4 (x86_64)

Note that the SLES image for SAP Business One is to be used only for
installation and not for upgrade. You can upgrade your operating
system by way of online updates, or you can contact your hardware
vendor or SUSE for support.
For information about recommended OS settings, refer to SAP Notes
1954788 (for SLES 11 SP3) and 2240716 (for SLES 11 SP4).
If you use the XFS file system, be sure to read SAP Note 2314126 and
ensure the proper Kernel version.

SAP HANA Platform Edition
1.0 SPS 11 Revision 112.03

When installing a newly certified HANA appliance with a recommended
HANA revision, the installation may not succeed because of failed
hardware checks. You can refer to SAP Note 1658845 for the solution.
Additional operating system software packages are required for SAP
HANA SPS 11. Please refer to SAP Note 2228351 for details.

 Caution
For a single, productive SAP HANA appliance, multiple SAP
HANA database instances (SIDs) are not supported. For more
information, see SAP Note 1681092.
When performing a fresh installation of the SAP HANA
database, be sure to select "single container" for the database
mode.

For more information about installing SAP HANA, see the SAP HANA
installation guides on SAP Help Portal at
http://help.sap.com/hana_platform.

Application function libraries
(AFLs)

The AFLs must be the same version as the SAP HANA server.

 Note
You can install the AFLs only after installing the SAP HANA
server. However, if you need to upgrade the SAP HANA server
later, you must upgrade the AFLs first.
In addition, in versions lower than release 9.1 PL08, you must
assign the following roles to the PUBLIC role:
o AFL__SYS_AFL_AFLPAL_EXECUTE

o AFL__SYS_AFL_AFLPAL_EXECUTE_WITH_GRANT_OPTION

For more information, see Database Role PAL_ROLE for
Pervasive Analytics.

64-bit version of SAP HANA
database client for Linux

For more information, see SAP HANA Client Installation Guide at
http://help.sap.com/hana_platform.

Samba Necessary for the shared folder b1_shf.

Samba-client

cron Necessary for the backup service.

https://service.sap.com/sap/support/notes/1954788
https://service.sap.com/sap/support/notes/2240716
https://service.sap.com/sap/support/notes/2314126
https://service.sap.com/sap/support/notes/1658845
https://service.sap.com/sap/support/notes/2228351
https://service.sap.com/sap/support/notes/1681092
http://help.sap.com/hana_platform
http://help.sap.com/hana_platform
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Installation Notes

nfs-kernel-server

zip Necessary for the backup service and the common database
SBOCOMMON.

nfs-client Necessary for any SAP HANA server that requires to be backed up
using the backup service.

unzip None.

bind-utils None

curl None

net-tools None

gawk None

coreutils None

bash None

perl None

SuSEfirewall2 None

Third-party libraries Various third-party libraries are required for the installation and
execution of SAP Business One server components. During the
installation, if any of the libraries do not meet the minimum version
requirement, the setup wizard will prevent you from proceeding. For a
list of the prerequisite libraries and their required versions, see
Appendix 1: List of Prerequisite Libraries for Server Component
Installation.

 Caution
Do not use OpenSSL versions from 1.0.1 through 1.0.1f
(inclusive). These versions are affected by the Heartbleed Bug.
Do not use glibc versions below 2.11.3-17.74.13. These
versions are affected by the GHOST (gethostbyname)
vulnerability.

Ports

Ensure that you have kept the following ports available:
· For SAP HANA services: 3xx00 to 3xx20 and 5xx13 (where xx represents the SAP HANA instance number)
· To use the app framework: 43xx for SSL-encrypted communication or 80xx (where xx represents the SAP

HANA instance number)



22
CUSTOMER
© 2016 SAP SE or an SAP affiliate company. All rights reserved.

SAP Business One Administrator’s Guide, version for SAP HANA
Prerequisites

 Example
If you intend to install the server tools on SAP HANA instance 00, you should ensure port 4300 or 8000 is
not being used by other applications.

· 40000, 40001: 40000 is the default port number for all the SAP Business One services (except for the app
framework) on Linux. If you want to use the default port number, ensure that this port is also available.
In addition, if you are using port X, make sure that you open both port X and port (X+1). For example, if you
are using port 40000, you must also open port 40001.

Script Server

You have started the script server, as follows:
To access the SAP HANA administrative settings, in the SAP HANA studio, double-click the relevant SAP
HANA system.
On the Configuration tab, choose daemon.ini → scriptserver → instances and change the system value to 1.
Restart the SAP HANA instance. To do so, proceed as below:

Log on as the <sid>adm user (for example, ndbadm) or switch to this user by entering the following
command: su - <sid>adm.
Stop the SAP HANA instance using the command: HDB stop.
Start the SAP HANA instance using the command: HDB start.

2.2 Client Workstation Prerequisites

· For information on hardware and software requirements on client workstations, search for the following
documents on sappartneredge.com:
o SAP Business One, version for SAP HANA Platform Support Matrix
o SAP Business One Hardware Requirements Guide

· If you already have SAP Crystal Reports installed on your computer, first uninstall the software and then
follow the installation procedures described in the section Installing SAP Crystal Reports, version for the SAP
Business One Application.

· You have installed Microsoft .NET Framework 4.5.2.

 Note
If you do not have Microsoft .NET Framework 4.5.2 installed, it is installed during the SAP Business One
installation process. However, you will have to restart your machine. To avoid a restart, you may choose
to install the framework before starting the SAP Business One installation.

· To install and use Excel Report and Interactive Analysis, ensure that you have installed the following:
o Microsoft Excel 2010 or 2013
o Microsoft .Net Framework 4.5.2
o Microsoft Visual Studio 2010 Tools for Office Runtime

If you do not have Microsoft Visual Studio 2010 Tools for Office Runtime installed, it is also installed
during the installation process of Excel Report and Interactive Analysis.
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· To display Crystal dashboards in the SAP Business One client application, ensure you have installed Adobe
Flash Player for the embedded browser Google Chrome on each of your workstations. You can download
Adobe Flash Player at http://www.adobe.com.

 Note
The download link provided by Adobe is by default for Microsoft Internet Explorer. To download Adobe
Flash Player for other browsers, choose to download for a different computer, and then select the correct
operating system and a Flash Player version for other browsers.

· You have installed the SAP HANA client with the same operating system type as that of the SAP Business One
components. For more information, see SAP HANA Client Installation Guide at
http://help.sap.com/hana_platform.

 Note
You must ensure that the same operating system types installed for the SAP Business One client and
Microsoft Excel are available for the SAP HANA database client. Therefore, if you have installed a 64-bit
version of SAP Business One client and the 32-bit version of Microsoft Excel, you must install both a 32-
bit and a 64-bit SAP HANA database client.

· If you want to access the System Landscape Directory service, be sure to use one of the following Web
browsers:
o Microsoft Internet Explorer 8 or later
o Mozilla Firefox 9 or later
o Google Chrome 12 or later

· If you want to access SAP Business One in a Web browser, be sure to use one of the following Web browsers:
o Mozilla Firefox
o Google Chrome
o Microsoft Edge
o Apple Safari (Mac and IPad)

2.3 Latency and Bandwidth Requirements

All SAP Business One components must be installed in the same LAN (local area network). Putting the client and
the server into two different locations (for example, VPN) will have an impact on the performance of SAP Business
One. Thus, latency should be as low as possible (< 1 ms).
The same LAN means:
· Sufficient bandwidth > 100 M
· Small latency < 1 ms
· Same WINS server
· Same local DNS server, if configured
· Same AD server, if AD is being used

For users outside the LAN of the server (for example, those using VPN connection), we recommend that you use a
remote desktop or the SAP Business One Browser Access service to access the SAP Business One client instead
of installing the SAP Business One client directly.

http://www.adobe.com/
http://help.sap.com/hana_platform
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For SAP HANA system replication scenarios, please refer to the Network Bandwidth for SAP HANA System
Replication document for details on the network requirements (among other things, bandwidth and latency).

2.4 Constraints

You can run SAP Business One, version for SAP HANA for 31 days without a license. To continue working with the
application after 31 days, you must install a valid license key assigned by SAP. For more information, see the
License Guide for SAP Business One 9.2, version for SAP HANA, which is available in the product package
(\Documentation\SystemSetup\LicenseGuide.pdf).

 Note
If you are a partner, you can also download the guide on sappartneredge.com.

There are certain constraints on the analytics features:
· You cannot use analytics features in a trial company. In other words, you must have a valid license to use

analytics features powered by SAP HANA.
· The Support user cannot use analytics features.

For more information about the Support user, see User Types.
The demo databases (schemas) provided are not for productive use. The application supports 40 localizations in
its demo databases.

2.5 User Privileges

The following table summarizes the requirements and recommendations for the group setup of the supported
operating system:

Operation Operating System User Group

Server installation SUSE® Linux Enterprise Server Root

Installation of DI Server and
Workflow

Microsoft® Windows operating
systems

Administrator

Client installation Administrator

Client upgrade Administrator

Runtime Users

 Note
For more information about possible installer issues related to the user account control (UAC) in
Microsoft Windows operating systems, see SAP Note 1492196.

http://go.sap.com/docs/download/2016/02/d0abe09d-607c-0010-82c7-eda71af511fa.pdf
http://go.sap.com/docs/download/2016/02/d0abe09d-607c-0010-82c7-eda71af511fa.pdf
https://service.sap.com/sap/support/notes/1492196
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3 Installing SAP Business One, Version for
SAP HANA

The overall installation procedure of SAP Business One, version for SAP HANA is as follows:
On a Linux server, install Linux-based server components.
On a Windows server, install Windows-based server components.
On each workstation, install client components.

For demonstration or testing purposes, you can install all Windows-based components on the same Windows
computer. You can also install the SAP Business One client on a terminal server or in a Citrix environment.
To ensure high availability (recovery from disasters for business continuity) of your system, you can adopt either
of the high-availability solutions provided by SAP Business One. For more information, search for "high
availability" in the SAP Business One area on sappartneredge.com.

3.1 Installing Linux-Based Server Components

You must install the following components on a Linux server:
· SAP Business One server tools, version for SAP HANA, including the following:

o Landscape management components:
o System Landscape Directory (SLD)
o License manager
o Extension manager

o App framework
o Job service
o Mobile service

· Backup service
· SAP Business One server:

o Shared folder (b1_shf):
o Common database (SBOCOMMON):
o Demo databases: Demonstration databases (schemas) that include transactional data for your testing
o Online help files in all supported languages
o Add-ons

By installing the SAP add-ons as part of the server installation process, you register them to all
companies on the server. If you do not install them now, you will have to register the add-ons manually
later in the SAP Business One client.

o Microsoft Outlook integration server
· Analytics platform

http://www.sappartneredge.com/
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· Service Layer
You can install the Linux-based server components in one of the following modes:
· GUI mode
· Silent mode

Prerequisites

· You have installed the 64-bit version of the SAP HANA database client.
· You have the password of the Linux root user account.
· We recommend that you use a database user other than SYSTEM. To ensure that this database user has

appropriate database privileges, follow the instructions in Database Privileges for Installing, Upgrading and
Using SAP Business One.

· You have extracted or copied the following folders from the product package to the Linux server:
o Packages.Linux
o Prerequisites
o Packages/Server
o Packages/Client
o Packages/DI API
o Packages.x64/Client
o Packages.x64/DI API
o Packages/SAP CRAddin Installation

If you want to install demo databases, ensure to extract or copy /Packages/Server/Demo Databases as well.
Note that you must keep the original CD structure, with these folders in a separate parent folder.
If you have enough disk space, you can extract or copy the entire package to the Linux server.

· For successful backup of the server instance and export of company schemas, ensure the following:
o The backup location has free space that is at least three times the SAP HANA data size.

Note that you must regularly copy the server backups/schema exports to a storage location or medium
somewhere other than the SAP HANA server. This not only ensures the data safety but also ensures the
backup location has enough space for backup operations.

o The file system of the backup location was created with the intention of holding many small files and has a
reasonable number of index nodes (inodes) available. This is especially important if you intend to
schedule company schema export at short intervals.

 Recommendation
Use the "-T small" option when creating the file system. For example:
mke2fs -t ext3 -T small /dev/sda2

o The SAP system (sapsys) group ID can remain as the default value 79 or be specified with another ID
value for all SAP HANA servers that require to be backed up using the backup service. Make sure that all
SAP HANA servers in the same landscape share the same SAP system group ID value. For more
information about the groupid parameter, see the SAP HANA Administration Guide at
http://help.sap.com/hana_platform.

http://help.sap.com/hana_platform
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Dependencies Between Server Components

 Note
You can install all Linux-based SAP Business One server components together. However, if you want to
install them separately, you must install the System Landscape Directory first. The System Landscape
Directory is a precondition for all other server and client components.

Certain server components are dependent on other server components. When performing installation, you must
pay attention to the following dependencies, especially when performing the silent installation:
· The System Landscape Directory (SLD) is mandatory for all other components.
· The SAP Business One server depends on the existence of both the SLD and the license service.
· The app framework depends on the system schema SBOCOMMON and valid SBOCOMMOM registration in SLD is

required. Moreover, the pervasive analytics functions and the Fiori-style cockpit depend on the existence of
the app framework.

· The analytics platform depends on the system schema SBOCOMMON and valid SBOCOMMON registration in
SLD is required.

· The mobile service depends on the Service Layer.

 Note
As of release 9.2 PL02, the app framework and the backup service can be installed separately from the
SAP HANA database.

· The backup service requires the SBOCOMMON schema to exist in all the SAP HANA databases, local and
remote.

· The Service Layer depends on the existence of system schema SBOCOMMON and valid SBOCOMMON registration
in SLD is required.

3.1.1 Command-Line Arguments

The following table lists all the command-line arguments supported by the server components setup wizard:

Argument Description

-i Installs new components and upgrades existing components.

-r Reconfigures the settings, for example, uses a new IP address.

-u Uninstalls the application.

-va / --validate Validates that components are working properly.

-t <File Path> Creates a template property file which contains all parameters but no values.

 Note
The directory must already exist; otherwise, the template file cannot be
generated.
Although you can reuse a template for future patches, properties and
options may vary between patches.
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Argument Description

-d <Temporary
Folder>

Specifies a temporary folder for the installation (or upgrade, reconfiguration,
validation) instead of the default temporary folder (for example, /tmp).

silent -f <Property
File Path>

Loads input parameters from a specified property file.

--debug Sets installation in debug mode and creates log files with a higher verbosity level.
Different log files are generated depending on the installation status:
· Installation finished successfully: /<Installation

Folder>/logs/B1Installer_<TimeStamp>.log. For example,
/usr/sap/SAPBusinessOne/logs/B1Installer_201402191100.log).

· Installation did not finish correctly: <Temporary
Folder>/B1Installer.log. For example: /tmp/B1Installer.log.

As in GUI mode, sensitive information is not displayed on the console and is
hashed in the log file.

--mem-tomcat Sets a minimum memory requirement for installation or upgrade. By default a
5120-MB (5 GB) memory is required; if you intend to install only a few
components that do not require lots of memory (for example, the SLD and
license service), you may set a lower memory requirement. If the system
memory does not meet the requirement, installation or upgrade cannot proceed.
If the free memory is lower than the requirement, the setup program displays a
warning but you may choose to continue with the process. For example:
./install --mem-tomcat 2048M

A minimum of 2048 MB (2 GB) is still required for installation or upgrade.

-h Displays help information.

-v Displays the version of the installer.

3.1.2 Wizard Installation

The wizard installation requires a graphical environment. You can also install the Linux server components in the
interactive GUI mode remotely from a Windows computer with the aid of an X Server application.

 Note
Installation of the Service Layer is described in a separate chapter: Installing the Service Layer.

Procedure

The following procedure describes how to install all of the server components on a Linux server together (except
for the Service Layer). If you want to install the server components separately, refer to the “Dependencies
Between Server Components” section above to ensure successful installation. For more information about
command-line arguments that can also be used with the wizard installation, see Silent Installation.
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Log on to the Linux server as root.
In a command line terminal, navigate to the directory …/Packages.Linux/ServerComponents where the
install script is located.
Start the installer from the command line by entering the following command:
./install

The installation process begins.

 Note
If you receive an error message: “Permission denied”, you must set execution permission on the installer
script to make it executable. To do so, run the following command:
chmod +x install

In the welcome window of the setup wizard, choose the Next button.

In the Specify Installation Folder window, specify a folder in which you want to install the server components
and choose the Next button.
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In the Select Features window, select the features that you want to install, and choose the Next button.
You must install the System Landscape Directory and the license manager for landscape management.

 Note
If you want to use the analytical KPI function, you must install the app framework as well as the analytical
features. In addition, if you install the app framework, you must restart the SAP HANA instance after the
installation. The wizard will remind you to do so at the end of the installation process.

If a selected feature depends on system components which are missing (for example, programming libraries),
the installer prevents you from proceeding and displays the missing components. Similarly, an SAP Business
One server component may depend on another component (for example, the analytical features require the
system schema SBOCOMMON to exist on the same server); if the latter component is missing and not selected
for installation, the installer also prevents you from proceeding.
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In the Network Address window, select an IP address or use the hostname as the network address for the
selected components.
Note that if you install the SAP Business One components on the SAP HANA server machine and intend to
connect to a local SAP HANA instance, you must use the same IP address as the SAP HANA instance.

 Recommendation
Even if more than one network card is installed, use the same IP address for all components installed on
the same computer or use the hostname.
If you use different IP addresses for different components, the settings can be kept during the upgrade.
Nevertheless, if you need to reconfigure the system later, you can apply only one network address to all
local components.

In the Service Port window, specify a port number that is to be used by all of the services (except for the app
framework and Service Layer components) and choose the Next button. The default port number is 40000.

 Note
The port number must be within the 10000-65535 range.

 Caution
If you have installed a firewall on the server on which you install the server tools, make sure that the
firewall is not blocking the port number you use for the services.
In addition, if you are using port X, make sure that you open both port X and port (X+1) in the firewall. For
example, if you are using port 40000, make sure to also open port 40001.
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In the Site User Password window, create a password for the site user (B1SiteUser) and confirm the
password. Then choose the Next button.
For details on which special characters are not allowed for a site user password, see SAP Note 2330114.

 Recommendation
For security reasons, you should set a strong site user password, at least as strong as that defined in your
company’s password policy, and change it frequently.

For more information about site users, see Managing Site Users.
In the Specify Security Certificate window, specify a security certificate and choose Next.
You can obtain a certificate using the following methods:
o Third-party certificate authority - You can purchase certificates from a third-party global Certificate

Authority that Microsoft Windows trusts by default. If you use this method, select the Specify a PKCS12
certificate store and certificate password radio button and enter the required information.

o Certificate authority server - You can configure a Certificate Authority (CA) server in the SAP Business
One landscape to issue certificates. You must configure all servers in the landscape to trust the CA's root

https://service.sap.com/sap/support/notes/2330114
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certificate. If you use this method, select the Specify a PKCS12 certificate store and certificate password
radio button and enter the required information.

o [Not recommended] Generate a self-signed certificate - You can let the installer generate a self-signed
certificate; however, your browser will display a certificate exception when you access various service
Web pages, as the browser does not trust this certificate. To use this method, select the Use Self-Signed
Certificate radio button.

In the Database Server for System Landscape Directory window, specify the following information for the
System Landscape Directory and then choose the Next button:
o SAP HANA Server: Enter the SAP HANA server address (full hostname or IP address).
o Port: Enter the port number for your SAP HANA instance. The default port is 30015, where 00 represents

the SAP HANA database instance. If you want to use another instance, for example, the 01 instance, enter
it as follows: 30115.

o SLD Schema Name: Enter a name for the System Landscape Directory schema to be created.
o Database User Name and Password: Specify an SAP HANA database user and enter the user password.

 Recommendation
Do not use the SYSTEM user account. Instead use the database user account that you created as a
substitute for the SYSTEM user. For more information, see Database Privileges for Installing, Upgrading
and Using SAP Business One.
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Depending on the password policy of your SAP HANA database, you may need to change the initial password
for the database user upon first logon; if you have not, the installer prevents you from proceeding. For more
information about the force_first_password_change parameter, see the SAP HANA Administration
Guide at http://help.sap.com/hana_platform.
In the Backup Service Settings window, specify the following settings for the backup service:
o Backup Folder: Specify a folder to store server backups and company schema exports. Each company

schema will have a separate subfolder for its exports.
o Log File Folder: Specify a folder to store backup service log files.
o Working Folder: Specify a temporary folder where various backup operations are performed (for example,

compressing and decompressing files).

 Note
All three folders must be on the SAP HANA server machine; if the specified paths do not already exist, the
setup program will create them during the installation process.
The log file folder and the backup folder cannot be in the same parent directory; it is likewise for the log
file folder and the working folder. For example, you cannot specify /backup/logs for the log file folder
while specifying /backup/backups for the backup folder.

o [Recommended] Maximum Backup Folder Size (MB): Set an upper limit on the disk space used for storing
the server backups and company schema exports. If a new backup or export would cause the folder size
to exceed the limit, older backups or exports are deleted (moved to the trash), following the first-in-first-
out principle.

 Note
If you do not set a limit, you must set up a policy to regularly clean up old backups and exports. This is
especially important if you set up regular schedules of exporting your company schemas. For more
information, see Creating Export Schedules for Company Schemas.

o [Recommended] Compress company schema exports checkbox: This is relevant only for company
schema export. Select this checkbox to compress each company schema export into a zip file, which has
the following benefits:
o Reduces the size of the schema export.

http://help.sap.com/hana_platform
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o Keeps as many inodes available as possible - instead of tens of thousands of small files, there will be
just one zip file for each company schema export.

While this option reduces the eventual schema export size, it requires more disk space for export
operations. During the export process, the system requires both space for uncompressed export files and
space for compressing the export files; after export operations are complete, the uncompressed export
files are deleted permanently and only a compressed package is kept on the disk.

For more information, see Exporting Company Schemas.
In the SAP HANA Databases for Backup window, you can add or delete SAP HANA database servers for
backup.
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At least one SAP HANA database server must be specified for backup. The SAP HANA database server can be
on the same machine (local) as the backup service or on a different machine (remote).
To add an SAP HANA database server, choose Add and enter the connection information in the SAP HANA
Database window. Note that you must provide operating system credentials (for example, root user
credentials) for remote servers and the user must be a member of the root group.

If you chose to install or upgrade the app framework, the Restart Database Server window appears. Choose
one of the following options:
o Automatic Restart: Select this option to have the server restarted automatically after the setup process is

complete.
o Manual Restart: Select this option if you want to restart the server on your own. Note that you must

restart the SAP HANA server before you begin using the app framework.
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In the Windows Domain User Authentication (Single Sign-On) window, do one of the following:
o If you want to use the single sign-on function for SAP Business One, version for SAP HANA, select the Use

domain user authentication radio button, specify all required information, and choose the Next button.

 Note
The fully-qualified domain name must be the full name in upper case.
The domain user name is case-sensitive.
Make sure that the UTC time on your Linux server is the same as that on your Windows domain controller;
otherwise, you cannot proceed with the installation.

o If you have not registered a domain user account as the Service Principal Name (SPN), make sure that
the domain user account specified here is the one that you intend to use for SPN registration. For more
information, see Single Sign-On.

 Recommendation
As this domain user is a service user that functions purely for the purpose of setting up single sign-on, we
highly recommend that you create a new domain service user and do not assign any additional privileges
to the user other than the logon privilege. In addition, keep the user’s password unchanged after enabling
single sign-on; otherwise, single sign-on may stop working.

o If you do not want to use the single sign-on function, select the Do not need domain user authentication
radio button and choose the Next button.

 Caution
If you do not specify domain user information during installation of server tools, you will not be able to
activate the single sign-on function after installation. For more information, see Single Sign-On.

In the Review Settings window, review your settings carefully before proceeding to execute the installation. If
you need to change your settings, choose the Back button to go to relevant windows; otherwise, choose the
Install button to start the installation.
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If you want to save the current settings to a property file for a future silent installation, choose the Save
Settings button. For more information, see Silent Installation.

 Caution
The property file generated in this way does not contain the parameter
FEATURE_DATABASE_TO_REMOVE, which is required by silent uninstallation. You must manually add the
parameter to the property file before performing silent uninstallation.
Passwords will also be saved in the property file. We recommend that you delete the passwords from the
saved property file and enter the passwords manually before you perform the next silent installation.

In the Setup Progress window, when the progress bar displays 100%, proceed with one of the following
options:
o If all of the selected components installed successfully, choose the Next button to finish the installation.
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o If one or more components failed to be installed, choose the Roll Back button to restore the system. After
the rollback progress is complete, in the Rollback Progress window, choose the Next button to finish the
installation.
In addition, if you selected to install the system schema SBOCOMMON, you must delete it manually from the
SAP HANA server later.

In the Setup Process Completed window, review the installation results showing which components have been
successfully installed and which have not.

To exit the wizard, choose the Finish button.
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Results

Log

In the finish window, you can select the Log file or Log folder link to view the detailed installation log. The
installation log B1Installer_<Timestamp>.log (for example, B1Installer_201403281100.log) is stored
at <Installation Folder>/logs (for example, /usr/sap/SAPBusinessOne/logs); an additional log file
B1Installer_CurrentRun.log was also created for the current installation.
After the installation, you can check the runtime logs for various services at <Installation
Folder>/Common/tomcat/logs.

Service Users

SAP Business One services on Linux run under the SAP Business One service user B1service0; user permissions
for this user account should not be changed.
An operating system user b1techuser (repository access user) is created and used to move log files from client
machines to a central log folder in the shared folder b1_shf. You may change the user in the SLD by editing the
server information. The user must be either a local user or a domain user that has write permissions to the central
log folder (\b1_shf\Log) and read permissions to the entire shared folder.

Backup Service

The backup folder is by default located under the SAP HANA installation folder (typically
/hana/shared/backup_service/backups); the default backup log file folder is
/var/log/SAPBusinessOne/BackupService/logs. If required, you can change the backup folder in the System
Landscape Directory by editing the server information. For more information, see Registering Database Servers
on the Landscape Server.
An operating system user <sid>adm:sapsys (for example, ndbadm:sapsys) has been created on the machine
where the backup service is installed. All server backups and company schema exports are stored under the name
of this user.
The backup folder and the working folder are shared by the NFS server and are mounted on each SAP HANA
server. These mount points are not removed when you uninstall the backup service.
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If you want to register new SAP HANA database servers with the backup service after the installation or upgrade,
you must reconfigure the system. Note that the backup paths must be set properly to have successful server
backup. For more information, see Reconfiguring the System.
For any SAP HANA servers that are installed on a different machine than the backup service, you must perform
some manual steps to be able to delete older SAP HANA server backups directly from the SLD control center. For
instructions, see SAP Note 2272350.

Others

While validation is performed at the end of each installation and upgrade process, you can also perform validation
by yourself. For more information, see Validating the System.
After the installation or upgrade, you can reconfigure the system. For example, if you have changed the password
for the database user specified during the installation, you must update this information with SAP Business One;
or you may want to change the backup folder (which you can also change in the SLD). For more information, see
Reconfiguring the System.

3.1.3 Silent Installation

You can install (or upgrade) the Linux server components in silent mode using command-line arguments and
passing parameters from a pre-filled property file. To do so, enter the following command line:
install -i silent -f <Property File Path> [--debug]

Property File Format

In the property file, separate parameter values by a comma. The format is as below:
· Single value: Parameter=Value
· Multiple values: Parameter=Value, Value

 Example
SELECTED_FEATURES=B1ServerToolsTomcat, B1ServerToolsJava64

Parameters

 Note
If a component has already been installed and is up-to-date, the installer ignores the component even if
you include it in the selected features.

The table below lists all parameters that are required or supported:

Parameter Description

B1S_SAMBA_AUTOSTART Value options:
· none: Do not use this option; for internal use only.

https://service.sap.com/sap/support/notes/2272350
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Parameter Description

· true: Sets Samba to automatically restart after the
installation, which is required by the SAP Business One
server.

· false: You must restart Samba after installing the SAP
Business One server.

B1S_SHARED_FOLDER_OVERWRITE Value options:
· true: Overwrites the shared folder b1_shf if it already

exists.
· false

B1S_TECHUSER_PASSWORD The password for the repository access user. The setup program
automatically sets the value.

B1_SERVICE_GROUP The setup program automatically sets the values for these two
parameters.

B1_SERVICE_USER

BCKP_BACKUP_COMPRESS Optional parameter.
Value options:
· true: Compresses each company schema export into a zip

file to save disk space.
· false: Does not compress company schema exports.

BCKP_BACKUP_SIZE_LIMIT Optional parameter.
Sets an upper limit (measured in megabytes) on the overall size
of the backup folder. If the limit is exceeded, older server
backups and company schema exports are deleted following the
first-in-first-out principle.

BCKP_BACKUP_SIZE_LIMIT Optional parameter.
Sets an upper limit (measured in megabytes) on the overall size
of the backup folder. If the limit is exceeded, older server
backups and company schema exports are deleted following the
first-in-first-out principle.

BCKP_PATH_LOG Path to the folder where the log files for the backup service are
stored.

BCKP_PATH_TARGET Path to the folder where database server backups and company
schema exports are stored.
After installation, you can change the backup folder in the
System Landscape Directory by editing the server. For more
information, see Registering Database Servers on the
Landscape Server.

BCKP_PATH_WORKING Path to the temporary folder where various backup operations
are performed (for example, compressing and decompressing
files).

BCKP_HANA_SERVERS SAP HANA database servers that use the backup service.
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Parameter Description

Specify the parameter value in XML format, following the
example below:
BCKP_HANA_SERVERS=<servers><server><system
address="RemoteAddress"
user="root" password="root" /><database
port="30015" user="manager"
password="manager"/></server><server><system
address="LocalAddress"/><database port="30015"
user="manager"
password="manager"/></server></servers>

Note that the system user and password are mandatory for
remote systems and optional for local systems. As well, the user
must be a member of the root group.

HANA_DATABASE_ADMIN_ID <sid>adm user (for example, ndbadm).

HANA_DATABASE_ADMIN_PASSWD Password for the <sid>adm user.

HANA_DATABASE_SERVER SAP HANA database server address (hostname or IP address).

HANA_DATABASE_SERVER_PORT SAP HANA database port 3xx15, where xx represents the
instance number (for example, 30015).

HANA_DATABASE_USER_ID Name of an SAP HANA database user that has appropriate
privileges. For more information, see Database Privileges for
Installing, Upgrading and Using SAP Business One.

HANA_DATABASE_USER_PASSWORD Password for the SAP HANA database user.

 Note
You must have changed the initial password for the user
(for example, manager for the SYSTEM user) and the
password must comply with the password policy of the
particular instance. For more information, see the SAP
HANA Administration Guide at
http://help.sap.com/hana_platform.

HANA_SLD_DATABASE_NAME Name of the SLD schema that is to be created on the specified
SAP HANA database instance (for example, SLDDATA).

HANA_OPTION_RESTART Relevant only in the following situations:
· Installation/Upgrade: You select the app framework for

installation or upgrade.
· Uninstallation: You select the SSL-enabled app framework

for uninstallation.
Value options:
· true: Restarts SAP HANA after the installation (or upgrade,

uninstallation).
· false: You need to restart SAP HANA manually to apply the

changes.

http://help.sap.com/hana_platform
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Parameter Description

FEATURE_DATABASE_TO_REMOVE [Optional] For uninstallation only
Choose to remove one or more SAP Business One server
component schemas (not company schemas) during the
uninstallation. Note that a schema can be removed only if the
corresponding component is selected for uninstallation.

 Example
If you do not uninstall the SAP Business One server, the
SBOCOMMON schema cannot be removed and
FEATURE_DATABASE_TO_REMOVE=B1ServerCOMMOND
B is ignored.
If you include the following lines in the property file, the
SAP Business One server will be uninstalled along with
SBOCOMMON, while all demo databases (if any exist) will
be kept:
SELECTED_FEATURES=B1Server

FEATURE_DATABASE_TO_REMOVE=B1ServerCommonD
B

Value options:
· B1ServerToolsSLD: SLD schema

 Note
The parameter used for removing the SLD schema
before PL02 is
HANA_SLD_DATABASE_UNINSTALL_REMOVE (true,
false, none). If you reuse an old property file, we
strongly recommend that you remove the retired
parameter. Otherwise, if you specify
HANA_SLD_DATABASE_UNINSTALL_REMOVE=true,
even if
FEATURE_DATABASE_TO_REMOVE=B1ServerToolsSL
D does not exist in the property file, the SLD schema will
be removed. On the other hand,
HANA_SLD_DATABASE_UNINSTALL_REMOVE=none/fa
lse does not conflict with
FEATURE_DATABASE_TO_REMOVE=B1ServerToolsSL
D; if these parameters exist together, the retired
parameter is ignored.

· B1ServerCommonDB: SBOCOMMON schema
· B1ServerDemoDB_XX: A demonstration database (schema)

where "XX" represents the abbreviation of an SAP Business
One localization. For example, B1ServerDemoDB_US.
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Parameter Description

 Note
If you saved your previous installation settings using the
Save Settings option when running the server
components setup wizard in GUI mode, this parameter
was not among the saved settings. Before performing a
silent uninstallation, you must manually add this
parameter and specify its value. For more information,
see Wizard Installation.

INSTALLATION_FOLDER Installation folder (for example, /usr/sap/SAPBusinessOne)

INST_FOLDER_CORRECT_PERMISSIONS Value options:
· true: Grants required permissions on the installation folder.

Always use this option.
· false

LOCAL_ADDRESS The network address of the current machine.

SELECTED_FEATURES List of features that you want to install or upgrade.
Separate feature names with a comma; the order of the features
does not matter. If you do not specify a feature, all features will
be installed.
Value options:
· B1ServerTools: SAP Business One server tools

o B1ServerToolsLandscape: Landscape management
services
o B1ServerToolsSLD: System Landscape Directory
o B1ServerToolsLicense: License service, which

depends on the System Landscape Directory to be
installed

o B1ServerToolsJobService: Job service
o B1ServerToolsMobileService: Mobile service
o B1ServerToolsXApp: App framework
o B1ServerToolsEnxtensionManager: Extension

Manager
· B1BackupService: Backup service
· B1Server: SAP Business One server

o B1ServerSHR: Shared folder b1_shf
o B1ServerCommonDB: SBOCOMMON schema
o B1ServerDemoDB: Demonstration databases

o B1ServerDemoDB_XX: “XX” represents the
abbreviation of an SAP Business One localization.
For a list of localization abbreviations, see Appendix
3: List of Localization Abbreviations.
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Parameter Description

o B1ServerHelp: Online help files
o B1ServerHelp_XX: “XX” represents the

abbreviation of an SAP Business One localization.
o B1ServerAddons: SAP Business One add-ons
o B1ServerOI: Microsoft Outlook integration server

· B1AnalyticsPlatform: SAP Business One analytics
powered by SAP HANA

· B1ServiceLayerComponent: SAP Business One Service
Layer

SERVICE_PORT Port number for the System Landscape Directory (for example,
40000).

SITE_USER_ID Site user name that will be used to access the System
Landscape Directory (for example, B1SiteUser).

SITE_USER_PASSWORD Password for the specified site user.

SLD_CERTIFICATE_ACTION Certificate for HTTPS encryption.
Value options:
· self: Self-signed certificate
· p12: PKCS12 certificate

SLD_CERTIFICATE_FILE_PATH Path to the PKCS12 certificate.

SLD_CERTIFICATE_PASSWORD Password for the PKCS12 certificate.

SLD_SERVER_ADDR Landscape server address; needed when you install a feature
separately from the System Landscape Directory.

SLD_SERVER_PORT Landscape server port number; needed when you install a
feature separately from the System Landscape Directory.

SLD_SERVER_PROTOCOL Communications protocol for the System Landscape Directory.
Value options:
· none: Do no use this option; for internal use only
· http: Allowed for Cloud solutions only
· https: Always use this option for on-premises solutions

SLD_SERVER_TYPE System Landscape Directory type.
Value options:
· none: Do no use this option.
· op: On-premises solution
· od: Cloud solution

SLD_WINDOWS_DOMAIN_ACTION Value options:
· skip: Does not activate the single sign-on function.
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Parameter Description

· use: Activates the single sign-on function and requires the
following four parameter values; for more information, see
Single Sign-On.

SLD_WINDOWS_DOMAIN_CONTROLLER Windows domain controller.

SLD_WINDOWS_DOMAIN_NAME Fully-qualified domain name.

SLD_WINDOWS_DOMAIN_USER_ID Domain user name.

SLD_WINDOWS_DOMAIN_USER_PASSWORD Password for the domain user.

SL_LB_MEMBER_ONLY Value options:
· true: Installs only balancer members.
· false: Installs both the load balancer and balancer

members.

SL_LB_PORT Port for the Service Layer load balancer.

SL_LB_MEMBERS Service Layer load balancer members. Format: <Server
Name/IP Address>:<Port>,<Server Name/IP
Address>:<Port>… At least one load balancer member must
be specified.
· If the specified server is the machine on which you will

perform the installation, the balancer member is installed.
· If the specified server is a different machine, two situations

are possible:
o If you set SL_LB_MEMEBER_ONLY to true, the

installation will fail because remote installation is not
possible.

o If you set SL_LB_MEMBER_ONLY to false, the balancer
member will be added to the load balancer member pool
(cluster).

SL_THREAD_PER_SERVER Maximum number of threads to be run for each balancer
member.

3.2 Installing the Service Layer

The Service Layer is an application server that provides Web access to SAP Business One services and objects
and uses the Apache HTTP Server (or simply Apache) as the load balancer, which works as a transit point for
requests between the client and various load balancer members. The architecture of the Service Layer is
illustrated below (Note that the communication between the load balancer and the load balancer members is
transmitted via HTTP instead of HTTPS.):
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You may set up the Service Layer in one of the following ways:
· [Recommended] The load balancer and load balancer members are all installed on different physical

machines. Note that at least one load balancer member must be installed on the same machine as the load
balancer.

· The load balancer and all load balancer members are installed on the same machine.
Remote installation of the Service Layer is not supported. For example, if you intend to install the load balancer on
server A and two load balancer members on server B and C, you must run the server components setup wizard on
each server separately.
The installation order of the load balancer and load balancer members does not affect the functioning of the
Service Layer. However, we recommend that you create load balancer members first because you must specify
the information of load balancer members when installing the load balancer. Below is a simplified procedural
description for installing the Service Layer (load balancer and load balancer members).

Procedure

 Note
For more information about the silent installation of the Service Layer, see Silent Installation.

Log on to the Linux server as root.
In a command line terminal, navigate to the directory …/Packages.Linux/ServerComponents where the
install script is located.
Start the installer from the command line by entering the following command:
./install

The installation process begins.

 Note
If you receive an error message: “Permission denied”, you must set execution permission on the installer
script to make it executable. To do so, run the following command:
chmod +x install

In the welcome window of the setup wizard, choose the Next button.
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In the Specify Installation Folder window, specify a folder in which you want to install the Service Layer and
choose the Next button.
In the Select Features window, select Service Layer.
In the Specify Security Certificate window, specify a security certificate and choose the Next button. You can
also choose to use a self-signed certificate.
In the Database Server Specification window, specify the information of your SAP HANA database server.
In the Service Layer window, specify the following information for the Service Layer and then choose the Next
button:
o Install Service Layer Load Balancer and Port: Select the checkbox to install the load balancer and specify

the port for the load balancer.
When installing the load balancer, you need to specify the following information:
o Port for the load balancer
o Server name or IP address of all load balancer members, as well as their ports.

Note that the load balancer and load balancer members must use a different port for each if installed on
the same machine.

o Service Layer Load Balancer Members: Specify the server address and port for each load balancer
member.
If you have selected the Install Service Layer Load Balancer checkbox, you can specify load balancer
members either on local (current) or remote (different) machines. If on the local machine, the installer will
create a local load balancer member; if on a remote machine, the load balancer member will be added to
the pool (cluster) of load balancer members but you need to install the specific load balancer member on
its own server.
If you have not selected the checkbox, you cannot edit the server address, which is automatically set to
127.0.0.1 (localhost). All specified load balancer members will be created.

 Note
Ipv6 addresses are not allowed.

o Maximum Threads per Load Balancer Member: Define the maximum number of threads to be run for each
load balancer member.
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In the Review Settings window, review your settings and then choose the Install button to start the installation.
In the Setup Progress window, when the progress bar displays 100%, choose the Next button to finish the
installation.
In the Setup Process Completed window, review the installation results and then choose the Finish button to
exit the wizard.

Results

The Service Layer runs under the SAP Business One service user B1service0 as all other SAP Business One
services on Linux; user permissions for this user account should not be changed.
After installing the Service Layer, you can check the status of each balancer member in the balancer manager. To
do so, in a Web browser, navigate to https://<Load Balancer Address>:<Load Balancer
Port>/balancer-manager.
When installation is complete, the default Web browser on your server opens with links to various documentation
files (for example, the user guide and the API reference). The documentation files are stored in the
<Installation Folder>/ServiceLayer/doc/ folder. In addition, you can access the API help document for
the Service Layer in a Web browser from anywhere via this URL: https://<Load Balancer Address>:<Load
Balancer Port>. Note that only the following Web browsers are supported:
· Microsoft Internet Explorer 7 and higher
· Google Chrome
· Mozilla Firefox
· Apple Safari

 Note
The documentation URL is https://<Load Balancer Address>:<Load Balancer
Port>/b1s/docs/v1/index.html.
To upgrade the Service Layer to a higher patch level, run the server components setup wizard for the
required patch level. For more information, see Upgrading Server Components.
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3.3 Installing Windows-Based Server Components

You need to install the following components on the server:
· Server tools, including:

o Job service
o Workflow service
o Data interface Server

· Remote support platform
· Integration framework

If you want to enable access to the SAP Business One client in a Web browser, follow the instructions in Installing
the Browser Access Service.

Prerequisites

· You have installed the SLD.
· You have installed the SAP HANA database client for Windows on the Windows server on which you want to

install the optional server components.
· You have administrator rights on the machine on which you are performing the installation.

 Note
For more information about possible installer issues related to the user account control (UAC) in
Microsoft Windows operating systems, see SAP Note 1492196.

Procedure

A setup wizard is used for installation as well as for upgrade. The following procedure describes how to install all
Windows-based server components (except for the remote support platform and the browser access service) in a
clean environment where no SAP Business One components exist.

 Note
The installation of remote support platform is performed by a separate installation wizard. For more
information, see the Administrator’s Guide to the Remote Support Platform for SAP Business One. You
can find the guide (RSP_AdministratorGuide.pdf) under ...\Documentation\Remote Support
Platform\System Setup\ on the SAP Business One product DVD, or search for related information on
sappartneredge.com.

Navigate to the root folder of the product package and run the setup.exe file.
If you are using Windows Server 2008 or Windows 7, right-click the setup.exe file and choose Run as
administrator.
In the welcome window, select your setup language and choose Next.

http://service.sap.com/sap/bc/bsp/spn/smb_searchnotes/display2.htm?note_langu=E&note_numm=1492196
http://sappartneredge.com/
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In the Setup Type window, select Perform Setup and choose Next.

In the Setup Configuration window, select New Configuration and choose Next.
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In the System Landscape Directory window, select Connect to Remote System Landscape Directory, specify
the server, and choose Next.

In the Site User Logon window, enter the password for the site super user B1SiteUser and choose Next.
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In the Database Server Connection window, enter the database server information as follows:
Specify the database server type as HANADB.
From the Server Name dropdown list, select your SAP HANA server instance.
Choose Next.

In the Component Selections window, select the appropriate components and choose Next.
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For the integration framework, perform the following steps:
In the Integration Solution - Change Administration Password window, enter and confirm a new password
for the integration server administrator account (B1iadmin).

In the Integration Solution - B1i Database Connection Settings window, specify the following:
o Server Type: From the dropdown list, select HANA.
o Server Name: Enter the hostname or the IP address of the database server.
o Port: Specify the port for the database server.

The default port is 30015, where 00 represents the SAP HANA database instance. If you want to use
another instance, for example the 01 instance, enter it as follows: 30115.

o Database Name: Specify a name for the integration framework database. The default database name
is IFSERV.

o Database User ID: Enter the user name of a database administrator account.
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o Database Password: Enter the password for the database administrator account.

In the Integration Solution - Additional Information window, do the following:
o Enter the connection credentials.

Specify an SAP Business One user account (B1i by default) and password. This user account will be
used for DI calls.

o Select the version of SAP Business One DI API to use.
We recommend using the 64-bit SAP Business One DI API. For more information, see SAP Note
2066060.
If a version of DI API is not installed or is not selected for installation, that version of DI API is not
available for selection. If no DI API is selected or installed, you cannot proceed with the installation of
the integration framework.

https://b1-support.wdf.sap.corp/sap(bD1lbiZjPTAwMQ==)/bc/bsp/sno/ui_entry/entry.htm?param=69765F6D6F64653D3030312669765F7361706E6F7465735F6B65793D30313230303331343639303030303038363632373230313426
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In the Integration Solution - Scenario Packages window, select the corresponding checkboxes to activate
required scenario packages.

In the Review Settings window, review the settings you have made and choose Next.
This window provides an overview of the settings that you have configured for the setup process. To modify
any of the settings, edit the values in the table.
In the Setup Summary window, review the component list and choose Setup to start the setup process.
In the Setup in Process window, wait for the setup to finish.
Depending on the results of the upgrade, one of the following windows is displayed:
o Setup Result: Successful window: If the setup of all components was successful, the wizard opens this

window. To continue, choose Next.
o Setup Result: Errors window: If the setup of one or more components failed, the wizard opens this

window. To continue, choose Next, and then in the Restoration window, do either of the following:
o Select the failed component and proceed to start the restoration process.
o Choose Next to skip the restoration.

In the Congratulations window, choose Finish to close the wizard.

3.3.1 Installing the Browser Access Service

To enable access to SAP Business One in a Web browser, you must install the browser access service on a server
where the SAP Business One client is also installed.

 Recommendation
Reserve as much RAM as possible for the browser access service. For example, install the browser access
service on a separate Windows server or install the 32-bit SAP Business One client.

Compared with desktop access, browser access has certain limitations. For more information, see SAP Notes
2194215 and 2194233.

https://service.sap.com/sap/support/notes/2194215
https://service.sap.com/sap/support/notes/2194233
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Prerequisites

If you want to use a certificate for the HTTPS connection, ensure the following:
· You have specified the fully qualified domain hostname (FQDN) as the network address of the SLD.

If you did not, do either of the following:
o If your current SAP Business One version is 9.2, reconfigure the SLD network address following the

instructions in Reconfiguring the System.
o If your current SAP Business One version is lower than 9.2, first upgrade your system to 9.2 and then

reconfigure the SLD network address following the instructions in Reconfiguring the System.
When running the setup wizard to upgrade the schemas and Windows-based components, do not choose
to install the browser access service.

· The FQDNs of both the SLD server and the browser access server are covered by the certificate.
If you used a self-signed certificate for the SLD, do either of the following:
o If your current SAP Business One version is 9.2, change the certificate following the instructions in

Changing Security Certificate for the System Landscape Directory.
o If your current SAP Business One version is lower than 9.2, first upgrade your system to 9.2 and then

change the certificate following the instructions in Changing Security Certificate for the System
Landscape Directory.:

Procedure

Navigate to the root folder of the product package and run the setup.exe file.
If you are using Windows Server 2008 or Windows 7, right-click the setup.exe file and choose Run as
administrator.
In the welcome window, select your setup language and choose Next.
In the Setup Type window, select Perform Setup and choose Next.
In the Setup Configuration window, select New Configuration and choose Next.
In the System Landscape Directory window, do the following:

Select Connect to Remote System Landscape Directory.
Enter the FQDN of the SLD server.
Choose Next.

In the Site User Logon window, enter the password for the site super user B1SiteUser.
This site user was created during the installation of the SLD.
In the Database Server Connection window, enter the database server information as follows:

Specify the database server type.
In the Server Name field, enter the hostname or the IP address of the database server.
Choose Next.

In the Component Selections window, select the following components and choose Next:
o Browser access service
o SAP Business One client application (32-bit or 64-bit)

Note that the browser access service can be selected only if you have selected (or installed) either version of
SAP Business One client.
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In the Parameters for Browser Access Service window, specify the following information for the browser
access service:
o Service URL: For the internal access URL of the service, specify:

o The network address (hostname, IP address, or FQDN) of the machine
o The port for the service (default: 8100)

o Security certificate: Import a valid PKCS12 certificate and enter the password, or select the Use Self-
Signed Certificate radio button.
Communication between the browser access gatekeeper and SAP Business One clients or DI API is
encrypted using the HTTPS protocol, so a certificate is required for authentication. You can obtain a
certificate using the following methods:
o Third-party certificate authority – You can purchase certificates from a third-party global Certificate

Authority that Microsoft Windows trusts by default. If you use this method, select the Specify PKCS12
Certificate Store and Password radio button and enter the required information.

o Certificate authority server – You can configure a Certificate Authority (CA) server in the SAP
Business One landscape to issue certificates. You must configure all servers in the landscape to trust
the CA’s root certificate. If you use this method, select the Specify PKCS12 Certificate Store and
Password radio button and enter the required information.

o [Not recommended] Generate a self-signed certificate – You can let the installer generate a self-
signed certificate; however, your browser will display a certificate exception when you access SAP
Business One in a Web browser, as the browser does not trust this certificate. To use this method,
select the Use Self-Signed Certificate radio button.

In the next Parameters for Browser Access Service window, select the version of SAP Business One to be used
by the browser access service.
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In the Review Settings window, review your settings and proceed as follows:
o To continue, choose Next.
o To change the settings, choose Back.
In the Setup Summary window, choose Next.
In the Setup Status window, wait for the system to perform the required actions.
In the Complete window, choose Finish.

Post-requisites

The Browser Access service is registered as a Windows service SAP Business One Browser Access Gatekeeper.
After installation, check if this Windows service runs under the Local System account.
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3.4 Installing Client Components

You can install the following client components on every workstation:
· SAP Business One client application (together with SAP Business One client agent and DI API)
· Software development kit (SDK)
· Data transfer workbench
· SAP Business One Studio
· Excel Report and Interactive Analysis

If you want to use the Microsoft Outlook integration features on a workstation without the SAP Business One
client application, install the Microsoft Outlook integration component (standalone version). For more
information, see Installing the Microsoft Outlook Integration Component (Standalone Version).

Prerequisites

· The installation computer complies with all hardware and software requirements. For information on
hardware and software requirements, search for relevant information on sappartneredge.com.

· You have installed the SAP HANA database client for Windows. Whether you install a 32-bit or 64-bit client
depends on the type of SAP Business One client that you intend to install. For example, if you intend to install
a 32-bit SAP Business One client, you must first install the 32-bit SAP HANA database client.

· You have installed Microsoft .NET Framework 4.5.2. During the installation of the SAP Business One client,
the system checks whether Microsoft .NET Framework 4.5.2 is installed. If it is not installed yet, you can install
it during the installation process.

· You have installed Microsoft Visual C++ 2005 SP1 Redistributable Package. If it is not installed yet, you can
install it during the installation process.

· If you want to use Excel Report and Interactive Analysis, ensure that you have installed the following:
o Microsoft Excel 2010 or 2013
o Microsoft .Net Framework 4.5.2

If it is not installed yet, you can install it during the installation process. However, a restart may be
required.

o Microsoft Visual Studio 2010 Tools for Office Runtime
· If the machines on which the SAP Business One client and DI API run use an HTTP proxy for network access,

you have added the System Landscape Directory server to the list of proxy exceptions.

Procedure

A setup wizard is used for installation as well as for upgrade. The following procedure describes how to install all
client components (except for Excel Report and Interactive Analysis) in a clean environment where no SAP
Business One components exist.

Navigate to the root folder of the product package and run the setup.exe file.
If you are using Windows Server 2008 or Windows 7, right-click the setup.exe file and choose Run as
administrator.
In the welcome window, select your setup language and choose Next.

http://sappartneredge.com/
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In the Setup Type window, select Perform Setup and choose Next.
In the Setup Configuration window, select New Configuration and choose Next.
In the System Landscape Directory window, do the following:

Select Connect to Remote System Landscape Directory.
Specify the hostname or the IP address of the server where the SLD is installed.
Choose Next.

In the Site User Logon window, enter the password for the site super user B1SiteUser.
This site user was created during the installation of the SLD.

In the Database Server Connection window, enter the database server information as follows:
Specify the database server type.
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In the Server Name field, enter the hostname or the IP address of the database server.
Choose Next.

In the Component Selections window, select the required client components and choose Next.

In the Review Settings window, review the settings you have made and choose Next.
In the Setup Summary window, review the component list and choose Setup to start the setup process.
In the Setup in Process window, wait for the setup to finish.
In the course of the setup, some additional wizards are displayed to guide you through the setup of
corresponding components.
Depending on the results of the setup, one of the following windows is displayed:
o Setup Result: Successful window: If the setup of all components was successful, the wizard opens this

window. To continue, choose Next.
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o Setup Result: Errors window: If the setup of one or more components failed, the wizard opens this
window. To continue, choose Next, and then in the Restoration window, do either of the following:
o Select the failed component and proceed to start the restoration process.
o Choose Next to skip the restoration.

In the Congratulations window, choose Finish to close the wizard.

Post-requisites for Excel Report and Interactive Analysis

To use Excel Report and Interactive Analysis, you must do the following after the installation:
· In Microsoft Excel, enable all macros and select to trust access to the VBA project object model.

For instructions, see the Microsoft online help.
· If the user who installs Excel Report and Interactive Analysis (user A) is different from the user who uses Excel

Report and Interactive Analysis (user B), user B must start Excel Report and Interactive Analysis from the
Windows menu for the first time. After having done so, user B can start Excel Report and Interactive Analysis
directly from within the SAP Business One client or from the Windows menu.

· If you have installed Excel Report and Interactive Analysis to a folder that is not in the %ProgramFiles%
directory (default installation folder), you must perform some additional steps before using the function. For
instructions, see the section "Cannot Use Excel Report and Interactive Analysis" in Troubleshooting.

3.5 Installing the Microsoft Outlook Integration Component
(Standalone Version)

The Microsoft Outlook integration component enables you to exchange and share data between SAP Business
One, version for SAP HANA and Microsoft Outlook. This component is a standalone version that does not require
the SAP Business One client to be installed on the same computer.
If you want to use the Outlook integration features on a computer on which you have installed the SAP Business
One client, version for SAP HANA, you can install either the Outlook integration add-on or the standalone version.
For more information, see Assigning SAP Business One Add-Ons, version for SAP HANA.

 Caution
The Microsoft Outlook integration component is a standalone version of the Outlook integration add-on
and they cannot coexist.
If you install the add-on while you have the standalone version installed on the same computer, a
subsequent upgrade of the standalone version will be prevented; if you install the standalone version
while you have the add-on installed on the same computer, the installation fails.

 Note
Both 32-bit and 64-bit versions of the Microsoft Outlook integration component are available. You can
install and run both versions on the same machine, but you must install each version separately.
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Prerequisites

· You have installed the SAP Business One DI API with the same system type as that of the Outlook integration
component. For example, install the 32-bit DI API for the 32-bit Outlook integration component.

· You have installed Microsoft Outlook with the same operating system type as that of the Outlook integration
component. For example, install the 32-bit Outlook integration component for the 32-bit Microsoft Outlook.

· You have assigned the following to the SAP Business One user account which is used for the connection:
o The Microsoft Outlook integration add-on in the SAP Business One client
o The SAP AddOns license

· You have started the Microsoft Outlook integration add-on in the company at least once. This ensures that the
necessary user-defined tables are added to the company schema.

Procedure

Navigate to the root folder of the product package and run the setup.exe file.
If you are using Windows Server 2008 or Windows 7, right-click the setup.exe file and choose Run as
administrator.
In the welcome window, select your setup language and choose Next.
In the Setup Type window, select Perform Setup and choose Next.
In the Setup Configuration window, select New Configuration and choose Next.
In the System Landscape Directory window, do the following:

Select Connect to Remote System Landscape Directory.
Enter the hostname or the IP address of the SLD server.
Choose Next.

In the Site User Logon window, enter the password for the site super user B1SiteUser.
This site user was created during the installation of the SLD.
In the Database Server Connection window, enter the database server information as follows:

Specify the database server type.
In the Server Name field, enter the hostname or the IP address of the database server.
Choose Next.

In the Component Selections window, select the version of Outlook Integration Standalone, depending on
your Outlook version (32-bit or 64-bit), and choose Next.
In the Review Settings window, review your settings and proceed as follows:
o To continue, choose Next.
o To change the settings, choose Back.
In the Setup Summary window, choose Next.
In the Setup Status window, wait for the system to perform the required actions.
In the Complete window, choose Finish.
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4 Installing SAP Crystal Reports, version for
the SAP Business One application

SAP Business One 9.2, version for SAP HANA supports SAP Crystal Reports 2013 SP5, version for the SAP
Business One application:
If you already have SAP Crystal Reports installed on your computer, first uninstall the software and then perform
the installation operations below.

 Note
The operating system of the computer on which you want to install SAP Crystal Reports for SAP Business
One must be Windows 7 SP1 or higher.

To use SAP Crystal Reports, version for the SAP Business One application, perform the following operations:
Install SAP Crystal Reports 2013, version for the SAP Business One application
Run the SAP Crystal Reports integration script: This step ensures that SAP Business One data sources are
available in the application.

For more information about SAP Crystal Reports, version for the SAP Business One application, see How to Work
with SAP Crystal Reports in SAP Business One in the documentation area of SAP Business One Customer Portal at
http://service.sap.com/smb/sbocustomer/documentation.
For more information about how to connect to the data sources of SAP Business One, version for SAP HANA, see
How to Set Up SAP Business One, version for SAP HANA Data Sources for Crystal Reports in the documentation
area of SAP Business One Customer Portal at https://service.sap.com/smb/sbocustomer/documentation.

Prerequisite

Ensure that you have installed the 32-bit DI API on your workstation; otherwise, you cannot connect to SAP
Business One data sources or use the Add-ins menu to connect to SAP Business One.

4.1 Installing SAP Crystal Reports, version for the SAP
Business One application

 Note
If you have SAP Crystal Reports 2011 or 2013 installed on the computer where you want to install SAP
Crystal Reports, version for the SAP Business One application, you are prompted to uninstall it during the
installation procedure.

http://service.sap.com/smb/sbocustomer/documentation
https://service.sap.com/smb/sbocustomer/documentation
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Prerequisites

You have downloaded the installation package of SAP Crystal Reports 2011 or 2013, version for the SAP Business
One application from the SAP Business One Software Download Center on SAP Support Portal at
https://support.sap.com/b1software.

Procedure

In the installation package, right click the setup.exe file and choose Run as administrator.
In the SAP Crystal Reports for SAP Business One setup window, select a setup language and choose the OK
button.
The Prerequisites check window appears. If you have fulfilled all critical prerequisites, you can continue with
the installation; otherwise, follow the instructions in the wizard to resolve any issues before proceeding.
In the welcome window, choose the Next button.
In the License Agreement window, read the software license agreement, select the radio button I accept the
License Agreement, and then choose the Next button.
In the Specify the Destination Folder window, specify a folder where you want to install the software.
In the Choose Language Packs window, select the checkboxes of the languages you want to install and choose
the Next button.
In the Choose Install Type window, select one of the following installation types and choose the Next button:
o Typical: Installs all application features. For a typical installation, proceed to step 9.
o Custom: Allows you to do the following:

o Select features that you want to install.

 Note
If you have installed SAP Crystal Reports, version for the SAP Business One application, you can select
the Custom install type to add or remove features.
o Select whether or not you want to receive the web update service
o Check the disk cost of the installation

https://support.sap.com/b1software
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 Note
If you have done one of the following, the Browse button is inactive because a destination folder already
exists:
o You have already installed SAP Business One, version for SAP HANA; that is, before installing SAP

Crystal Reports, version for the SAP Business One application.
o You have already installed the SAP Crystal Reports viewer. For example, this may be installed

automatically when you install the SAP Business One client, version for SAP HANA.
In the Select Features window, select the features you would like to install and choose the Next button.
The icons in the feature tree indicate whether the feature and its sub-features will be installed, as follows:
o A white icon means that the feature and all its sub-features will be installed.
o A shaded icon means that the feature and some of its sub-features will be installed.
o A yellow 1 means that the feature will be installed when required (installed on demand).
o A red X means that the feature or sub-feature is either unavailable or will not be installed.

SAP Crystal Reports, version for the SAP Business One application uses an "install on-demand" technology
for some of its features. As a result, the first time a particular feature is used after being installed, there may
be an extra wait for the "install on-demand" to complete. This behavior will affect new installations only once
and will not occur when features are restarted.
To check how much disk space is required for the installation of selected features, choose the Disk Cost
button.
In the Web Update Service Option window, you can disable the web update service by selecting the Disable
Web Update Service checkbox. We recommend, however, that you enable the update service to stay aware of
updates that can help you enhance your SAP Crystal Reports.
Choose the Next button to proceed.
In the Start Installation window, choose the Next button.
The Crystal Reports for SAP Business One Setup window appears.
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When the installation is complete, the Success window appears. To exit the installation wizard, choose the
Finish button.

4.2 Running the Integration Package Script

To make the SAP Business One data sources, version for SAP HANA and the Add-ins menu available in the SAP
Crystal Reports designer, run the SAP Business One Crystal Reports integration script. The SAP Business One
tables, version for SAP HANA are organized according to the modules in the SAP Business One Main Menu.

Procedure

In the SAP Business One product or upgrade package, locate the …Packages\SAP CRAddin
Installation folder, right-click the SAP Business One Crystal Report Integration
Package.exe file, and choose Run as administrator.
Wait for the integration package to install.
After the installation finishes, to exit the wizard, choose the Finish button.

4.3 Updates and Patches for SAP Crystal Reports, version for
the SAP Business One application

 Caution
Since you are using SAP Business One, version for SAP HANA together with an Original Equipment
Manufacturer (OEM) version of SAP Crystal Reports, do not apply standard SAP Crystal Reports file or
product updates (including Hot Fixes and Service Packs) as they are not designed to work with OEM
versions of SAP Crystal Reports.

File or product updates are provided in the following ways:
· Integrated runtime version: distributed together with SAP Business One, version for SAP HANA
· Designer: provided separately via a dedicated folder location in the SAP Business One Software Download

Center on SAP Support Portal at https://support.sap.com/b1software.

 Note
If you are using both the integrated runtime version and the designer, make sure that they are either on
the same patch or Service Pack level or that the Report Designer is on an earlier patch or Service Pack
level than the Runtime version. If not, inconsistencies may occur.

To find out if you are using an OEM version of SAP Crystal Reports, start the designer and look for either of these
two indicators:
· The title bar of the designer indicates SAP Crystal Reports for a certain product (such as SAP Crystal Reports

for SAP Business One).
· In the Help menu, choose About (for example, About Crystal Reports). The technical support phone number in

the About Crystal Reports box is not listed as (604) 669 8379.

https://support.sap.com/software/business-one.html
https://support.sap.com/b1software
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If either of these indicators exists in your product, you are using an OEM version of SAP Crystal Reports.
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5 Uninstalling SAP Business One, version for
SAP HANA

When you uninstall SAP Business One, version for SAP HANA, you remove the application and its components.

 Note
You must uninstall all SAP Business One add-ons, version for SAP HANA before uninstalling the server
and client components of SAP Business One, version for SAP HANA.

Procedure

Uninstall the SAP Business One add-ons, version for SAP HANA as follows:
On any of your workstations, log on to SAP Business One.
In the SAP Business One Main Menu, choose Administration → Add-Ons → Add-On Administration.
In the Add-On Administration window, on the Company Preferences tab, under Company Assigned Add-
Ons, select the add-ons you want to remove.
Choose the arrow button between the two panels. This removes the add-ons from the list.
In the Available Add-Ons list, select the add-ons you want to remove.
Choose the Remove Add-On button, and then choose the Update button.

SAP Business One, version for SAP HANA automatically removes the add-ons that you have uninstalled the
next time you start the SAP Business One client application, version for SAP HANA from any workstation that
is connected to the SAP HANA database server.
On the Linux server machine, uninstall the server components (server tools, SAP Business One server, SAP
Business One analytics powered by SAP HANA, and so on) as follows:

Navigate to the installation folder for the SAP Business One server components (default path:
/usr/sap/SAPBusinessOne).
Start the uninstaller from the command line by entering one of the following commands, depending on
the uninstallation mode:
o Wizard uninstallation: Enter./setup, select Uninstallation, and then follow the steps in the wizard to

uninstall the components.
o Silent uninstallation: Enter./setup –u silent –f <Property File Path>. For more

information about supported arguments and parameters, see Silent Installation.
To uninstall the SBO DI server and Workflow, on your Windows server, in the Programs and Features window
(Control Panel →Programs → Programs and Features), select SAP Business One Server Tools and choose
Uninstall.
On each of your workstations, in the Programs and Features window (Control Panel →Programs → Programs
and Features), select the following items one at a time and choose Uninstall after each selection:
o SAP Business One Client
o Data Transfer Workbench
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o SAP Business One SDK
o SAP Business One Studio
o SAP Business One Excel Report and Interactive Analysis
To remove the DI API:
o If you installed the DI API as part of the client installation of SAP Business One, version for SAP HANA, the

system automatically removes the DI API when you uninstall the SAP Business One client, version for SAP
HANA.

o If you installed the DI API using the manual setup program in the b1_shf/B1DIAPI folder, you must
remove it by choosing Control Panel → Programs → Programs and Features and selecting SAP Business
One DI API.

Results

The analytics schema COMMON has been removed from the SAP HANA database server as well as all customized
analytical contents and settings. The database user COMMON reserved for analytics features has also been deleted.
You can now do the following:
· Manually delete the SAP Business One folders on Linux and Windows.

 Note
Exports of company schemas are not removed during the uninstallation process. We highly recommend
that you keep at least one export for each company schema.

· If you chose not to remove any of the following schemas during the uninstallation process, remove (drop) the
schema from the SAP HANA database:
o SLD schema
o SBOCOMMON schema
o Demo databases (schemas)

 Note
Each of the above schemas is available for removal only if the corresponding feature is selected for
uninstallation. For example, if you do not uninstall the System Landscape Directory, the SLD schema
does not appear for selection in the GUI mode; in the silent mode, even if you specify for the SLD schema
to be removed in the property file, the command is ignored.

· Remove (drop) your company schemas from the SAP HANA database.

 Caution
Before dropping any productive schemas, ensure that you have backed up the entire SAP HANA database
instance.

SAP Business One, version for SAP HANA entries no longer appear in the Windows Programs menu and all
shortcuts on the Microsoft Windows desktop are removed.
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5.1 Uninstalling the SAP Business One Client Agent

To uninstall the SAP Business One client agent, version for SAP HANA, in the Programs and Features window
(Control Panel →Programs → Programs and Features), select SAP Business One Client Agent and choose the
Uninstall button.

5.2 Uninstalling the Integration Framework

To uninstall the integration framework, use the Change SAP Business One Integration program. With this program
you can add or remove features, repair the installation or uninstall the integration framework.

Prerequisites

· To disable further event creation for the company schemas in SAP Business One, run the event sender setup
and in step 4, deselect the company schemas.

· You have administrative rights on the PC where you uninstall the integration framework.
· You have made a backup of the database of the integration framework.
· You have made a backup of the B1iXcellerator folder.

To find the folder, select IntegrationServer ® Tomcat ® webapps ® B1iXcellerator.

Procedure

Choose Start ® All programs ® Integration solution for SAP Business One ® Change SAP Business One
Integration.
The SAP Business One Integration Wizard Introduction window opens.
In the Maintenance Mode window select Uninstall Product and choose Next.
The system notifies you that it uninstalls the integration framework.
Choose Uninstall.
The system uninstalls your installation.
To finish the procedure, choose the Done button.

Result

The program uninstalls the integration framework, but it does not remove the database (or schema). Remove it
separately.
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6 Upgrading SAP Business One, version for
SAP HANA

To upgrade your SAP Business One application to a new minor or major release and run it successfully, you must
do the following:

Upgrade your SAP Business One successfully.
Update the system information in the system data maintenance area:
o Partners: On the SAP Business One Support area on sappartneredge.com, in the Quick Links area, choose

System Data Maintenance.
o Customers: On the SAP Business One Customer Portal at http://service.sap.com/smb/sbocustomer, in

the left-hand navigation bar, choose System Data Maintenance.
Import the license file for the new release.

For the latest information about upgrade issues that may not appear in this guide, see SAP Note 2004998.
If you are using the intercompany integration solution for SAP Business One, make sure the intercompany version
is compatible with this SAP Business One patch level as specified in SAP note 1844555. You may need to upgrade
the intercompany version as well.

 Note
If your SAP Business One is of a hotfix version, we strongly recommend that you upgrade to the next
regular patch once it is available, as hotfixes are intended only as temporary solutions.
To upgrade to a new minor or major release, you must upgrade to a regular patch first, and then you can
proceed with the upgrade to the new release.

6.1 Supported Releases

The following major or minor releases are currently supported for upgrade to SAP Business One 9.2, version for
SAP HANA:
· SAP Business One 8.82, version for SAP HANA
· SAP Business One 9.0, version for SAP HANA
· SAP Business One 9.1, version for SAP HANA

For more information about upgrading from specific patches of supported releases, see the Readme or Patch
Readme file for the respective SAP Business One version.

6.2 Upgrade Process

All components of SAP Business One 8.82, version for SAP HANA are installed on Windows except for SAP
Business One analytics powered by SAP HANA. Therefore, to upgrade release 8.82 to a higher release, you must

https://sappartneredge.com/
http://service.sap.com/smb/sbocustomer
https://service.sap.com/sap/support/notes/2004998
https://service.sap.com/sap/support/notes/1844555
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first uninstall all existing SAP Business One 8.82, version for SAP HANA server components and client
components.
As of SAP Business 9.0, version for SAP HANA, all server components are installed on Linux except for the DI
Server and Workflow (which are still installed on Windows). To upgrade release 9.0 and higher, you must do the
following:

To determine the upgrade path, read the Overview Note for the required version.
For example, check which versions are supported for upgrade to the required higher version. If direct upgrade
is not supported, you need to upgrade your system first to a supported version and perform the server
upgrade operation (steps 2 and 3) more than once.
If the required version of SAP HANA has changed, upgrade the following:
o AFLs on the SAP HANA server system

 Note
You must upgrade the AFLs before you upgrade the SAP HANA server. Otherwise, you may encounter
errors upgrading the SAP HANA server.

o SAP HANA Platform Edition
For more information, see SAP Note 2001393 and the corresponding documentation on SAP Help Portal at
http://help.sap.com/hana_platform.
On your Linux server, upgrade the server components. For more information, see Upgrading Server
Components.

 Note
If some components are not installed, you can select to install them during the upgrade process.

On a Windows machine, upgrade your company schemas and other components. For more information, see
Upgrading Schemas and Other Components.
If needed, update analytical contents for your companies in the Administration Console. For more
information, see Initializing and Updating Company Schemas.
On each workstation, do the following:
o If you have installed such client components as the DTW, run the setup wizard to upgrade these client

components. For more information, see Upgrading Schemas and Other Components.
o Upgrade the SAP Business One client. For more information, see Upgrading the SAP Business One Client.
o Upgrade the SAP HANA database client

6.3 Upgrading Server Components

Before upgrading your company schemas, including the SBOCOMMON schema and the company schemas, you
must upgrade the server components.
You can perform the upgrade in both GUI and silent modes. Silent upgrade shares the same process and
parameters used for the silent installation; for more information, see Silent Installation. The following procedure
describes how to upgrade server components in GUI mode.

 Note
If you have installed the Service Layer, the components of this application will also be upgraded.

https://service.sap.com/sap/support/notes/2001393
http://help.sap.com/hana_platform
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Prerequisite

You have extracted or copied the following folders from the product package to the Linux server:
· Packages.Linux
· Prerequisites
· Packages/Server
· Packages/Client
· Packages/DI API
· Packages.x64/Client
· Packages.x64/DI API
· Packages/SAP CRAddin Installation
· Packages/Server/ExclDocs

Note that you must keep the original CD structure, with these folders in a separate parent folder.
If you have enough disk space, you can extract or copy the entire package to the Linux server.

Procedure

Log on to the Linux server as root.
In a command-line terminal, navigate to the directory …/Packages.Linux/ServerComponents where the
install script is located.
Start the upgrader from the command line by entering the following command:
./install

The upgrade process begins.
In the welcome page of the setup wizard, choose Next.
In the Select Features window, select the features that you want to upgrade and choose Next.

 Note
If there are no installed versions of a feature, you can select the feature to install it. For more information,
see Installing Server Components.

In the Site User Password window, enter the password for the site super user B1SiteUser and choose Next.
If the password has not changed since the last installation or upgrade, choose Next without re-entering the
password.
In the Database Server for System Landscape Directory window, enter the password for the database user
and choose Next.
If the password has not changed since the last installation or upgrade, choose Next without re-entering the
password.
In the Backup Service Settings window, you can change the backup service settings.
Note that if you have been keeping the log file folder and the backup folder in the same parent directory, you
must change either folder; it is likewise for the log file folder and working folder. For example, you cannot
specify /backup/logs for the log file folder while specifying /backup/backups for the backup folder.
Choose Next to continue.
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If you have installed the app framework on this machine, in the Restart Database Server window, choose
whether or not to restart the SAP HANA serve after the upgrade. Choose Next.
If you have not enabled single sign-on, in the Windows Domain User Authentication (Single Sign-On) window,
choose whether or not to enable single sign-on. For detailed instructions, see Installing Linux-Based Server
Components.
Choose Next to continue.
In the Review Settings window, first review your settings and then choose Install.
If you want to save the current settings to a property file for a future silent installation, choose Save Settings.
For more information, see Silent Installation.

 Caution
Passwords will also be saved in the property file. We recommend that you delete the passwords from the
saved property file and fill in passwords before you perform silent installation next time.

The upgrade process begins.
If your current installation has been running under a b1serviceX user (where X represents any integer larger
than 0) instead of a b1service0 user, a Delete Residual Service Users and Groups window is displayed.
B1serviceX users and user groups are usually remnants of previously failed uninstallations or rollbacks.
Although not mandatory, we recommend that you delete these users and user groups to prevent potential
unnecessary future complications. To do so, select the Delete residual service users and service user groups
checkbox and choose Next.

In the Setup Progress window, when the progress bar displays 100%, do one of the following:
o If all components were upgraded successfully, choose Next.
o If a component failed to be upgraded, choose Roll Back to restore the system. After rollback is complete,

in the Rollback Progress window, choose Next.
In the Setup Process Completed window, review the upgrade result and choose Finish. (If you chose to
configure SSL for the app framework, an additional window appears, reminding you to restart the SAP HANA
server).
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Results

Database Role PAL_ROLE

A database role PAL_ROLE is created during the upgrade/installation process of the app framework. All database
privileges necessary for using pervasive analytics are assigned to this role.
If you encounter any problems using pervasive analytics after the installation/upgrade, refer to Database Role
PAL_ROLE for Pervasive Analytics.

Service User

If you have upgraded from release 9.0 or 9.1, an operating system user b1techuser is created and used to move
log files from client machines to a central log folder in the shared folder b1_shf. You may change the user in the
SLD by editing the server information. The user must be either a local user or a domain user that has write
permissions to the central log folder.

Security Certificate for the App Framework

If you want to use a security certificate issued by a certificate authority for the app framework, rather than using a
self-signed certificate, you must create a certificate request and import the signed certificate by yourself. For
detailed instructions, see the "Configuring HTTPS (SSL) for Client Application Access" chapter in the SAP HANA
Administration Guide at http://help.sap.com/hana_platform.

Post-requisites

Update the system information in the system data maintenance area:
o Partners: On the SAP Business One Support area on sappartneredge.com, in the Quick Links area, choose

System Data Maintenance.
o Customers: On the SAP Business One Customer Portal at http://service.sap.com/smb/sbocustomer, in

the left-hand navigation bar, choose System Data Maintenance.
In the license control center, import the license file for the new release. For more information, see License
Control Center.
Upgrade SBOCOMMON and your company schemas.

6.4 Upgrading Schemas and Other Components

You must use the SAP Business One setup wizard to upgrade the SAP Business One common database
(SBOCOMMON) and your company schemas. If any of the upgrade steps fail, you can use the restoration
mechanism to reverse all changes made by the wizard.
For company schemas migrated from the Microsoft SQL Server, upgrade is an integral part of the entire migration
process. For more information, see Migrating from Microsoft SQL Server to SAP HANA.
If you intend to install the browser access service during the upgrade process, first read the instructions in
Installing the Browser Access Service.

http://help.sap.com/hana_platform
https://sappartneredge.com/
http://service.sap.com/smb/sbocustomer
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Prerequisites

· You have ensured that all SAP Business One clients, version for SAP HANA are closed.
· You have backed up the entire SAP HANA instance.

 Note
If the upgrade fails, recover the entire instance.

· On your SAP HANA server, you have started the Samba component.
For more information, see the section “Starting Samba to Access and Upgrade the Shared folder” in
Troubleshooting.

· The database user registered for server connection is an admin user. To confirm this, do the following:
To find out which database user is registered, in the System Landscape Directory, on the Servers and
Companies tab, in the Servers section, choose the Edit button.
The Edit Server window displays the registered database user.
In the SAP HANA studio, check if the registered database user is an admin user.
If the registered database user is not an admin user, either change the database user to an admin user or
assign the appropriate privileges to the currently registered user.

· If you have installed the integration framework of SAP Business One, version for SAP HANA, you have
ensured that the following services have been stopped (in the order given below):

SAP Business One integration Event Sender
SAP Business One integration DI Proxy Monitor
SAP Business One integration DI Proxy
Integration Server Service

 Note
After you have completed the upgrade process, you must restart the services in reverse order.

 Note
To only upgrade the integration framework, run the setup.exe file under \Packages\B1 Integration
Component\Technology\ in the product package.

· On the computer on which you want to run the setup wizard, the following requirements have been met:
o You have downloaded the product package. For more information, see Software Download.
o You have administrator rights.
o You have installed Microsoft .NET Framework 4.5.2.
o You have installed the 32-bit version of SAP HANA database client for Windows.
o The SAP HANA studio application is closed, if there is one.
o You have added the System Landscape Directory server to the list of proxy exceptions.
o The memory is no less than 4 GB.
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Procedure

A setup wizard is used for installation as well as for upgrade. The following procedure describes how to upgrade
the common database, the company schemas, Windows-based server components, and client components.
Note that the setup wizard does not support remote upgrade and can upgrade only local components. To
upgrade components on other machines, you must run the setup wizard repetitively.
In addition, for upgrade of the SAP Business One client within a release family, you can perform silent upgrade
instead of using the setup wizard. For more information, see Upgrading the SAP Business One Client.

In the root folder of the upgrade package, double-click the setup.exe file.
If you are using Windows Server 2008 or Windows 7, right-click the setup.exe file and choose Run as
administrator.
In the welcome window, select your setup language, and choose Next.
In the Setup Type window, select the Perform Setup checkbox, and choose Next.

The option Test System Environment verifies if the system environment and the company schemas are ready
for an upgrade. The existing installation and data are not changed. For each company schema that passes the
test, you can generate a passcode, which allows you to bypass the pre-upgrade test when upgrading the
schema later. The passcode is in the form of an XML file that contains details on the tested company
schemas. It is valid for three days, and any changes to the company configuration render the passcode
invalid.
The Perform Setup option performs both the pre-upgrade tests and upgrades selected components and
schemas. If you carried out a pre-upgrade test for a company schema earlier, you can enter the passcode to
bypass the pre-upgrade tests for this company schema.
In the Setup Configuration window, select one of the following options and choose Next:
o New Configuration: Select this radio button to manually enter all the required settings.
o Use Settings from the Last Wizard Run – Select this radio button to use the settings from the last wizard

run, which are stored in the configuration file generated during that run.
o Load Settings from File – Select this radio button to use the settings stored in a configuration file

generated during a previous wizard run, and then specify the location of the file you want to use.
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To obtain the required Config.XML file, first run the setup wizard and select the New Configuration
option. After generating this file, you can make a copy and use a text editor to modify the values for future
use, as required.

If you selected to use the settings from the previous wizard run or a file, the Review Settings window appears.
This window provides an overview of the settings that you have configured for the upgrade process. To modify
any of the settings, edit the values in the table. Otherwise, choose Next to proceed with the upgrade.

 Note
If you are sure that all the settings are correct, you can select the checkbox Skip Remaining Steps and
Automatically Start Pre-Upgrade Test and Upgrade to bypass the remaining wizard steps and begin the
process immediately.

In the System Landscape Directory window, select Connect to Remote System Landscape Directory, specify
the server, and choose Next.
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Note that the connected System Landscape Directory must have already been upgraded to the required
version.

In the Site User Logon window, enter the password for the site super user B1SiteUser.

 Note
If you chose to perform only the pre-upgrade test, you also have the option to connect to a database
server. In this case, you need to specify the information for a database user instead of the site user.

In the Database Server Connection window, select the database server type (HANADB) and the server. Then
choose Next to proceed.
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If you do not find the database server you want to upgrade in the server list, you can register it in the System
Landscape Directory. To do so, choose the Register New Database Server button, specify the relevant
information, and choose Back to continue with the upgrade.
In the Component Selections window, select the components you want to upgrade and choose Next.
If a component has already been upgraded to the current version, its checkbox is enabled but not selected. If
you select an already upgraded component, the wizard overwrites all instances of installed components.
The wizard also lists all third-party add-ons present in the …\Packages\Add-Ons Autoreg or
…\Packages.x64\Add-Ons Autoreg folders, which you can select to upgrade.

 Notes
Upgrading the repository (shared folder and common database) is a prerequisite for upgrading other
components or company schemas.
If a component is indicated as Not Found, you can select the corresponding checkbox to install the
component.
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In the Database Selection window, select the checkboxes of the schemas that you want to upgrade.

To view additional options and information, select the row of a company schema, select the Advanced
Settings checkbox, and then specify the following:
o Backup – From the dropdown lists in the Backup column, select whether to back up each schema before

the upgrade.

 Caution
If you select not to back up a schema before upgrade, you cannot restore the schema should the upgrade
fail. SAP does not provide support for such schemas in the case of an upgrade failure; a backup of the
pre-upgrade schema is required to qualify for SAP support.

o Upgrade By – From the dropdown list, select the SAP Business One superuser to perform the upgrade. By
default, the wizard uses the manager account.

o Stop on Test Error – Select this checkbox to force the wizard to stop the entire upgrade process if it
encounters an error during a pre-upgrade test.

o Stop on Upgrade Error – Select this checkbox to force the wizard to stop the entire upgrade process if it
encounters an error while upgrading the schema.
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If errors occur which are preventing you from upgrading the company schemas, do the following:
In the Status column, click the Not Ready link.
Specific information appears.
Do either of the following:
o Fix the error and choose Refresh.
o If the error cannot be fixed and you must contact SAP Support, deselect the checkbox.

In any of the following cases, the status of the company schema is Not Ready and you cannot select it for
upgrade:
o Upgrade is not possible:

o The wizard does not support the company schema version.
o The wizard cannot find the localization for the company schema from the locale list in the common

database.
o You must fix the errors to proceed with the upgrade:

o The wizard finds more than one connection to the company schema.
o The database user registered with the server is either locked or is not a database admin user.

When all the selected company schemas have the status Ready, choose Next.

 Note
If any of the selected schemas has the status Not Ready, the wizard disables the Next button. You cannot
proceed to the next step until you have fixed the problem.

In the Upgrade - Backup Settings window, choose Next.
The Use Database Server Default radio button is automatically selected.
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If you previously selected the integration framework for upgrade, do the following:
In the Integration Solution - B1i Database Connection Settings window, enter the database password.

In the subsequent Integration Solution - Scenario Packages windows, if you want to activate any new
scenarios, select the corresponding checkboxes and specify the necessary information.

In the Review Settings window, review your configuration settings. To modify any of the settings, choose Back
to return to the relevant window; otherwise, choose Next.
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In the Pre-Upgrade Test window, do the following:
o To bypass the tests for certain company schemas, choose Enter Passcodes and upload one or several

passcode files that you saved earlier. After uploading the files, choose Next and proceed to step 23.

 Note
A passcode file is only valid for three days. Any changes to the company configuration render the
passcode file invalid.

o To perform pre-upgrade tests on each database to ensure its readiness for the upgrade and to reduce the
possibility of upgrade failure, choose Start.
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In the Pre-Upgrade Testing In Progress window, the wizard first checks the common database and then
checks the company schemas one by one.

 Note
If the common database does not pass the checks, the wizard does not continue with the rest of the
checks.

The Pre-Upgrade Test window provides a detailed overview of the results of the pre-upgrade tests. You can
view information about individual checks, possible solutions to errors, and recommendations for dealing with
warnings by clicking the links to the corresponding notes in the SAP Note column.
Depending on the results of the pre-upgrade tests, one of the following windows appears:
o Pre-Upgrade Test: Passed – All components and databases successfully passed the pre-upgrade tests.

Proceed to the Setup Summary window.
o Pre-Upgrade Test: Errors Detected – One or more components or databases contain errors. You cannot

continue upgrading. You must fix the reported errors or contact SAP for support, and then start the setup
wizard again.

o Pre-Upgrade Test: Warnings Detected – One or more components or databases contain warnings. You
can still continue upgrading; however, first you must confirm all warnings, as follows:

For each component or database that contains warnings, click the corresponding link in the Details
column.
The Pre-Upgrade Test Result window appears.
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In the Pre-Upgrade Test Result window, do the following:
o To ignore a warning, select the corresponding checkbox in the Confirmation column.
o To fix an issue, click the corresponding hyperlink in the SAP Note column and follow the

recommendations. After fixing the issue, select the checkbox in the Confirmation column.
After confirming all the warnings, choose Back to return to the Pre-Upgrade Test window.
After you have confirmed all warnings for all components and databases, choose Next to open the
Pre-Upgrade Test: Warnings Confirmed window, and then proceed to the next step.
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The Setup Summary window displays an overview of the components and schemas that you have selected to
upgrade (or install if some selected components are not installed). Do either of the following:
o To begin the upgrade process, choose Upgrade.
o To change the settings, choose Back to return to the previous steps.

The Upgrade in Process window displays the upgrade progress for each component and schema.
According to the upgrade results, one of the following windows is displayed:
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o Upgrade Result: Upgraded window: This window appears if the upgrade of all components and schemas
was successful. To continue, choose Next.

o Upgrade Result: Errors window: This window appears if the upgrade of any component or schema failed.
To continue with the restoration step of the rollback process, choose Next and proceed to the Restoring
Components and Schemas section.

In the Congratulations window, choose Finish to close the wizard.
To view a summary report of the various upgrade steps, such as company schemas and pre-upgrade test
results, click the Upgrade Summary link.

Post-requisites

For each upgraded company schema, in the Administration Console, verify if an update (or even
reinitialization) is required; if so, update (or reinitialize) the schema. For more information, see Initializing and
Updating Company Schemas.
On each client workstation, upgrade the SAP Business One client. For more information, see Upgrading the
SAP Business One Client.

6.4.1 Restoring Components and Schemas

If the upgrade process fails, the SAP Business One setup wizard restores the schemas and certain components.
The other components must be restored manually.

 Note
The procedure below continues from the penultimate step in the previous section, Upgrading Schemas
and Other Components. It is only relevant for situations where the upgrade has failed.

Procedure

To restore components and databases, do the following:
In the Restoration window, select the checkboxes of the components and schemas that you want to restore,
and choose Next.
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Depending on the results of the restoration process, one of the following windows appears:
o If the restoration was successful, the Restoration Result: Restored window appears. To complete the

restoration, do the following:
In the Restoration Result: Restored window, choose Next.

In the Congratulations window, choose Finish to complete the restoration process.
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o If the restoration failed, the Restoration Result: Failed window appears. To complete the restoration, do
the following:

In the Restoration Result: Failed window, choose Next.

In the window displayed, choose Finish to exit.

 Note
If the restoration fails, to roll back SAP Business One to the version before the upgrade, you must do a
manual restoration.

Post-requisite

After the setup wizard has finished restoring the schemas, you must recover the entire SAP HANA instance that
you backed up before you ran the setup wizard. Note that all schemas will be restored, regardless of whether the
upgrade result was successful or not for each schema.

6.4.2 Troubleshooting Upgrades

To troubleshoot the upgrading process, check the following:
· All operating system users (owner, group, others) have write permission to the shared folder b1_shf on the

SAP HANA server computer.
· If you cannot connect to the System Landscape Directory using the server name, use the IP address of the

server computer.
· To have the SBO Mailer’s signature copied after upgrade, do the following:

In a Web browser, navigate to the following URL:
https://<Mailer Address>:<Port>/mailer



94
CUSTOMER
© 2016 SAP SE or an SAP affiliate company. All rights reserved.

SAP Business One Administrator’s Guide, version for SAP HANA
Upgrading SAP Business One, version for SAP HANA

If you have not logged on to the SLD service or license service, then in the logon page, enter the site user
password and choose Log On.
From the Database Server dropdown list, select an SAP HANA instance and choose Save.
Log off from SAP Business One, version for SAP HANA, and then log on again.

The signature is copied.

6.5 Upgrading the SAP Business One Client

After the server upgrade, you must upgrade the SAP Business One client on all of your workstations.

 Note
If you have installed both 32-bit and 64-bit SAP Business One clients on a client workstation, we
recommend uninstalling one client and keeping only the one of your choice. Otherwise, errors might occur
during the upgrade.
If the compatible SAP HANA version has changed, you must also upgrade the SAP HANA database client
on each of your client workstations.

Upgrading to a Higher Release Family

For an upgrade from a previous release family (for example, from the 8.82 release to the 9.2 release), run the
setup wizard on each workstation to upgrade the SAP Business One client.
Alternatively, you can uninstall the old client and then install the new client using the client installation program.
The client installation package is available in the entire product package as well as in the shared folder b1_shf.

Upgrading Within a Release Family

For an upgrade within a release family (for example, from the 9.1 release to the 9.2 release), you can directly
upgrade the SAP Business One client. The auto-upgrade is performed by the SAP Business One client agent,
which is installed automatically with the SAP Business One client.

Prerequisite

For the SAP Business One client agent to upgrade third-party add-ons in silent mode, you must recreate the ARD
file of the add-on, using the latest version of the Add-On Registration Data Generator. For more information, see
Enabling Silent Upgrades for Third-Party Add-Ons.

Procedure

Run the client as the administrator.
Log on to a company.
A system message appears to inform you that the client is not updated.
In the system message window, choose OK to upgrade the client.
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Alternatively, you can run the setup wizard to upgrade the client or reinstall the client using the client installation
program. The client installation package is available in the entire product package, as well as in the shared folder
b1_shf.

 Note
Automatic upgrade for the 9.0 PL11 client is not possible. You must use the setup wizard to upgrade the
client or reinstall the client to a higher version.

 Note
If you want to install or upgrade the SAP Business One client manually in silent mode, you can use the
following command line parameters:
setup.exe /S /z"c:\Program Files (x86)\SAP\SAP Business One
Client\*127.0.0.1:30000"

Where:
/S means "silent mode“
/z is followed by installation parameters: Full Installation Path*System Landscape
Directory Address:Port

6.6 Upgrading SAP Add-Ons

When you select the Add-On checkbox in the Component Selections window of the setup wizard, the following
occurs:
· New versions of all SAP add-ons are automatically registered on the SAP Business One server.
· New installers are uploaded to the server during the upgrade of the common database.

Add-ons that were already installed and assigned to a company are re-registered with new releases and assigned
to the same company.
On a client computer, upon the next logon to a company assigned with add-ons, installers for the new add-on
releases run automatically.

6.6.1 Troubleshooting Add-On Upgrades

When upgrading add-ons in an upgraded company for which the server name was previously something like
(local), you may encounter a message about installation failure.
SAP Business One has introduced a license security mechanism, and we do not recommend that you specify a
server name such as (local). In this case, during an upgrade, the user defines the server name as an IP address
or a computer name. The application does not find the previous, (local), name of the upgraded company, which
prevents the previous add-ons from being upgraded.
To solve this problem, do the following:

Go to the …\SAP Business One\ folder and locate the AddonsLocalRegistration.sbo file.
Change the server name of each related add-on to the new name specified in the license server.
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 Example
o Old name: <Common ID="1" Name="(local)"/>
o New name: <Common ID=”1” Name=”MyServerName”/>

6.6.2 Enabling Silent Upgrades for Third-Party Add-Ons

To enable the SAP Business One client agent to upgrade a third-party add-on in silent mode, do either of the
following:
· If your add-on needs to be installed, you must recreate the add-on’s ARD file using the latest version of the

Add-On Registration Data Generator to enable silent upgrades (and installations).
· If your add-on does not need to be installed, you can use the Extension Manager to manage its upgrade. For

more information, see the guide How to Package and Deploy SAP Business One Extensions for Lightweight
Deployment on sappartneredge.com.

Enabling Silent Upgrade Using Add-On Registration Data Generator

To start the Add-On Registration Data Generator, run the AddOnRegDataGen.exe file, which is typically
located in the ...\SAP Business One SDK\Tools\AddOnRegDataGen folder.
Load an existing file or enter the mandatory information.
For more information, see Create a Registration Data File in the SDK help file.
Select the Silent Mode checkbox.
If necessary, in the Installer Command Line, Uninstaller Command Line Arguments, or Upgrade Command
Line field, enter any required command line arguments.
Choose the Generate File button.

 Note
You may be required to rebuild the installation package of the add-on and redesign the installation and
configuration process. For example, if the add-on uses an installation wizard that requires the user to
specify some information, then you can perform the configuration steps in the SAP Business One client
after installing the add-on instead. Alternatively, you can provide the required information as command
line arguments in the ARD file.
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7 Performing Post-Installation Activities

Immediately after installing SAP Business One, version for SAP HANA, you are required to perform the following
activities:
· Configuring various SAP Business One services
· Configuring the SAP Business One client, version for SAP HANA
· Assigning SAP Business One add-ons, version for SAP HANA
· Performing post-installation activities for the integration framework

 Note
If you use Microsoft Internet Explorer to access the SLD, license, or job service control center on
Microsoft Windows Server 2008 R2, you must first disable the Microsoft Internet Explorer Enhanced
Security Configuration (IE ESC), as follows:

In Microsoft Windows, choose Start → All Programs → Administrative Tools → Server Manager.
In the Server Manager window, in the Security Information area, click Configure IE ESC.
In the Internet Explorer Enhanced Security Configuration window, in the Administrators and Users
areas, select both Off radio buttons.
Choose the OK button.

If you do not want to turn off the IE ESC, you can access the SLD using other Web browsers.

 Note
If you use a proxy for your Internet connection, you must add the full hostname or IP address of any Web
server (for example, SLD) to the proxy exception list of your Web browser; in other words, do not use a
proxy for these addresses.

7.1 Working with the System Landscape Directory

The SLD is a central workplace where you perform various administrative tasks. After installing the server tools on
your Linux server, the SLD service starts automatically. You can then access the SLD with a Web browser using a
URL in the following format: https://<Server Address>:<Port>/ControlCenter.

 Note
The URL address is case-sensitive.

You can access the SLD control center in a Web browser to do the following:
· Add, remove, and edit database servers
· Manage authentication settings for database servers
· View information about the companies on a database server
· Enable single sign-on functionality
· Manage encryption keys
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· Manage SAP Business One site users
· Change the database user used to connect to the SAP HANA server

In addition to the above administrative tasks, the SLD works as a security controller for your company schemas.
For more information, see Data Storage Security.

7.1.1 Registering Database Servers on the Landscape Server

For companies to appear on the application´s logon screen, you must register the database server on the
landscape server using the System Landscape Directory.

 Note
If you use Microsoft Internet Explorer to access the SLD, license control center, or SBO Mailer on
Microsoft Windows Server 2008 R2, you must first disable the Microsoft Internet Explorer Enhanced
Security Configuration (IE ESC) as follows:

In Microsoft Windows, choose Start → All Programs → Administrative Tools → Server Manager.
In the Server Manager window, in the Security Information area, click Configure IE ESC.
In the Internet Explorer Enhanced Security Configuration window, in the Administrators and Users
areas, select both Off radio buttons.
Choose the OK button.

If you do not want to turn off the IE ESC, you can access the SLD using other Web browsers.

 Note
If you use a proxy for your Internet connection, you must add the full hostname or IP address of any Web
server (for example, SLD) to the proxy exception list of your Web browser; in other words, do not use a
proxy for these addresses.

Procedure

To access the SLD service, in a Web browser, navigate to the following URL:
https://<Server Address>:<Port>/ControlCenter

In the logon page, enter the site user name and password, and then choose the Log On button.

 Note
The site user name is case sensitive.

On the Servers and Companies tab, in the Servers area, choose the Add button.
In the Add Server window, specify the following information and then choose the OK button:
o Server Name: Specify your SAP HANA database server in the format of <Server Address>:<Port>.

 Caution
Make sure that the server name does not contain any of the following special characters:
o Ampersand (&)
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o Less than sign (<)
o Greater than sign (>)
o Quotation mark (”)
o Apostrophe (’)

o Database User Name: Enter the name of an admin database user. For information about the required
database privileges, see Database Privileges for Installing, Upgrading and Using SAP Business One.

o Database User Password
o [Optional] Backup Path: Specify the path to the backup folder for storing SAP HANA database instance

backups and company schema exports.
If you leave the field blank, the backup folder specified during the backup service installation is used.
If you specify a folder other than the one specified during the installation, you must ensure the specified
folder already exists on the SAP HANA server. Additionally, the SAP Business One service user for the
current installation must be assigned as the owner of the folder. To assign the service user as the folder
owner, do the following:

Log on to the server as root.
To identify the service user running the tomcat server for SAP Business One, run the following
command:
ls -la <Installation Directory>

For example, ls -la /opt/sap/SAPBusinessOne
To change the owner of the backup folder you want to use, run the following command:
chown <User Group>:<Service User> <Installation Directory>

For example, chown b1service0:b1service0 /home/BackupFolder

7.1.2 Managing Encryption Keys

You can encrypt data in your company schemas using a static key or dynamic key.

 Recommendation
We strongly recommend that you use a dynamic key to encrypt your company schemas.

 Caution
Enabling the use of dynamic keys is an irreversible process.

Procedure

Log on to the SLD service.
On the Security Settings tab, in the Encryption Key Management area, choose the Enable Dynamic Key button.

 Note
After enabling the use of dynamic keys, you can generate a new dynamic key at any time. To do so,
choose the Enable Dynamic Key button again.
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Open the SAP Business One client application, log on to each of your companies, and accept to update the
company schema.
Note that you must perform this for all company schemas on the servers registered in the System Landscape
Directory.

7.1.3 Adding Services in the System Landscape Directory

The Services tab of the SLD displays all SAP Business One services that have been installed and registered on the
license server (SAP HANA server). The services include the following:
· License service
· Job service
· Analytics Platform
· App framework
· Backup service

If you accidentally delete a service from the SLD, you must add the service again; otherwise, you cannot use the
service.

Procedure

To access the SLD, in a Web browser, navigate to the following URL:
https://<Server Address>:<Port>/ControlCenter

In the logon page, enter your site user name (B1SiteUser) and password.

 Note
The site user name is case-sensitive.

On the Services tab, choose the Add button.
In the Add Service window, specify the following information:
o Service type: Only installed service types are available.
o Service name: Enter a name for the service
o Service URL: Specify the service URLs as below:

o License: https://<Server Name/IP>:<port>/LicenseControlCenter
o Analytics platform: https://<Server Name/IP>:<port>/Enablement
o Job service: https://<Server Name/IP>:<port>/job
o Browser access service: https://<Server Name/IP>:<port>dispatcher
o App framework: http://<Server Name>:80xx/ or https://<Server Name>:43xx/ (where

“xx” represents the SAP HANA instance number)
o Backup service: https://<Server Name/IP>:<port>/BackupService/
o Service Layer: https://<Server Name/IP>:<port>
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7.1.4 Managing Site Users

The site user account serves as site-level authentication for performing various administrative tasks, as listed in
the table below:

Site Users Function

B1SiteUser Lifecycle management: installation, upgrade, uninstallation

Configuring services installed on Windows (for example, Workflow service)

Company creation

All All operations performed in the System Landscape Directory

Accessing and performing operations in Web-based service control centers (for example,
job service, Administration Console of the analytics platform)

B1SiteUser

The site super user, whose account information should only be known to a few selected system administrators, is
B1SiteUser. You can update the password of B1SiteUser in the System Landscape Directory, on the Security
Settings tab, by choosing the Change B1SiteUser Password button. You will need to provide the old password to
make the change.
The B1SiteUser account cannot be removed.

Domain Users as Less-Privileged Site Users

You can assign appropriate Windows domain users as site users to perform administrative tasks that require
fewer privileges in the System Landscape Directory.

Prerequisite

You have entered Windows domain user authentication information during the installation of the System
Landscape Directory. For more information, see Installing Server Components.

Procedure

To assign a Windows domain user as a less-privileged site user, do the following:
In a Web browser, log on to the System Landscape Directory.
On the Security Settings tab, choose the Manage Site Users button.
In the Manage Site Users window, in the edit box on the top, enter a domain user account in the format of
Domain\User.
To assign the domain user as a site user, choose the Add button.

Result

You can delete domain-user site users at any time. Additionally, a domain user can even remove itself as a site
user. After the removal, the domain user can no longer log on to the System Landscape Directory.
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7.1.5 Mapping External Addresses to Internal Addresses

To enable access from outside the local network, you must map an external access URL to each required
component.

Procedure

In a Web browser, log on to the system landscape directory using this URL:
https://<Hostname>:<Port>/ControlCenter.
On the External Address Mapping tab, choose Register.
In the Register External Address window, specify the following information:

Component
Hostname or IP address of the machine on which the component is installed
External URL
The external access URL must have the format <protocol>://<Path>:<Port>.

 Example
http://10.58.9.100:8080

The Hostname/IP Address field for the SLD may display the hostname rather than the FQDN of the SLD
server, or it may be empty; either is fine and can be ignored.
Choose OK.

Post-requisites

After finishing mapping the addresses for all required components, you must restart the services on the machines
on which they're installed.
For example, if you have registered the external address mapping for a Browser Access server, you must restart
the SAP Business One Browser Access Server Gatekeeper service.
Note that the restart of SAP Business One Browser Access Server Gatekeeper service may take from 5 to 10
minutes.
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7.2 Configuring Services

You must configure the services you have installed in order for them to operate properly. The subsections below
introduce how to configure various services.

 Note
To use the analytical features powered by SAP HANA, you need to initialize and maintain SAP Business
One company schemas in the Administration Console. For more information, see Initializing and
Maintaining Company Schemas for Analytical Features.
For more information about the backup service, see Exporting Company Schemas.

7.2.1 License Control Center

 Caution
If you have installed a firewall on the license server, make sure that the firewall is not blocking the port
number you use for the license service; otherwise, the license service and SLD cannot work.
In addition, if you are using port X, make sure that you open both port X and port (X+1) in the firewall. For
example, if you are using port 40000, make sure to also open port 40001.

The license service is a mandatory service that manages the application license mechanism according to the
license key issued by SAP. Web access to the license service enables you to do the following:
· Find and copy the hardware key to run your SAP Business One application, version for SAP HANA and apply

for SAP licenses
· Import the license file
· View the basic license information

For new installations, you can use the application for a period of 31 days without a license key. After that period,
the SAP Business One application, version for SAP HANA needs a license key to run. We strongly recommend that
you request a license key immediately after installing the application.
You also must install a new license key whenever any of the following occurs:
· You have additional users or components.
· The hardware key changes.
· The current license expires.
· You installed a new version of SAP Business One, version for SAP HANA.

To avoid accidentally changing the hardware key, do not perform the following actions on the license server
computer:
· Format the computer and reinstall Linux using another product key for Linux.
· Change the computer name
· Change the domain (the hardware key does not change back when you return to the previous domain.)

The following actions are safe and do not change the hardware key:
· Add a new user logon
· Change the computer date or time
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Procedure

In a Web browser, navigate to the following URL:
https://<Server Address>:<Port>/LicenseControlCenter

Alternatively, on the Services tab in the System Landscape Directory, you can click the license manager link to
access the license control center.

 Notes
o If you use a proxy for your Internet connection, you must add the full hostname or IP address of any

Web server (for example, SLD) to the proxy exception list of your Web browser; in other words, do not
use a proxy for these addresses.

o The URL of the service is case-sensitive.
If you have not logged on to the SLD service, in the logon page, enter the site user name and password, and
then choose the Log On button.

 Note
The site user name is case sensitive.

The General Information area displays the details of the license server.
If you have not yet obtained a license key, apply to SAP for a license key using the hardware key. If you are a
partner, for more information, see License Guide for SAP Business One 9.2, version for SAP HANA on
sappartneredge.com.
To install the license key, choose the Browse button, select the TXT file you received from SAP, and then
choose the Import License File button.

7.2.2 Job Service

The job service manages the following settings on the server side:
· SBO Mailer settings
· Alert settings

7.2.2.1 SBO Mailer

This optional service enables you to send e-mails from SAP Business One, version for SAP HANA.

7.2.2.1.1 Configuring SBO Mailer

The process of configuring SBO Mailer comprises the following steps:
Define the mail settings
Select companies
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Connect to the SMTP server

 Note
The SBO Mailer configuration Web page does not provide access to SBO Mailer e-mail signature settings.
To access these settings, in the SAP Business One Main Menu, choose Administration → System
Initialization → E-Mail Settings.

Procedure

In a Web browser, navigate to the following URL:
https://<Server Address>:<Port>/job

Alternatively, on the Services tab in the system landscape directory, you can click the Job Service link to
access the settings.

 Notes
o If you use a proxy for your Internet connection, you must add the full hostname or IP address of any

Web server (for example, SLD) to the proxy exception list of your Web browser; in other words, do not
use a proxy for these addresses.

o The URL of the service is case-sensitive.
If you have not logged on to the SLD service, in the logon page, enter the site user name (B1SiteUser) and
password, and then choose Log On.

 Note
The site user name is case sensitive.

On the Mailer Settings tab, specify the following mandatory mail settings information and choose Save to save
your settings:
o SMTP Server: Name or IP address of your outgoing mail server.
o SMTP Port: Specify the port number for the SMTP server.

 Note
If your SMTP server does not allow anonymous connection, specify a user name and password;
otherwise, select the Anonymous checkbox.

o In the Language dropdown list, select the language for email text.
o If your SMTP server requires TLS encryption, make sure the Use TLS Encryption checkbox is selected.
o If you are using a right-to-left language, select the Right-to-Left checkbox.
o To include the subject line in the body of the message, select the Include Subject in Message Body

checkbox.
From the Database Server dropdown list, select an appropriate server.
Select the companies for which you want to set up the SBO Mailer service, and choose Save.
To connect to the SMTP server, choose Start.
The status changes to RUNNING and the button changes to Stop.
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 Note
To change the SMTP server, add or remove companies, you must first stop the connection by choosing
Stop.

Result

You can now proceed to create a mount point for your shared attachments folder in your Linux server. For more
information, see Setting Up Shared Attachments Folder.

7.2.2.1.2 Setting Up Shared Attachments Folder

To send emails with attachments using SBO Mailer, you must perform some additional configurations.

Procedure

Create a folder on either a Linux machine or a Windows machine and grant full permission to the folder, for
example: \\server\folder\shared_folder.
Log on to the SAP Business One client and do the following:

On the Path tab of the General Settings window (Main Menu → Administration → System Initialization →
General Settings), specify "\\server>\folder\shared_folder" as the attachments folder.
Send a test email with an attachment (for example, an A/R invoice).

In the SAP HANA studio, execute the following query against the company schema in question:
select top 1 "Attachment" from OALR order by "Code" Desc

The result looks like the following: "\\server\folder\shared_folder\AR Invoice_1.pdf".
Copy the query result to a text editor, remove the file name, and replace the backslash (\) with the forward
slash (/).
The result is the shared folder path saved in the database, for example:
//server/folder/shared_folder.
Log on to the Linux server as root and do the following:

Create an empty folder, for example: /mnt/sbomailer.

 Caution
The name of the mount point must not contain underscores (_).
o Correct example: /mnt/sbomailer
o Incorrect example: /mnt/sbo_mailer
Mount the folder in step 4 to the empty folder, using the following command:
mount -t cifs -o user=b1service0,pass=b1service0
'//server/folder/shared_folder' /mnt/sbomailer
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7.2.2.1.3 Troubleshooting

The following troubleshooting information may be required when configuring the mail services:
Ensure that you have already set up email accounts for SAP Business One users on the specified mail server.
To verify the connection with the mail server, in the Mail Settings area, choose Test Connection.
If the SMTP server requires authentication, for example, if the SMTP server is configured to accept only
logon-authenticated mails, you must not select the Anonymous option in the Mail Settings area.
To check whether the connection to the SMTP server works, send a test email. If the connection fails, verify
that you have done the following:
o Entered the correct name of your mail server
o Entered the correct user name and password
o Restarted the connection to the SMTP server after changing any of the settings

7.2.2.2 Alert Settings

In order to use the alert function to have SAP Business One automatically notify selected users whenever certain
system events occur, you must first start the alert service for the companies on the server side.

Procedure

In a Web browser, navigate to the following URL:
https://<Server Address>:<Port>/job

Alternatively, on the Services tab in the system landscape directory, you can click the Job Service link to
access the settings.

 Notes
o If you use a proxy for your Internet connection, you must add the full hostname or IP address of any

Web server (for example, SLD) to the proxy exception list of your Web browser; in other words, do not
use a proxy for these addresses.

o The URL of the service is case-sensitive.
If you have not logged on to the SLD service, in the logon page, enter the site user name (B1SiteUser) and
password, and choose Log On.

 Note
The site user name is case sensitive.

On the Alert Settings tab, if you want to change the technical user used to execute the alerts, enter the user
code for an SAP Business One user and then choose Save.

 Note
If you want to use a different user than the default user AlertSvc, you must ensure the user is created in
all the companies. Otherwise, all the alert settings are ineffective for the companies missing this user.
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This technical user is used for database connection and not intended for any business transactions. You
do not have to assign a license to this technical user and we recommend that you don't.

From the Database Server dropdown list, select an appropriate server.
Select the companies for which you want to use the alert function, and choose Save.
To start the alert service, choose Start.
The status changes to RUNNING and the button changes to Stop.

 Note
To change the technical user or change the company selection, you must first stop the connection by
choosing Stop.

Result

You can now log on to each of your companies in the SAP Business One client and define the alert settings on the
client side. For more information, see the online help.

7.2.3 App Framework

After installation is complete, SAP HANA Extended Application Services (SAP HANA XS engine) switches to
embedded mode. We highly recommend that you keep the SAP HANA XS engine in embedded mode to enhance
the overall performance of the app framework.

Port Number

The default port number used for the app framework is 43xx or 80xx (where xx represents the SAP HANA
instance number).

 Example
If you installed the server tools on SAP HANA instance 01, you should ensure port 4301 or 8001 is not
being used by other applications.

If you have changed the port used for the SAP HANA XS, you must update the port number in the System
Landscape Directory (SLD) for the app framework service. To do so, follow the steps below:

To access the SLD, in a Web browser, navigate to the following URL:
https://<Server Address>:<Port>/ControlCenter

In the logon page, enter the site user name and password, and then choose the Log On button.

 Note
The site user name is case sensitive.

On the Services tab, select the app framework service and choose the Edit button.
In the Edit Service window, in the Service URL field, change the port number (the number behind the colon).
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To save the changes, choose the OK button.
For more information, see the Maintaining HTTP Destinations section of the SAP HANA Developer Guide at
http://help.sap.hana/hana_platform and instructions about configuring SSL in this guide.

7.2.4 Service Layer

After the installation, to start working with the Service Layer, ensure that the SBOCOMMON schema and your
company schema are installed or upgraded to the same version. In addition, the SAP HANA database user used
for connection must have the following SQL object privileges:
· SBOCOMMON schema: SELECT, INSERT, DELETE, UPDATE, EXECUTE (all grantable)
· Company schema: Full privileges

7.2.5 SBO DI Server

This optional service enables multiple clients to access and manipulate the SAP HANA database. To use it, you are
required to have a special license.
For more information, see the SDK Help Center.

7.2.6 SAP Business One Workflow

The workflow service enables you to standardize your business operations to increase overall efficiency. With
predefined conditions, the system automatically executes various tasks, liberating labor resources for more
creative activities.
For more information, see How to Configure the Workflow Service and Design the Workflow Process Templates at
http://service.sap.com/smb/sbocustomer/documentation. The guide includes samples and additional reference
materials.

7.3 Initializing and Maintaining Company Schemas for
Analytical Features

This section provides information about checking and maintaining your company schemas for the analytical
features powered by SAP HANA.
To avoid disrupting customers’ daily business activities in SAP Business One, version for SAP HANA, the
application provides a Web-based Administration Console that can be used to initialize and maintain company
schemas on the SAP HANA database server.

http://help.sap.hana/hana_appliance
http://service.sap.com/smb/sbocustomer/documentation
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 Note
For more information about system administration and maintenance of SAP HANA, see SAP HAHA
database administration guides on SAP Help Portal at http://help.sap.com/hana_platform.

7.3.1 Starting the Administration Console

To initialize and maintain company schemas on SAP HANA, you must first start the Administration Console.

Procedure

In a web browser, navigate to the following URL:
https://<Server Address>:<Port>/Enablement

In the logon page, enter the site user name and password, and choose the Log On button.
The Administration Console homepage appears. The following table describes the different sections on the
homepage:

Section Description

SAP HANA Server Statistics Displays SAP HANA database server information.
When the memory usage or disk volume usage reaches 90% or more, the
status bar turns from blue to red. We recommend that you release some
memory or disk space when you see the warning.

 Caution
If you have changed the password of the COMMON user that is
exclusively used by the analytics platform to connect to the SAP
HANA database, you must update the password accordingly in the
Administration Console, as follows:

Update the password by choosing the Change Password button.
Stop and restart SAP Business One analytics powered by SAP
HANA. For more information, see the section “Restarting SAP
Business One Services on Linux” in Troubleshooting.

License Displays the license server information.

Company Overview Displays the following information:
· Number of companies
· Number of initialized company schemas
· Number of company schemas for which you have scheduled data staging

http://help.sap.com/hana_platform
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7.3.2 Initializing and Updating Company Schemas

To use functions provided by SAP Business One analytics powered by SAP HANA in your SAP Business One
companies (for example, enterprise search, SAP HANA models, real-time dashboards, Excel Report and
Interactive Analysis, and SAP Crystal Reports), you need to initialize or update company schemas in the
Administration Console, depending on the specific scenarios, as listed in the table below:

Operation Function Scenario

Initialization Deploys various analytical contents
to your company (for example,
models, Crystal reports, and
dashboards), and prepares the
company for data staging.

Required in either of the following situations:
· The status of your company is New.
· You have reinstalled SAP Business One analytics

powered by SAP HANA.

Update Updates your company with
analytical contents while
maintaining all customized contents
and settings.

 Note
Update is possible only for
companies that have
already been initialized.

Required in either of the following situations:
· Your company status changes to Update

Required, usually because you have upgraded the
SAP Business One system and the analytical
contents have changed.

· You want to change the model language.

Reinitialization Redeploys analytical contents to
your company and erases all
customized contents and settings.

Required in either of the following situations:
· Several update attempts have failed.
· The status of your company changes to

Reinitialization Required, explicitly
requesting you to reinitialize the analytical
contents of your company.

 Note
The initialization process also deploys the specified language version of predefined SAP HANA models.
For more information about deploying SAP HANA models, see the online help of SAP Business One,
version for SAP HANA.

Prerequisite

If third-party models or procedures in your company schema reference retired views or ETL tables, before you
perform initialization or update on the schema, ensure either of the following:
· The staging compatibility mode is on, which is the default mode for upgraded companies.
· If the staging compatibility mode is off, you have removed the dependencies of third-party models or

procedures on retired views or ETL tables.
For more information, see SAP Note 2000521 (retirement progress) and Staging Compatibility Mode.

https://service.sap.com/sap/support/notes/2000521
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 Note
Before all ETL tables are removed, data staging is still required because some system views are still based
on ETL tables.

Initializing Company Schemas

The following procedure describes how to initialize a company schema.
Log on to the Administration Console. For more information, see Starting the Administration Console.
On the Companies tab page, click the company schema that you want to initialize.
The company page for the company you have chosen is displayed.
In the Database Initialization section, from the Model Language dropdown list, select a language. The labels of
pre-defined models provided by SAP will be displayed in the selected language after initialization.

 Note
If you want to change the display language after initialization, make the change directly in the
Administration Console and then update the company (by choosing the Update button) to apply the
change.
Different language versions of a model cannot coexist. Whichever way you choose the change the model
language, the previous language version is overwritten.

Choose the Initialize button.
In the confirmation message box, choose the Yes button.

 Note
The initialization process may take some time, depending on the size of the schema.

 Note
The system performs some checks before starting the initialization. Each check must be in the status as
listed in the table below:

Check Status

The SAP HANA database server (Linux) has enough free disk space for
the initialization.

Yes

All user-defined objects have names Yes

The name of any user-defined objects is SYSTEM, or SYS, or begins with
_SYS_.

No

The name of any user-defined object is the same as that of a certain SAP
HANA object of one of the following object types: TABLE, TYPE,
SEQUENCE, PROCEDURE, FUNCTION, INDEX, VIEW, MONITOREVIEW,
SYSNONYM, and TRIGGER.

No

Result
The Database Initialization section displays the status of the initialization process. The initialization status is New
before the initialization, In Process during the initialization, and Initialized after the initialization is
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completed. The status bar in the Database Initialization section displays the specific status when the system is
migrating tables, or deploying enterprise search, SAP HANA models, and dashboards.
If any error occurs during the initialization, an error message appears in the company log indicating which row in
which table the error was encountered.

Updating or Reinitializing Company Schemas

After you initialize a company schema, the Initialize button changes to Update. You may update the analytical
contents for your company, depending on your needs.
In some exceptional cases, the update may not succeed and you must reinitialize your company schema.
However, compared with a relatively light-weight update, reinitialization removes all customized contents and
settings; therefore, we strongly recommend that you do not attempt reinitialization unless necessary. In addition,
although update is a comparatively light operation, data staging is stopped during the update and it may also
bring about disruption to your daily work; therefore, we also recommend that you perform update during off
hours.
If reinitialization is required for a company, then on the corresponding company page in the Administration
Console, choose the button and then choose Re-initialize from the dropdown list to perform reinitialization.
Result
If your company was in the process of data staging before the update or reinitialization, data staging is
automatically resumed after the update or reinitialization is complete.

7.3.2.1 Staging Compatibility Mode

While the data staging function facilitates the use of data for analytical purposes, it slows down transactions on
the database and impacts system performance. With higher versions of SAP HANA, the performance of OLAP
views has significantly improved; analytics with data in memory is as efficient as with staged data. Therefore, SAP
Business One intends to phase out the data staging function and remove the related ETL tables (tables whose
names start with "ETL_", representing "extract, transform, and load") and views. For more information about the
retirement progress, see SAP Note 2000521.
As partners may have built models and stored procedures based on the removed ETL tables or views, you can
enable the staging compatibility mode to temporarily work on old ETL tables and views; after your partners have
rebuilt the models or procedures, you can disable the staging compatibility mode and start to work with
redesigned analytics functions, taking advantage of more powerful new views and other features. By default, the
staging compatibility mode is:
· Kept as is for initialized companies which are upgraded from lower versions
· Off for upgraded but not initialized companies
· Off for new companies

Procedure

To enable or disable the staging compatibility mode, do the following:
Log on to the Administration Console. For more information, see Starting the Administration Console.

https://service.sap.com/sap/support/notes/2000521
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On the Companies tab page, click the company for which you want to turn on the staging compatibility mode.
The company page for the company you have chosen is displayed.
On the company page, choose the button and then in the dropdown list, choose Compatibility Mode.
The Staging Compatibility Mode Configuration window displays the following options:
o On: Enables the staging compatibility mode
o Off: Disables the staging compatibility mode

To change the current setting of the company, select the relevant radio button and then choose the Update
button.
To exit the window, choose the OK button.

Results

The company schema is initialized or updated. The analytical contents in the company schema are updated, as
below:
· If you turned off the compatibility mode:

o New views are deployed to your company.
o Retired ETL tables and related resources are removed from the database.

 Note
If third-party models or procedures still reference the retired ETL tables or views, initialization or update
will fail. However, the compatibility mode remains off. For more information, see Initializing and Updating
Company Schemas.
When the compatibility mode is off, some third-party pervasive dashboards may stop working because
their data sources include retired views. However, company schema initialization or update will succeed.
In this case, you must redesign the pervasive dashboards or turn on the compatibility mode again.

· If you turned on the compatibility mode:
o Retired ETL tables and related resources (for example, lower versions of pre-defined models) are

deployed to your company.
o New views still exist in the database.

7.3.3 Scheduling Data Staging

Data staging gathers data from the SAP HANA database for better and faster utilization of the data in Excel
Report and Interactive Analysis. For more information about Excel Report and Interactive Analysis, see the online
help of SAP Business One, version for SAP HANA.
The data staging automatically starts when you initialize the company schema. However, if you want to stop the
data staging for faster performance in the back-end, you can stop the service at any time.

 Note
When data staging is in progress, you may lose connection to the SAP HANA server for various reasons;
for example, if the SAP HANA server is restarted. In such cases, the data staging service repeatedly
attempts to reconnect to the SAP HANA server within a defined period of time (4 hours by default). If the
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SAP HANA server is reconnected within that period of time, the data staging service will continue
gathering the unfinished data; if the SAP HANA server remains unreachable after that period of time, the
data staging service is stopped. For more information, see Configuring Data Staging Service Parameters.

You can start, stop, and schedule the data staging function in the Administration Console.

Procedure

Log on to the Administration Console. For more information, see Starting the Administration Console.
Go to the Companies tab page and click the company for which you want to schedule data staging.
In the Data Staging Schedule section, do one of the following:
o If you want to stage data in near real time, select the Real-time Data Staging radio button.
o If you want to stage data at regular intervals, select the Scheduled Data Staging radio button.

From the Frequency dropdown list, select a recurrence interval. If you select 1 day, select a time from the
Start Time dropdown list to specify when the data staging starts every day.

To apply your settings and start the schedule, choose the Start button. If you want to stop the data staging
service later, choose the Stop button.

Result

If any error occurs during data staging, an error message appears in the company log indicating which row in
which table the error was encountered.

7.3.3.1 Configuring Data Staging Service Parameters

In case of errors, the data staging service attempts to resume data staging within a certain period of time. This
section describes how to change the duration and frequency of retry attempts.

 Caution
Improper configuration may cause performance issues or even lead to system crashes. It is strongly
recommended that you first test configured parameters in a development environment.
By default, the configuration file StagingConfig.xml is located under
/usr/sap/SAPBusinessOne/AnalyticsPlatform/Conf.

 Note
After changing any of the parameters, you must restart SAP Business One analytics powered by SAP
HANA to apply the changes.
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secondsToRetryForStagingCycleFailure

Purpose

This parameter defines the time interval between the system's attempts to restart a failed data staging cycle. The
time interval is measured in seconds.

Use Case

You want the restarting attempts to be more frequent or less frequent.

Valid Value

Zero or a positive integer. Note that the value cannot be greater than the minutesToStopForStagingCycleFailure
value converted to seconds.
Default value: 10

minutesToStopForStagingCycleFailure

Purpose

This parameter defines the duration of the system's continual attempts to restart a failed staging cycle. The
duration is measured in minutes.
If the data staging service does not recover from the errors that caused the failure during the defined duration, the
service stops automatically.
For more information, see the section “secondsToRetryForStagingCycleFailure”.

Use Case

You want a longer or shorter duration for restarting attempts.

Valid Value

Zero or a positive integer.
Default value: 240

7.3.4 Assigning UDFs to Semantic Layer Views

You can make user-defined fields (UDFs) available in semantic layer views directly in the Administration Console.
This method has two advantages:
· You do not have to make the assignments in each view in the SAP HANA studio.
· If you assign a UDF to a view, you must also assign the UDF to all views that are referenced by this view. With

this new feature, you only need to assign UDFs to the top-level query views (names of which end with
"Query") and the UDFs are automatically assigned to all referencing views.

· For information about the prerequisites for consuming UDFs in Excel Report and Interactive Analysis, see SAP
Note 2168402.

https://service.sap.com/sap/support/notes/2168402
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Prerequisites

· The UDFs available for configuration meet the following requirements:
o The UDFs are added to system tables, not to user-defined tables.
o Each UDF title contains only English letters (a-z/A-Z), numbers (0-9), and underscores.

· You have initialized the company for which you want to configure UDF availability in the semantic layers. In
other words, the status of the company schema must be Initialized.

Procedure

Log on to the Administration Console. For more information, see Starting the Administration Console.
Go to the Companies tab page and click the company for which you want to configure UDF availability in the
semantic layers.
On the company page, choose the button and then in the dropdown list, choose UDF Configuration.
The UDF Configuration in Semantic Layer window opens and displays only the categories (business objects)
which contain UDFs.
To assign a UDF to the semantic layers, do the following:

On the left pane of the window, select the UDF row.
The right pane displays the relevant views. These views include only system query views.
Select the corresponding Assign checkbox.
If the UDF is a numeric value, on the right pane, do the following:

Define its type in a view: measure or attribute.
If you define it as a measure, define its aggregation type.
Repeat the above steps for each view.

 Recommendation
If the UDF is in a header table, define it as an attribute in line views (names of which contain the word
"Detail", for example, APReserveInvoiceDetailQuery).

 Note
If the UDF is not a numeric value, it can only be used as an attribute.
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To save the configurations, choose the Save button.

 Note
If another conflicting process (for example, UDF configuration, reinitialization or update) is already
ongoing in this company, you must wait until the other process is complete.

Wait for the configuration to complete. The time may vary from a few minutes to much longer depending on
various factors such as the number of UDFs to be assigned.

Results

Configuration in Progress

While waiting for the configuration to complete, you cannot perform other tasks on this company schema which
conflict with the configuration. For example, you cannot reinitialize or update the company schema until the
configuration is complete. We recommend the following:
· Keep the browser tab with the Configuration Progress window open.

This not only ensures that you can track the configuration progress, but also ensures that you can revert the
changes in case of a configuration failure. If you have closed the Configuration Progress window, you can only
check the company log to determine the configuration result.

· If you need to perform tasks on other company schemas, open a new Web browser or browser tab.
· Do not run the UDF configuration process on many company schemas simultaneously because

configurations on the semantic layers usually consume a fair amount of SAP HANA resources.

Configuration Failed

If the configuration process encounters an error, the process stops at the first failed assignment. If you have kept
the Configuration Progress window open, you can reverse the changes that have already been made. The
reversion not only removes the previous successful assignments (or unassignments), but also ensures no view is
negatively impacted by the failure.
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If you have already closed the Configuration Progress window, you are not able to reverse the changes, and the
successful assignments (or unassignments) are kept. The query view which failed the assignment, as well as the
views referencing this query view, cannot be properly consumed.

 Example
A UDF has been added to the business partner object. There are two relevant views. When you attempt to
assign the UDF to the semantic layers, the configuration encounters an error and fails the assignment to
the second view.
If you do not reverse the changes, the UDF is still assigned to the first view. As the second assignment
may be partly made, the second view may not be properly consumed, as well as the views that reference
the second view.

Configuration Completed

After assigning a UDF to the semantic layers, the results are as below:
· You can include the UDF in the relevant query views as well as in views which reference those views.
· The technical name of the UDF is the UDF title with a set prefix. For more information about the prefixes, see

How to Work with Semantic Layers on sappartneredge.com.
· If you later remove the UDF from the company schema in the SAP Business One client application, you must

clean up the relevant views to remove the assignment.
In the UDF Configuration in Semantic Layer window, a new Clean Up button becomes available. After choosing
this button, the UDF is unassigned from both the relevant query views and the views which reference the
query views.
If you do not perform the cleanup, the following consequences may occur:
o If a tool or report consumes these views (query views and referencing views), the tool or report cannot

work properly.
o You may fail with new UDF configurations.

7.4 Enabling External Browser Access

The SAP Business One Browser Access service helps you use SAP Business One outside your corporate
networks. For secure access, you must be sure to do the following:

Use an appropriate method to handle external requests.
Use valid certificates to install relevant SAP Business One services.
Assign an external address to each relevant SAP Business One service.
Build proper mapping between the external addresses and the internal addresses.

Alternatively, you can use Citrix or similar solutions for external access. These third-party solutions are not
covered in this guide.

http://sappartneredge.com/
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7.4.1 Choosing a Method to Handle External Requests

As the Browser Access service enables you to access SAP Business One from external networks, it is essential
that external requests can be sent properly to internal services.
To handle external requests, we recommend deploying a reverse proxy rather than using NAT/PAT (Network
Address Translation/Port Address Translation). Compared with NAT/PTA, the reverse proxy is more flexible and
can filter incoming requests.

 Note
Regardless of the method, the database services are not exposed to external networks; only the SAP
Business One services are exposed. However, you must never directly assign an external IP address to
any server with SAP Business One components installed.
To improve your landscape security, you can install your SAP database server on a machine other than
the one holding SAP Business One components.

Reverse Proxy

A reverse proxy works as an interchange between internal SAP Business One services and external clients. All the
external clients send requests to the reverse proxy and the reverse proxy forwards their requests to the internal
SAP Business One services.
To use a reverse proxy to handle incoming external requests, you need to:

Import a trusted root certificate for all SAP Business One services during the installation.
The certificate can be issued by a third-party certification authority (CA) or a local enterprise CA. For
instructions on setting up a local certification authority to issue internal certificates, see Microsoft
documentation.
All the components (including the reverse proxy) in the SAP Business One landscape should trust the root CA
which issued the internal certificate for all SAP Business One services.
Purchase a certificate from a third-party public CA and import the certificate to the reverse proxy server.
Note that this certificate must be different from the first certificate. While the first certificate allows the
reverse proxy to trust the CA and, in turn, the SAP Business One services, the second certificate allows the
reverse proxy to be trusted by external clients.
All clients from external networks naturally trust the public CA and, in turn, the reverse proxy. A chain of trust
is thus established from the internal SAP Business One services, to the reverse proxy, and to the external
clients.

NAT/PAT

If you prefer NAT/PAT to a reverse proxy, be aware that all clients connect directly to the internal SAP Business
One services, external clients and internal clients alike.
To use NAT/PAT, you must purchase a certificate from a third-party CA and import the certificate to all machines
installed with SAP Business One services. All the clients must trust this third-party public CA.

https://technet.microsoft.com/en-us/library/cc995096.aspx
https://technet.microsoft.com/en-us/library/cc995096.aspx
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7.4.2 Preparing Certificates for HTTPS Services

Any service listening on HTTPS needs a valid PKCS12 (.pfx) certificate to function properly, especially for external
access using the Browser Access service.
How you prepare PKCS12 (.pfx) certificates depends on how you plan to expose your SAP Business One services
(including the Browser Access service) to the Internet (external networks).
When preparing the certificates, pay attention to the following points:
· Ensure the entire certificate chain is included in the certificates.
· To streamline certificate management, set up a wildcard DNS (*.DomainName).
· The public key must be a 2048-bit RSA key.

Note that JAVA does not support 4096-bit RSA keys and 1024 bits are no longer secure.
Alternatively, you can use 256-bit ECDH keys, but RSA-2048 is recommended.

· The signature hash algorithm must be at least SHA-2 (for example, SHA256).

Reverse proxy (recommended)

For a reverse proxy, prepare an internal certificate for the internal domain and import the internal root certificate
to all Windows servers. Then purchase for the external domain another external certificate issued by a third-party
CA and import this certificate to the reverse proxy server.

NAT/PAT

If you use NAT/PAT to handle external client requests, purchase a certificate issued by a third-party CA for both
internal and external domains.
If the internal and external domains have different names, this certificate should list both domains in the Subject
Alternative Name field. However, we recommend that you use the same domain name for both internal and
external domains.

7.4.3 Preparing External Addresses

To expose your SAP Business One services to the Internet (external networks), you must prepare external
addresses for relevant components.

 Note
The Service Layer is for internal component calls only and you do not need to expose it to the Internet.

Please pay attention to the following points:
· The external address and the internal address of each component must be different; otherwise, the external

networks cannot be distinguished from the internal network, making browser access impossible.
· Only one set of external addresses is supported. Communication via the DNS alias of an external address will

lead to error.
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Reverse Proxy Mode

If you intend to handle client requests using a reverse proxy, we recommend that you use different domain names
for internal and external domains. For example, the internal domain is abc.corp and the external domain is
def.com.
Prepare the external addresses as follows:
· Prepare one external address (hostname or IP address) for each of these components:

o System Landscape Directory (SLD)
o Browser Access service
o Analytics service
o Integration framework (if you use the SAP Business One mobile solution)

· The internal address of each component must match the common name of the certificate for the internal
domain; the external address of each component must match the common name of the purchased certificate
for the external domain.

 Example
The internal URLs of the components are as follows:
o System Landscape Directory: https://SLDInternalAddress.abc.corp:Port
o Browser Access service: https://BASInternalAddress.abc.corp:Port/dispatcher
o Analytics service: https://B1AInternalAddress.abc.corp:Port/Enablement
o Integration framework: https://B1iInternalAddress.abc.corp:Port/B1iXcellerator

The external URLs are as follows:
o System Landscape Directory: https://SLDExternalAddress.def.com:Port
o Browser Access service: https://BASExternalAddress.def.com:Port/dispatcher
o Analytics service: https://B1AExternalAddress.def.com:Port/Enablement
o Integration framework: https://B1iExternalAddress.def.com:Port/B1iXcellerator

NAT/PAT

If you intend to handle client requests using NAT/PAT, we recommend that you use the same domain name
across internal and external networks. For example, both the internal and external domains are abc.com.
Prepare the external addresses as follows:
· Prepare one external address (hostname or IP address) for each of these components:

o System Landscape Directory (SLD)
o Browser Access service
o Analytics service
o Integration framework (if you use the SAP Business One mobile solution)

· The combination of external address and port must be different for these components. In other words, if two
components have the same external address, the ports they listen on must be different; and vice versa.

· The internal address and external address of each component must match the common name of the
certificate purchased for both the internal and external domains.
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 Example
The internal URLs of the components are as follows:
o System Landscape Directory: https://SLDInternalAddress.abc.com:Port
o Browser Access service: https://BASInternalAddress.abc.com:Port/dispatcher
o Analytics service: https://B1AInternalAddress.abc.com:Port/Enablement
o Integration framework: https://B1iInternalAddress.abc.com:Port/B1iXcellerator

The external URLs are as follows:
o System Landscape Directory: https://SLDExternalAddress.abc.com:Port
o Browser Access service: https://BASExternalAddress.abc.com:Port/dispatcher
o Analytics service: https://B1AExternalAddress.abc.com:Port/Enablement
o Integration framework: https://B1iExternalAddress.abc.com:Port/B1iXcellerator

7.4.4 Configuring Browser Access Service

The Browser Access service enables remote access to the SAP Business One client in a Web browser. The
Windows service name is SAP Business One Browser Access Server Gatekeeper.

Prerequisite

Ensure that the date and time on the Browser Access server is synchronized with the database server.

Procedure

In a Web browser, log on to the System Landscape Directory control center using this URL:
https://<Hostname>:<Port>/ControlCenter.
On the Services tab, select the Browser Access entry for the particular Browser Access server and then
choose Edit.
In the Edit Service window, edit the following information:
o Service URL: Edit the URL used to access the service.

For example, you may want to use the IP address instead of the hostname. Or the hostname, IP address,
or the port has changed and you must update the service URL to reflect the changes.

o Initial Processes: Specify the initial number of SAP Business One client processes that the Browser
Access service hosts.

o Maximum Processes: Specify the maximum number of SAP Business One client processes that the
Browser Access service can host.

o Idle Processes: Specify the number of standby SAP Business One client processes. When a new SAP
Business One user attempts to log on, an idle process is ready for use.

o Description: Enter a description for this Browser Access server.
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 Example
Specify the following:
o Initial processes: 20
o Maximum processes: 100
o Idle processes: 2

Twenty (20) SAP Business One client processes are constantly running on the Browser Access server
and allow 20 SAP Business One users to access the SAP Business One client in a Web browser at the
same time.
When the 19th SAP Business One user logs on, one (1) more SAP Business One process is started to
ensure that two (2) idle processes are always running in the background.
If more SAP Business One users attempt to access the SAP Business One client in a Web browser, more
idle processes are started, but at most, 100 users are allowed for concurrent access.

To save the changes, choose OK.
To apply the changes immediately, on the Browser Access server, restart the SAP Business One Browser
Access Server Gatekeeper service.

7.4.5 Mapping External Addresses to Internal Addresses

You must register in the System Landscape Directory the mapping between the external address of each of the
following components and its internal address:
· System Landscape Directory (SLD)
· Browser Access service
· Analytics service

Note that you do not need to register the mapping for the integration framework.
For detailed instructions, see Mapping External Addresses to Internal Addresses.

7.4.6 Accessing SAP Business One in a Web Browser

By default, no load balancing mechanism is applied. You can create a Web access portal and redirect requests to
different Browser Access servers using a load balancing mechanism of your own choice, for example, round robin.

Prerequisites

· You have ensured that you can log on to the SAP Business One client installed on the Browser Access server.
· You are using one of the following Web browsers:

o Mozilla Firefox
o Google Chrome
o Microsoft Edge
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Ensure that you have enabled Automatically Detect Intranet Network.
o Apple Safari (Mac and IPad)

Ensure that you have enabled Adobe Flash Player. This is a prerequisite for Crystal dashboards.

Procedure

The following procedure illustrates how to access SAP Business One directly in a Web browser.
In a Web browser, navigate to the external URL of the Browser Access service. For example:
https://BASExternalAddress.abc.com:Port/dispatcher
If you are uncertain about it, you can check the external address mapping in the SLD.
The Browser Access page is opened.

Choose the company and log on.
Now you can work with SAP Business One in your Web browser.
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7.4.7 Monitoring Browser Access Processes

As of release 9.2 PL02, you can monitor the Browser Access processes in a Web page using this URL:
https://dispatcherHostname:port/dispatcher/serviceMonitor/.

7.4.8 Logging

The log files for the browser access service are stored at <Installation Folder>\SAP Business One BAS
GateKeeper\tomcat\logs.
If you need to troubleshoot problems, edit the file <Installation Folder>\SAP Business One BAS
GateKeeper\tomcat\webapps\dispatcher\WEB-INF\classes\logback.xml, and change the logging level
from the default WARN to DEBUG. Note that you must change the logging level back to the default value after
the investigation.
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7.5 Configuring the SAP Business One Client, version for
SAP HANA

After you have installed SAP Business One, version for SAP HANA and logged on to the application for the first
time, you are required to provide the license server address and port number in the License Server Selection
window.
To start the SAP Business One client, version for SAP HANA, choose Start → All Programs → SAP Business One →

SAP Business One. To start the SAP Business One client, version for SAP HANA using the command line, enter the
following command:
“SAP Business One.exe" -DbServerType <SAP HANA Server version> -Server <SAP HANA
Server instance name> -CompanyDB <Company Schema> -UserName <User ID> -Password
<Password> -LicenseServer <License Server address:port>

For the DbServerType parameter, enter 9 for the SAP HANA database server.

 Note
Command line parameters are case-sensitive.

 Caution
For security reasons, do not start the SAP Business One client, version for SAP HANA using the command
line in productive environments. Only use this method for testing.

In the SAP Business One toolbar, you can check the log configurations by choosing Help → Support Desk →

Logger Setting. You can see the relevant configuration log file under: …\SAP\SAP Business
One\Conf\b1LogConfig.xml.

7.6 Assigning SAP Business One Add-Ons, version for SAP
HANA

Add-ons are additional components or extensions for SAP Business One, version for SAP HANA. Installing the
server and client applications automatically registers the SAP Business One add-ons and makes them available
for installation from the SAP Business One application, version for SAP HANA. For more information about
assigning SAP add-ons to your companies, see the Assigning Add-Ons section in the online help document.
The add-ons run under the SAP Add-Ons license, which is included in the Professional User license.
SAP Business One, version for SAP HANA provides the following add-ons:
· 32-bit add-ons:

o Screen Painter
o DATEV FI Interface
o Electronic File Manager
o Microsoft Outlook integration
o Payment Engine

· 64-bit add-ons:
o Screen Painter
o Electronic File Manager
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o Microsoft Outlook integration
o Payment Engine

 Note
For more information about the Microsoft Outlook integration component, a standalone version of the
Outlook integration feature, see Installing the Microsoft Outlook Integration Component.
The ELSTER Electronic Tax return add-on is available for download in the SAP Business One Software
Download Center and is no longer included in the SAP Business One download package. For more
information, see SAP Note 2064562.

Prerequisites

· You have a Professional User license provided by SAP.
· You have installed Microsoft XML 3.0 Service Pack 4 on your workstation. To ensure that this software is

installed on the hard drive of the workstation, check that the msxml3.dll file is saved in the system32
directory in the main Windows directory.

· If you have not included SAP add-ons in the installation of the SAP Business One server, you must register
them in your workstations separately. For more information, see Registering Add-Ons in the online help
documentation.

· You must have Power User or Administrative rights, especially in the terminal server environment.
The following table displays the SAP Business One add-ons, version for SAP HANA and their prerequisites.

Add-On Prerequisites

Screen Painter You have installed Microsoft .NET Framework 2.0 on the SAP Business One,
version for SAP HANA workstation intended to run Screen Painter.

DATEVF FI Interface You have created a new company to work with the DATEV add-on and deselected
the checkboxes: Copy User-Defined Fields and Tables and Copy User-Defined
Objects.
The DATEV add-on may not work with demo databases.

ELSTER Electronic Tax
Return

Ensure that you install Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86). For more information, see www.microsoft.com. You can install it either
before or after you install or upgrade the ELSTER Integration add-on.

Microsoft Outlook
integration

· You have installed Microsoft Outlook on your workstation.
Supported versions: 2000 SR1 and later, 2002, 2003, 2007, 2010, 2013, and
2016

· After installing Microsoft Outlook, you have created an e-mail account for
sending and receiving e-mails.

· Microsoft Outlook is set as your default mail client.
· Your version of Microsoft Outlook is of the same system type as that of the

SAP Business One client. For example, both are the 32-bit versions.
After installing the Microsoft Outlook integration add-on, the SAP Business One
entry appears in the Add-Ins menu of the following Microsoft Office applications:
· Microsoft Outlook

https://service.sap.com/sap/support/notes/2064562
http://www.microsoft.com/
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Add-On Prerequisites

· Microsoft Word
· Microsoft Excel

For more information about how to use the feature, see the Microsoft Outlook
integration online help. The help is available in the Add-Ins menu of the above
Microsoft Office applications and from within the relevant windows in the SAP
Business One client application (by pressing F1  in the windows).

Payment Engine Inbound functionality is activated only when the Install Bank Statement Processing
checkbox is deselected.

7.7 Performing Post-Installation Activities for the
Integration Framework

After installation is complete, you can begin using the integration framework. No mandatory post-installation
activities are necessary.
However, for certain use cases, you need additional settings in the integration framework. The following sections
provide information about additional configuration options and settings you can check to ensure a correct setup.

 NOTE
The integration framework is implemented as a Microsoft Windows service with the SAP Business One
Integration Service identifier. The service starts automatically after successful installation.
If you cannot start the integration framework, stop and restart the service.
You can locate the service by choosing Start → Control Panel → Administrative Tools → Services.

7.7.1 Maintaining Technical Settings in the Integration
Framework

Procedure

In Microsoft Windows, choose Start ® All Programs ® Integration solution for SAP Business One ®
Integration Framework.
The Administrative Logon user interface opens.
In the B1i User field, enter B1iadmin and in the Password field, enter the password that has been provided
during installation.
Note that entries in the B1i User field are case-sensitive.
To add or change integration framework technical settings, in the integration framework, choose
Maintenance.
o To define proxy settings for your network and provide connection information for your e-mail server,

choose Cfg Connectivity.
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o To get an overview about configuration information for message exchange between SAP Business One
and the integration framework and about integration packages setup, choose Tools ® Troubleshooting,
and in the Functional Group field, choose B1 Setup.

For more information about maintenance functions, in the integration framework choose Help ® Documents
® Operations Part 2, section System Administration.

7.7.2 Maintenance, Monitoring and Security

Monitoring

For technical monitoring purposes, choose Start ® All programs ® Integration solution for SAP Business One ®
Integration Framework, and in the integration framework, choose Monitoring.
You can use the message log, access the error inbox, display SAP Business One (B1) events and use other
monitoring functions.
By default, the message log is active after installation. We recommend deactivating the message log in a
productive environment.
For additional documentation, choose Start ® All programs ® Integration solution for SAP Business One ®
Integration Framework, and then choose Help ® Documents ® Operations Part 1 and Operations Part 2.

System Landscape Directory (SLD)

 Note
Do not confuse the SLD for the integration framework with the SLD for the SAP Business One landscape,
which you access from a Web browser. For more information, see Working with the System Landscape
Directory.

To maintain systems connecting to the integration framework, choose Start ® All programs ® Integration solution
for SAP Business One ® Integration Framework, and then choose SLD.
For all integration packages, SAP delivers the necessary system entries in SLD.
In SLD, make sure that you keep the entry in the b1Server field for the SAP Business One system in sync with the
entry in the associatedSrvIP field for the WsforMobile system.

Integration with SAP Business One integration for SAP NetWeaver

If your SAP Business One is connected as a subsidiary to the SAP Business One integration for SAP NetWeaver
server, it is necessary to add entries to the event subscriber manually.
To configure the SAP Business One event subscriber to send events to a remote integration framework server,
choose Start ® All programs ® Integration solution for SAP Business One ® Integration Framework, and then
choose Maintenance ® Cfg B1 Event Subscriber.
For more information, click the documentation (Book) icon in the function.
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Security Information

The integration framework security guide gives you information that explains how to implement a security policy
and provides recommendations for meeting security demands for the integration framework.
For more information, choose Start ® All programs ® Integration solution for SAP Business One ® Integration
Framework, and then choose Help ® Documents ® Operations Part 2, section Integration Framework Security
Guide.

7.7.3 Technical B1i User

SAP Business One creates a user with the B1i user code for each company. The default process requires that you
set the same password for each company. The integration framework uses the B1i user to connect to SAP
Business One (for example, to check authentication when using the mobile solution). Ensure that the password
that you provided during installation of the integration framework is the same you set in SAP Business One.

7.7.4 Licensing

Ensure that the SAP Business One B1i user has been assigned with the following two free licenses:
· B1iINDIRECT_MSS
· B1i

No additional licenses are required for the B1i user.
Mobile users must be licensed to access the SAP Business One system through the mobile channel. License
administration is integrated with the SAP Business One user and license.

7.7.5 Assigning More Random-Access Memory

We recommend checking the performance aspects in the related documentation.
Choose Start ® All programs ® Integration solution for SAP Business One ® Integration Framework, and then
choose Help ® Documents ® Operations Part 2, section 2.
If you expect your system to run under very high load and to process a high amount of messages, you can assign
more random-access memory (RAM) to the integration framework server to improve performance.

Procedure

On your local drive C:\Program Files\SAP\SAP Business One
Integration\IntegrationServer\tomcat\bin\ double-click tomcat6w.exe.
If the system denies access, select tomcat6w.exe, open the context menu and select the Run as Administrator
option.
Select the Java tab, and increase the maximum memory pool amount as follows:
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o In a 32-bit operating system, Tomcat supports a maximum memory pool of 1024 MB.
o In a 64-bit operating system, the default is 2048 MB for the maximum memory pool amount for Tomcat,

you can assign more RAM.

7.7.6 Changing Integration Framework Server Ports

By default, the integration framework server uses port 8080 for http and 8443 for https. If another application is
already using one of these ports, change the integration framework ports.

Procedure

If SAP Business One Event Sender Service is already running, stop the service.
In the …\Program Files (x86)\SAP\ Integration Solution for SAP Business
One\IntegrationServer\Tomcat\conf folder, double-click the server.xml Tomcat file and in the
connector port tag, change the settings as necessary. Do not change any other settings in the file.
Log on to the integration framework, choose Maintenance ® Cfg Runtime and change the port or ports.
The integration framework also updates the setting in the SLSPP table in SAP Business One.
Restart the SAP Business One Integration Service.
Choose Start ® All Programs ® Integration solution for SAP Business One ® EventSender ® Setup, follow the
steps of the wizard and in the Configure B1i Parameters section, change the B1i Server Port entry, and then
test the connection.
Restart the SAP Business One EventSender Service.
To change the properties for the menu entry, choose Start ® All programs ® Integration solution for SAP
Business One ® Integration Framework. Be sure to use the correct port number.

7.7.7 Changing Event Sender Settings

SAP Business One writes events for new data, changes and deletions to the SEVT table. Based on filter settings,
the event sender accesses the table, retrieves data and hands over the events to the integration framework for
further processing.
The installation program installs and sets up the event sender on the SAP Business One server. The following
section describes event sender settings, although usually no further changes are required.

 NOTE
Only call the event sender setup in the following cases:
o You must change the password for database access.
o You have changed the B1iadmin password for the runtime user.
o You have moved to another SAP HANA server.
o To reduce the message load, you want to include or exclude some objects.
o You want to exclude users.
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To check the settings for the event sender, use the integration framework troubleshooting function. In the
integration framework, choose Tools → Troubleshooting, and in the Functional Group field, choose Event Sender.

Procedure

To call the event sender setup, choose Start → All Programs → Integration Solution for SAP Business One →

EventSender → Setup.
In step 1, in the Choose a DB Type field, select the SAP Business One database type.
In the DB Connection Settings section, you can set the following:
o In the DB Server Name field, enter the computer name or IP address of the machine, where the database

of the SAP Business One server is installed. Do not use localhost.

 Recommendation
Use the hostname of the server. Only if you have problems specifying the hostname, use the IP address
instead.

 Caution
In the SAP Business One integration for SAP NetWeaver installation, this setting must be identical with
the value in the b1Server field. If the values are not identical, they appear in the Filtered section.

o In the Port field, enter the port number of the database server, where the SAP Business One server is
installed.

o In the Setup DB Account and Password fields, the installation has set the database user name and
password for database access during setup.
This user must have access rights to create tables and store procedures.

o In the Running DB Account and Password fields the installation has set the database user name and
password for database access at runtime.
This user must have access rights to the event log and event lock tables.

o If you want to use the Microsoft Windows authentication mechanism to connect to the database, select
the Trusted Connection option.
If you select this option, you do not have to specify the Setup DB Account, Running DB Account and
Password fields.

In step 2, the following settings are available in the Monitor Settings section.
o In the Idle Time (millisecond) field, you can change the time period the event sender waits until it polls

events from SAP Business One.
The default is 3000 milliseconds.

o In the Batch Count field, you can set the number of events the event sender polls each time.
The default is 10.

In step 3, you can change general settings for the integration framework.
By default, the installation program sets the Sending Method to Direct.
o If you select the Direct method, the event sender directly sends events to a dedicated server address.

This can either be an integration framework server or the SAP Business One integration for SAP
NetWeaver server.
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o If you select the Distributed method, the event sender sends all events to the local server address and
the event dispatcher takes over the task of distributing the events to other systems. Before selecting this
method, make sure that you have configured the event subscriber.
For more information, see the Operations Guide Part 2, section Configuring the B1 Event Subscriber

In the General B1i Settings, you can configure the following:
o In the Protocol Type field, select the protocol for the connection between the event sender and the

integration framework. To enable https, make settings in the Tomcat administration.
o In the Authentication field, always use the Basic option. This is the default.
o In the B1i Server field, enter the name or IP address of your integration framework or the SAP Business

One integration for SAP NetWeaver server.
o In the B1i Server Port field, enter the port number of your integration framework or the SAP Business One

integration for SAP NetWeaver server.
o If you work in a network with a proxy, in the Proxy Host field, enter the name or IP address of your network

proxy.
o If you work in a network with a proxy, in the Proxy Port field, enter the port number of your network proxy.
o In the User Name field, enter the user name for accessing the integration framework or SAP Business One

integration for SAP NetWeaver server. The default is B1iadmin.
o In the Password field, enter the password for accessing the integration framework or SAP Business One

integration for SAP NetWeaver server.
o To test the connection, choose the Test Connect… button.
In step 4, choose the company databases.
The setup program displays the company databases in your SAP Business One system. For each company
database, you can set up the following:

Deselect the checkbox in front of the SAP Business One company database, if the company does not use
the integration framework. If you deselect the checkbox, SAP Business One does not create events for
the company database in the SEVT table.
To define for which SAP Business One objects the event sender sends events, chose the Event Filter
button.
o In the Include List B1 Object(s) field, enter the object identifier of the SAP Business One object or

objects. Separate entries by comma.
If you enter, for example, 22,17, the event sender sends events for purchase orders and orders to
the integration framework or the SAP Business One integration for SAP NetWeaver server.
If you leave the field empty, the event sender sends events for all SAP Business One objects to the
integration framework or the SAP Business One integration for SAP NetWeaver server.

o In the Exclude List B1 Object(s) field, enter the object identifier of the SAP Business One object or
objects. Separate entries by comma.
If you enter for example 85 the event sender excludes events for special prices for groups.
If you leave the field empty, the event sender sends events for all SAP Business One objects to the
integration framework or the SAP Business One integration for SAP NetWeaver server.

 Note
Use either the Include B1 Object(s) or the Exclude List B1 Object(s) function. Do not use the functions
together.
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o In the Exclude List B1 User field, enter SAP Business One users for which the event sender does not
send events to the integration framework. Enter the SAP Business One user name, not the user code.
Separate entries by comma.

o If you want the company database to create events based on indirect journal entries, select the
Create Complete Journal Entry Events checkbox. Standard SAP Business One processing does not
create events for indirect journal entries.

To define the receiver of events, choose the Default Inbound button. You have the following options:
o Default Inbound

This is the default. The event sender hands over events to B1iP. The event dispatcher hands over the
events to the event subscriber that distributes the events to the target application or applications.

o SAP Business One integration for SAP NetWeaver 2005
This option is available for SAP Business One integration for SAP NetWeaver 2005 to be backwards
compatible.
If you select this option, choose the Receiver button and enter the B1i application URI. To test the
connection, choose the Test connection button.

o OTR (Other)
If you select this option, choose the Receiver button and enter the B1i application URI. To test the
connection, choose the Test connection button.

To test the connection to the receiver of SAP Business One events, choose the Receiver and then on the
Test Connection button.

Step 5 gives you a summary of the event sender settings.
To save the settings, choose the Finish button.
Restart the SAP Business One EventSender service.

Result

The setup program stores the settings in the datasource.properties and
eventsenderconfig.properties configuration files.

7.7.8 Changing SAP Business One DI Proxy Settings

SAP Business One DI Proxy is the SAP Business One-related component that enables data exchange with SAP
Business One using the DI API. No additional steps are required to set up the SAP Business One DI Proxy service.
To influence the behavior of the SAP Business One DI Proxy service, parameters are available in the
diproxyserver.properties file.

Procedure

To change parameters, access the diproxyserver.properties file in the …SAP\SAP Business One
Integration\ DIProxy path.
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Property Description

RMI_PORT The parameter is obsolete.

HTTPS_PORT DI Proxy TCP port for HTTPS.

MAXDIERRORS If this property exists and has a value greater than 0, the value defines
the number of DI errors that may occur before the DI Proxy restarts. The
default is 50.

RESTARTPERIOD If this property exists and has a value greater than 0, the value
determines the time in minutes after which the DI Proxy restarts. The
default is 60.

ORPHANED This property defines the value in minutes after which the system
defines a pending and not yet completed DI transaction as orphaned.
The DI Proxy removes the transaction from the internal transaction list.
If this property does not exist or does not have a positive value, the
default is 10. If it exists, the default is 30.

JCOPATH If this property exists and is not empty, it defines the path the DI Proxy
uses to search for the Jco installation. In this case the system ignores
any value coming from B1iP requested by an adapter.
If the property does not exist, the system uses any value coming from
B1iP requested by an adapter. In this case the setting is probably not
definite.
SAP recommends setting the Jco path in the
diproxyserver.properties file.
If you want to change a Jco path that someone has already maintained
and that the system has used for connection, you can apply this change
only after you have restarted the SAP Business One DI Proxy Service.
Use / or \\ instead of \ as a separator in the JCOPATH value. Use for
example C:\\Program Files\\SAP\\SAP Business One DI
API\\JCO\\LIB

JCOVERSION If this property exists and is not empty, it defines the version the DI
Proxy uses to search for the Jco installation.

restartAttemptDelay As of DI Proxy version 30002211, you can overlay the default for a
restart delay (500 milliseconds).
Provide a value in milliseconds.
The parameter is not part of the default diproxyserver.properties
file. If you want to use it, add it manually.

restartAttemptCap As of DI Proxy version 30002211, you can overlay the default number of
restart attempts (10).
The parameter is not part of the default diproxyserver.properties
file. If you want to use it, add it manually.

If you change any settings, restart the SAP Business One DI Proxy Service.
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7.7.9 Using Proxy Groups

The DI adapter allows defining multiple proxy groups in the global adapter configuration properties. This allows
load balancing by processing requests to multiple proxies. Requests can come from IPO steps that are
independent of each other. If you process a step using a certain proxy, the step uses the proxy during the
complete step processing.
You can find the following information in the proxy log file:
· The proxy logs the processing start and stop time and describes how the proxy was stopped.
· Find a usage statistics summary, which lets you decide whether the proxy suits the processing requirements

or whether it should be enhanced to a proxy group to fulfill the overall requests.

7.7.9.1 Providing Further Proxies

To use proxy groups, provide several DI proxies.

Procedure

To enable a configuration set for a second DIProxy instance, copy the DIProxy folder and paste it.
The system creates the DIProxy - Copy folder.
Rename the folder to DIProxy2.
In the ...\DIProxy2 folder, open the service.ini file and change the following entries:
o ServiceName = SAPB1iDIProxy2

o DisplayName = SAP Business One DI Proxy 2 Service

In the ...\DIProxy2 folder, open the diproxyserver.properties file.
Change the HTTPS_PORT parameter to 2098, if port 2098 is available on your machine.
HTTPS_PORT=2098

Choose Start, right-click Command Prompt and choose the Run as administrator option.
Run service.exe with the -install parameter in the ...\DIProxy2 folder.
Start the SAP Business One DI Proxy 2 Service Monitor service.
Repeat the steps above for the number of DIProxies you want to use.

7.7.9.2 Adding Proxy Groups to the DI Adapter Global
Configuration

In the integration framework, you have the option of defining proxy groups with proxies. Define the proxy groups
and proxies in the DI adapter global configuration.
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Procedure

In the integration framework, choose Tools ® Control Center ® Configuration ® Global Adapter Config.
In the Global Adapter Configuration Properties user interface, for the B1DI adapter, click the Edit Global
Configuration Properties link.
For the diProxyGroupList property, define the proxy groups in the following way:
o [<groupname1> <hostname1>:<port1>,<port2>][<groupname2>

<hostname2>:<port1>,<port2>]

o <groupname1,2> are the proxy group names
o <hostname1,2> are the host names or IP addresses of the proxies
o port1,2 are the port numbers

Example

You want to provide the following proxy groups:
· alpha and beta

· Each group has two proxies
[alpha abc:2099 def:3701][beta 1.2.3.4:2099,3000]

7.7.9.3 Using Proxy Groups in SLD

In SLD, enter the proxy group definition that you want to use for a certain company database in the diProxyhost
field of the SAP Business One company database entry in the following way, for example: [alpha]
If you use a proxy group, leave the diProxyport field empty.

7.8 Validating the System

While validation is a natural part of the installation and upgrade process, you can always validate by yourself if the
components are working properly after the installation or upgrade.

Procedure

The following procedure describes how to perform validation in GUI mode.

 Note
You can also validate your system in silent mode. To do so, enter the following command line:
./setup -va silent

For more information about supported arguments and parameters, see Silent Installation.
Log on to the Linux server as root.
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In a command line terminal, navigate to the installation folder of SAP Business One where the setup script is
located. By default the installation folder is /usr/sap/SAPBusinessOne.
Enter the following command: ./setup
The server components setup wizard is launched.
In the welcome page, select Validation and choose Next.

The Select Features window lists all local SAP Business One components. Choose Next to continue.
The Review Settings window displays current settings. Choose Next to continue.
In the Validation Progress window, wait for the validation process to finish and then choose Next to continue.
In the Validation Completed window, review the validation results, take note of the components that did not
pass the validation, and then choose Next to continue.
In the Validation Completed window, choose Finish to exit the wizard.

7.9 Reconfiguring the System

If you need to reconfigure the system, perform a reconfiguration using the server components setup wizard. For
example, if the SAP HANA address or the database user password has changed, the SLD stops working and you
must reconfigure the system.
The reconfiguration mode allows you to update some external information with SAP Business One as well as
change some settings, as summarized in the table below:

Operation Setting Remarks

Update Network address of the SAP
Business One components

If you have assigned different IP addresses to components
installed on the same machine, you can apply only one IP
address.



140
CUSTOMER
© 2016 SAP SE or an SAP affiliate company. All rights reserved.

SAP Business One Administrator’s Guide, version for SAP HANA
Performing Post-Installation Activities

Operation Setting Remarks

Network address of the SAP HANA
server

If the IP address or hostname of the SAP HANA server has
changed, you must "tell" SAP Business One of this change.
For more information about changing the hostname of the
SAP HANA server, see SAP Note 1780950.

Database user password If you want to keep using the original database user for life
cycle management but the password for the database
user has changed, you must "tell" SAP Business One of
this change.

SLD network address Applicable for SAP Business One components installed
separately from the SLD.
If the network address of the remote SLD has changed,
you must first reconfigure the SAP Business One system
on the SLD server and then on all machines with other
SAP Business One components.

Change Database user If you want to use a different database user for life cycle
management, you must reconfigure the system. This
database user must have the required database privileges.
For more information, see Database Privileges for
Installing, Upgrading and Using SAP Business One.
Note that changing the admin user for server connection
in the SLD does not change the database user for life cycle
management.

Backup settings Includes the backup folder, the backup folder size limit,
and the schema compression setting.
You can also register more SAP HANA servers with the
backup service, or edit or delete existing SAP HANA
servers.

Service Layer settings You can change the Service Layer settings, such as adding
or removing load balancer members, changing the port
number, or changing the maximum threads per load
balancer member.

Procedure

The following procedure describes how to perform validation in GUI mode on the SLD server. The scenario where
the SLD is installed remotely is omitted.

 Note
You can also reconfigure your system in silent mode. To do so, enter the following command line:
./setup -r silent -f <Property File Path>

For more information about supported arguments and parameters, see Silent Installation.
Log on to the Linux server as root.

https://service.sap.com/sap/support/notes/1780950
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In a command line terminal, navigate to the installation folder of SAP Business One where the setup script is
located. By default the installation folder is /usr/sap/SAPBusinessOne.
Enter the following command: ./setup
The server components setup wizard is launched.
In the welcome page, select Reconfiguration and choose Next.

In the Network Address window, you can select a new IP address or enter the new hostname for SAP Business
One components. Choose Next to continue.
In the Database Server Specification window, you can enter the new network address for the SAP HANA
server, specify another database user, or enter the new password for the original database user. Choose Next
to continue.
Note that the database user must have appropriate database privileges. For more information, see Database
Privileges for Installing, Upgrading and Using SAP Business One.
The Installed Components for Reconfiguration window lists all local SAP Business One components. Choose
Next to continue.
In the Service Port window, you can specify a new port for SAP Business One services. Choose Next to
continue.
In the Site User Password window, enter the password for the site super user B1SiteUser, and choose Next
to continue.
Note that you can change the site user password only in the SLD. For more information, see Managing Site
Users.
If the app framework is one of the local components, the Restart Database Server window appears. Choose
whether to allow automatic restart or perform manual restart after the reconfiguration, and then choose Next
to continue.
In the Backup Service Settings window, you can change the backup settings. Choose Next to continue.
Note that you can change the backup folder directly in the SLD; for the other settings (for example, company
schema compression), you must perform a reconfiguration.
In the SAP HANA Databases for Backup window, you can add, edit, or delete an SAP HANA server for backup.
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In the Service Layer window, you can change the Service Layer settings. Choose Next to continue.
In the Review Reconfigured Settings window, review the changed and unchanged settings and then choose
Next to start the reconfiguration process.

In the Reconfiguration Progress window, wait for the reconfiguration to finish and then choose Next to
continue.
In the Reconfiguration Status window, review the reconfiguration results, take note of the components that
have failed the reconfiguration, and then choose Next to continue.
In the Reconfiguration Completed window, choose Finish to exit the wizard.

7.9.1 Changing Security Certificate for the System
Landscape Directory

The System Landscape Directory enforces secure connection using HTPPS encryption. After installation, you may
change the certificate used for authentication or update the certificate when its validity expires. To do so, perform
the following:

Log on to your Linux server as root and navigate to the folder <Installation
Path>/SAPBusinessOne/ServerTools/SLD/tools/.

 Caution
In the tools folder, you may notice a file called update_db_credential.sh. Be aware that you cannot
run this shell script to reset the database user password.

In a command-line terminal, execute the shell script update_https_certificate.sh.
In the terminal, enter the following information step by step:

Path to the tomcat server for the SLD (<Installation Path>/SAPBusinessOne/Common/tomcat/)
Path to the new certificate, for example, <Certficate Path>/server.p12.
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Password for the new certificate
Restart the server tools using the command: /etc/init.d/sapb1servertools restart



144
CUSTOMER
© 2016 SAP SE or an SAP affiliate company. All rights reserved.

SAP Business One Administrator’s Guide, version for SAP HANA
Migrating from Microsoft SQL Server to SAP HANA

8 Migrating from Microsoft SQL Server to
SAP HANA

The following SAP Business One releases are supported for migration to SAP Business One 9.2, version for SAP
HANA:
· SAP Business One 9.0
· SAP Business One 9.1

For more information about migrating from specific patches of supported releases, see the Overview Note for the
respective SAP Business One patch, version for SAP HANA.

8.1 Migration Process

To migrate SAP Business One hosted on the Microsoft SQL Server to SAP HANA and upgrade to SAP Business
One 9.2, version for SAP HANA, do the following:

To determine the migration path, read the Overview Note for the required version for SAP HANA.
For example, check which versions for Microsoft SQL Server are supported for migration to the required
version for SAP HANA. If direct migration is not supported, you first need to upgrade your system to a
supported version for Microsoft SQL Server and then perform the migration operation.
[If required] If your SAP Business One version is lower than 9.0 PL04, upgrade your company databases to a
version that can be migrated to SAP Business One 9.2, version for SAP HANA. For example, first upgrade to
9.0 PL17 or 9.1 PL05.
For more information, see the SAP Business One Administrator's Guide (SQL) in the documentation area of
SAP Business One Customer Portal at http://service.sap.com/smb/sbocustomer/documentation.
On your Linux server, do the following:

Install SAP Business One server components, version for SAP HANA. For more information, see Installing
Server Components.
If required, upgrade the server components to the required version. For more information, see Upgrading
Server Components.

On a Windows machine, run the migration wizard to migrate your company schemas from the Microsoft SQL
Server to the SAP HANA database. For more information, see Running the Migration Wizard.
A single migration wizard handles the entire company schema migration process. The migration process
includes both company database migration to SAP HANA and company schema upgrade on SAP HANA. If
you do not upgrade the company schemas immediately after migrating from the Microsoft SQL Server, the
migration process is considered incomplete; you can then use the SAP HANA version of setup wizard to
upgrade the migrated company schemas and complete the migration process.
Uninstall all old server and client components from the Windows control panel.

http://service.sap.com/smb/sbocustomer/documentation
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 Recommendation
After the uninstallation, delete all SAP Business One folders and files within the folders. By default, you
can find the folders under C:\Program Files (x86)\SAP\.

Convert and migrate your customized contents.
Install the Windows-based server components and SAP Business client using the product package, and then
if required, upgrade the components to the preferred version using the upgrade package.
Note that the corresponding 32-bit or 64-bit SAP HANA database client (for Windows) is required for each
machine.

8.2 Running the Migration Wizard

The migration wizard helps you to migrate your company databases from Microsoft SQL Server to SAP HANA.
The process of migrating company databases consists of the following steps:

Perform pre-migration tests.
Migrate selected company databases to SAP HANA.
Perform post-migration tests.
If the migrated databases fail the tests, you cannot proceed with step 4. While the original company
databases on Microsoft SQL Server remain intact, the schemas on SAP HANA cannot be used.
Upgrade the successfully migrated company databases (schemas on SAP HANA).
You can upgrade the schemas separately using the SAP HANA version of setup wizard. However, note that
the migration would be considered incomplete without the upgrade and you will not be able to use the
migrated schemas until you have upgraded them to the required version.
If upgrade fails on the SBOCOMMON schema, the upgrade is rolled back for all schemas; if upgrade fails on a
company schema, the upgrade is rolled back for that company schema.

Prerequisites

· You have downloaded the upgrade package of the required version of SAP Business One, version for SAP
HANA.

· You have installed the SAP Business One server components, version for SAP HANA and upgraded the server
components to the required patch level. For more information, see Installing Server Components and
Upgrading Server Components.

· The version of your company databases is not lower than 9.0 PL04. Otherwise, you must first upgrade the
databases to a patch level (SQL version) that can be migrated to the required version for SAP HANA.

· You have ensured that all SAP Business One clients are closed.
· You have removed all add-ons (system and third-party). This prevents future problems when using add-ons.

You can register the add-ons after you complete the migration. For more information about removing and
registering add-ons, see the SAP Business One online help.

· On the Windows machine on which you want to run the migration wizard, you have done the following:
o Installed Java 8 (32-bit or 64-bit) and appended the directory $JAVA_HOME/bin to the system variable

PATH.
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o Installed the 32-bit SAP HANA database client for Windows.
o Installed the Microsoft SQL Server native client with the same version as your Microsoft SQL Server.
o Added the System Landscape Directory server to the list of proxy exceptions.
o Downloaded the upgrade package for the required patch level of SAP Business One 9.2, version for SAP

HANA. For the download instructions, refer to the corresponding SAP Overview Note.
· The memory of the machine on which you want to run the migration tool is no less than 4 GB.
· For the prerequisites specific to the upgrade stage, see Upgrading Schemas and Other Components.

Procedure

In the upgrade package root folder, right-click the Migrate.exe file and choose Run as administrator.
The migration wizard is launched.
In the welcome window of the wizard, select a language and choose Next.

In the Setup Type window, the following options are available:
o Test Only: Checks whether the databases are ready for migration. For each company database that

passes the test, you can generate a passcode which you can later use to bypass all or part of the pre-
migration tests when migrating the database. The passcode is in the form of an XML file that contains
details on the tested company database. It is valid for three days; any changes to the company
configuration render the passcode invalid.

o Migrate to SAP HANA: Performs pre-migration tests, migrates the selected databases to SAP HANA, and
upgrades the successfully migrated schemas on SAP HANA. If you performed a pre-migration test for a
company database earlier, you can bypass the pre-migration test for this company database by entering
the passcode.

Select Migrate to SAP HANA and choose Next.
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In the Source MSSQL Server window, specify the following information and choose Next:
o Database Server Type: Select the database server type and version.
o Server Name: For a default instance, enter the hostname or IP address of the server; for a named

instance, specify <Hostname>\<Instance Name>.
o User Name: Enter the name of a database user.
o Password: Enter the password for the database user.

In the Target SAP HANA Server window, specify the following information and choose Next:
o License Server Name: Enter the hostname or IP address of your System Landscape Directory server (SAP

HANA version).
o Port: Enter the port for the System Landscape Directory service.
o Password: Enter the password for the site user B1SiteUser.
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Note that if you chose to perform only the pre-migration test, this window is skipped and you are directly
asked to select databases for migration.

In the next Target SAP HANA Server window, select the SAP HANA server to which you want to migrate your
company databases and choose Next.

If you do not find the required database server in the server list, you can register it in the System Landscape
Directory (SAP HANA version). To do so, choose the Register New Database Server button, specify the
relevant information, and then choose Back to continue with the migration.
In the Migration Performance Settings window, to prevent the migration operation from taking up too many
system resources, you can change the following settings:
o JAVA VM Memory Allocation (MB): Set an upper limit on the memory to be used by the JAVA virtual

machine. The value is evaluated dynamically according to the system.
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o Read/Write Batch Size (No. of Records): Define the number of records to be included in a single
read/write batch operation. The default value is 10000.

o Max. blob size (MB): Set an upper limit on the size of BLOBs (binary large objects). BLOBs that are larger
than the defined value will not be migrated to SAP HANA.
The default value is 512 MB.

o Multi-connection mode: Select this option to execute the migration process in multiple threads. The
migrated databases are then set to multi-user mode rather than single-user mode.
Note that the multi-user mode cannot prevent data changes made by other user sessions during the
migration process. Therefore, while selecting this option will speed up the migration process, you must
take extra caution and warn other users against making any data changes during the process.

 Caution
Do not change the default values for the read/write batch size and the maximum BLOB size unless you
encounter problems with migration. Otherwise, the migration performance may be negatively impacted.
If a database contains some very large BLOBs, you are advised to increase the Max. blob size value and
decrease the Read/Write Batch Size value.

In the Database Selection window, do the following:
If any of the databases you want to migrate are not ready for migration, do the following:
o If the checkbox is disabled for selection, a serious error is detected (for example, the database

version is not supported for migration) and you must resolve the issue before you migrate the
database. To view details of the issue, choose the Not Ready link.

o If the checkbox is enabled for selection but the database status is Not Ready, an easy-to-fix error is
detected (for example, there are other applications connecting to the database). To set the database
status to Ready, choose the Not Ready link to see the cause of the error, resolve the issue, and then
choose Refresh.

The Next button is enabled only if at least one database is selected and all selected databases are ready
for migration.
Select the databases that are ready for migration.
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If you want to make advanced settings for a database, select the checkbox for the relevant database and
then select the Advanced Settings checkbox. Additional information (for example, database size) is
displayed along with the advanced settings.

 Note
For each database to be migrated, a schema is created in the SAP HANA database. The schema is named
after the database but always in upper case. If you rename the schema in the advanced settings, each
small letter is automatically converted to upper case.
Choose Next.

In the Migration - Backup Settings window, specify a backup location and choose Next.
All selected databases will be backed up before being checked for migration. If the selected location does not
have sufficient space, you must free some space in the location and then choose Refresh.
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In the Review Settings window, review the settings. If you want to change the settings, choose Back to return
to the relevant window; otherwise, choose Next to start the pre-migration test.

In the Pre-Migration Test window, do the following:
o To bypass the tests for certain company databases, choose the Enter Passcodes button and upload one

or several passcode files that you saved earlier. After uploading the files, choose Next.

 Note
A passcode file is only valid for three days. Any changes to the company configuration render the
passcode file invalid.

o To start the pre-migration test for the company databases, choose Start.
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If the wizard identified any errors or warnings on a database, the Pre-Migration Test: Errors Detected or Pre-
Migration Test: Warnings Detected window is displayed. Do either of the following:
o If only warnings were detected, do the following:

Review all the warnings and instructions in the relevant SAP Notes.
After carefully reading the instructions, you can decide to confirm the warnings, if appropriate.
Choose Back to return to the pre-migration test results screen.
With all warnings confirmed and no errors detected, choose Migrate to start migrating databases that
have passed the pre-migration test.

o If some errors were detected in a database, you must fix the errors before being able to migrate the
relevant database. If you want to continue to migrate the other databases, go back to the Database
Selection window and deselect the databases that failed the pre-migration test.

In the migration result window, review the migration details of each database and choose Next.
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In the finish window, do either of the following:
o To upgrade the successfully migrated databases later and exit the wizard, choose Finish.

 Caution
Without an upgrade, the migration is considered incomplete. You must run the SAP HANA version of
setup wizard to upgrade the databases (schemas on SAP HANA) later. For more information, see
Upgrading Schemas and Other Components.

o To upgrade the successfully migrated databases (schemas on SAP HANA) immediately, choose the
Upgrade button. For detailed instructions on the upgrade stage, see Upgrading Schemas and Other
Components, starting from step 9.
For databases which failed the migration or the post-migration checks, review the log information and
resolve the errors in the databases before attempting migration again.

Results

· Despite the migration result, a corresponding schema is created in the SAP HANA database for each
database selected for migration. We recommend that you drop (delete) the schemas of the databases which
failed the migration so as to prevent potential confusion.

· All database tables are migrated, including user-defined tables (UDTs) and user-defined fields (UDFs).
· You can find the log files and summary reports in the following folders:

o Migration stage:
o %UserProfile%\AppData\Local\SAP\SAP Business One\Log\MigrationWizard

o %UserProfile%\sap_b1_migration

o Upgrade stage: %UserProfile%\AppData\Local\SAP\SAP Business One\Log\UpgradeWizard
· You can now proceed to convert and migrate customized contents (reports, dashboards, stored procedures,

add-ons, user-defined queries, and so on), excluding UDTs and UDFs.
Due to the different SQL syntaxes in the Microsoft SQL Server and in the SAP HANA database, we provide a
half-automated converter tool to help you with the conversion. To download the tool along with the how-to
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guide, search for How to Convert SQL from the Microsoft SQL Server Database to the SAP HANA Database on
sappartneredge.com.

http://sappartneredge.com/
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9 Managing Security in SAP Business One,
version for SAP HANA

Your security requirements are not limited to SAP Business One, version for SAP HANA, but apply to your entire
system landscape. Therefore, we recommend establishing a security policy that addresses the security issues of
the entire company. This section offers several recommendations to help you meet the security demands of SAP
Business One, version for SAP HANA.
Your security solution should cover the following aspects:
· Technical Landscape: Provides an overview of the technical components and communication paths used in

SAP Business One, version for SAP HANA.
· User Management and Authentication: Provides system access to legitimate users only and prevents identity

impersonation.
· Database Authentication: Introduces how to restrict database access and a strong password definition

mechanism
· Network Security: supports your communication needs without allowing unauthorized access to your

network.
· Application Security: Restricts access to users with the necessary permissions.
· Data Storage Security: Provides recommendations for secure data storage in SAP Business One, version for

SAP HANA.
Once you have established your security policy, we recommend that you dedicate sufficient time and allocate
ample resources to implement it and maintain the level of security that you require.

 Note
For more security information of SAP HANA, see the SAP HANA documentation on SAP Help Portal at
http://help.sap.com/hana_platform.

9.1 Technical Landscape

In SAP Business One 9.2, version for SAP HANA, database credentials are saved in SLD, which serves as the
security server.
Database credentials are obtained by supplying SAP Business One, version for SAP HANA logon credentials for
authentication against the SLD service. Upon successful authentication, connections to databases are established
using database credentials from the SLD service.
The figure below is a representation of the security workflow for SAP Business One, version for SAP HANA.

http://help.sap.com/hana_platform
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SAP Business One, version for SAP HANA Security Landscape

9.2 User Management and Authentication

This section provides an overview of how SAP Business One, version for SAP HANA supports an integrated
approach to user administration and authentication.

9.2.1 User Management

This section provides an overview of user types and user administration within SAP Business One, version for SAP
HANA.

9.2.1.1 User Types

It is necessary to specify different security policies for different types of users. For example, your policy may
specify that individual users who perform tasks interactively have to change their passwords on a regular basis,
but not users who process job runs. Therefore, SAP classifies these types of users in the application as follows:
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Site Users

The site user is not a company user type that can log on to the SAP Business One client application, version for
SAP HANA, but serves as site-level authentication for performing the following activities:
· Creating new companies
· Installing or upgrading SAP Business One, version for SAP HANA
· Importing or exporting the license configuration file
· Configuring security settings in the SLD service
· Registering database servers in the SLD service

For more information, see Managing Site Users.

SAP Business One Company Superusers

When you create a company, a predefined superuser named manager exists in the system. Due to the password
policy, you must change the password of the manager user at the first logon.
You can also create new superusers. The responsibilities of a superuser include:
· Defining users in companies and setting user permissions
· Assigning licenses
· Configuring password policy at the company level
· Upgrading companies

SAP Business One Company Regular Users

You can define company regular users according to different business role requirements.
The responsibilities of a regular user are to perform the relevant business work in the SAP Business One
application, version for SAP HANA.

SAP Business One Company Support User

A Support user (user code: Support) is created upon the installation or upgrade of SAP Business One
companies. This new user is provided for support and consulting purposes.
The Support user does not require a license to access the system. This can minimize the disruption to business
where a user may previously have needed to log off the system to free up a license for support.

 Note
Certain advanced features (such as the analytics features) are not available for the Support user.

While you do not need to assign a license to the Support user, it has the same access rights as those of a
Professional User license. Therefore, strict usage rules are applied to the Support user to prevent misuse, as
follows:
· After logging on to the company using the Support user account, the user must identify him/herself by

entering his/her real name and selecting a login reason in the Support User Login window.
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· The Support user account can only be used if the remote support platform (RSP) is active (an RSP system
status report was uploaded within the last 7 days).

· The usage of the Support user is recorded (including the real name and the login reason). You can review the
log records in the Support User Log window under Administration -> License.

Notes for Upgraded Companies

If you had already created a user account Support before the upgrade, the Support user will have the features
described above after the upgrade. The licenses assigned to the original user account, the password and all other
settings for the original user account remain unchanged. You can transfer any license assignments of this account
to another user because they are no longer required by the Support user.

9.2.1.2 Single Sign-On

SAP Business One, version for SAP HANA supports single sign-on (SSO) functionality. You can bind an SAP
Business One user account to a Microsoft Windows domain account. After starting the SAP Business One client,
version for SAP HANA, users can start using the application without being prompted to enter their SAP Business
One logon credentials.

 Caution
To be able to use the single sign-on function, you must have specified a domain user and password during
installation of the System Landscape Directory on the SAP HANA server. Otherwise, even if you have
performed all the following steps to set up single sign-on, you still cannot single sign-on to SAP Business
One using domain user accounts.

To use the single sign-on function, you must complete the following steps:
Register a Service Principal Name (SPN).
Bind SAP Business One users to Microsoft Windows accounts.
Enable the single sign-on function in the SLD.
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9.2.1.2.1 Registering the Service Principal Name

To enable Windows domain single sign-on with SAP Business One, you must register a service principal name
(SPN) for the SLD service. The SPN can be registered before or after you install the System Landscape Directory.
Nevertheless, if you register the SPN after the installation, the domain user account used for installation must be
used for SPN registration.

 Recommendation
As this domain user is a service user that functions purely for the purpose of setting up single sign-on, we
highly recommend that you create a new domain user and do not assign any additional privileges to the
user other than the logon privilege. In addition, keep the user’s password unchanged after enabling single
sign-on; otherwise, single sign-on may stop working.

Prerequisite

You are a domain administrator or have been delegated the appropriate authority.

Procedure

On a Windows computer, run the command prompt as an administrator.
Run the following setspn command: setspn -U -A <SPN> <Domain User Name>.
An example of an SPN is SLD/Domain.com.

9.2.1.2.2 Binding SAP Business One Users to Microsoft
Windows Accounts

After binding SAP Business One users to Microsoft Windows domain accounts, the users can log on to SAP
Business One, version for SAP HANA without specifying the user credentials.

Manual Binding

The following procedure describes how to bind SAP Business One users one by one:
In the SAP Business One Main Menu, choose Administration → Setup → General → Users.
In the Users - Setup window, in the User Code field, specify the user that you want to bind.
In the Bind with Microsoft Windows Account field, enter the domain and user name of the Microsoft Windows
domain account to which you want to bind the user.

 Caution
The domain user name is case-sensitive. Therefore, you must ensure that you enter the domain user
name exactly as it was created in the domain, including the letter case.
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Choose the Update button.

Copy User Mappings Between Companies

You can copy user mappings between two companies provided that the same user exists in both companies. Each
user is identified by the user code (not the user name).
Typical scenarios for this function are as follows:
· You have moved your company schema from a test system to a productive system.
· You have moved your company schema to another server.
· You have imported and renamed your company schema (the old schema also exists on the same server).

To copy user mappings, do the following:
Log on to the System Landscape Directory in a Web browser.
On the Security Settings tab, in the Authentication section, choose the Copy User Mappings button.
In the Copy User Mappings Between Companies window, specify the source and target companies.

 Note
To be available for selection, the servers must be registered in the System Landscape Directory.
However, the company schema versions do not matter.

To display SAP Business One users whose mappings can be copied, choose the Check button.
If a user exists only in the source company but is bound to a domain account, the user is displayed as missing
in the target company. However, if a user exists only in the target company, the user is not displayed.
To copy user mappings to the target company, choose the Copy button.

9.2.1.2.3 Enabling Single Sign-On

After enabling SSO, the Choose Company window displays only the companies to which your Windows account is
bound.

 Caution
Enabling SSO in the SLD activates this functionality for all companies in the landscape.

Procedure

In a Web browser, navigate to the following URL: https://<Server Address>:<Port>/ControlCenter.
A Web browser opens and displays the logon page for the SLD service.
In the logon page of the Web browser, enter the site user name and password, and then choose the Log On
button.

 Note
The site user name is case sensitive.
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On the Security Settings tab, select the Enable Single Sign On (Log On Using Windows Domain Account)
checkbox.
If you did not choose to activate the single sign-on function during installation of the System Landscape
Directory, this checkbox is deselected and non-editable.
If you want to prevent logons using SAP Business One user accounts and enforce single sign-on using domain
accounts, select the Disable logons with SAP Business One User Accounts checkbox.
If you keep this checkbox deselected, users can log on using both SAP Business One user accounts and
Windows domain accounts.
Choose the Update button.

Result

Each user must confirm the binding upon first logon. After confirmation, the user can log on to SAP Business One,
version for SAP HANA using the bound Windows account.

 Caution
The first time you single sign-on to SAP Business One using your domain user account, ensure you have
logged on to the Windows system using the correct domain user name (case-sensitive). If not, log off and
then log on again using the correct user name; otherwise, single sign-on will not work.

If the system administrator has not disabled logons using SAP Business One user accounts, you can still log on
with an SAP Business One user account (which does not have to be bound to a Windows account), as below:

In the logon window, deselect the Logon with Windows Account checkbox (or in the Choose Company window,
deselect the Log on with Current Domain User checkbox).
Manually enter the company schema name.
Enter your SAP Business One user name and password.
Choose the OK button.

 Caution
If the system administrator has disabled logons using SAP Business One user accounts, you must bind
each SAP Business One user to a Windows account and each user must confirm the binding; otherwise,
logon is not possible.

9.2.2 User Authentication

As standard practice, SAP Business One, version for SAP HANA authenticates users based on their user accounts
and passwords.
You can change your password at any time. In addition, the application checks the password validity of each logon
attempt according to the selected security level.

 Note
To change your password, choose Administration → Setup → General → Security → Change Password.
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If you are required to change your password, the application displays the Change Password window. You must
change the password to log on.
The new password must comply with the settings of the selected security level, containing at least:
· x characters
· x lowercase
· x uppercase
· x digits
· x non-alphanumeric

The application saves passwords in the database in encrypted form. The last n passwords are also encrypted.
When appraising a new password, the application first encrypts and then compares it with the saved ones.
The password policy defines global guidelines and rules for password settings, such as the following:
· Time interval between password changes
· Required and forbidden letters and characters
· Minimum required number of characters
· Number of logon attempts before the system locks the user account

The password policy improves the security of SAP Business One, version for SAP HANA and enables
administrators to apply the required security level for their organization.

 Note
Only a superuser can change the security level. You can use the Password Administration window to
change the security level. To open the window, choose Administration → Setup → General → Security →

Password Administration.
SAP Business One, version for SAP HANA supports the following approaches to raising the security level of user
authentication:
· Increase the complexity of the password.
· Increase the frequency of password changes.

For more information about working with passwords in SAP Business One, version for SAP HANA, see SAP Note
978292.

9.3 Database Authentication

The default database administrator user SYSTEM has full authorization. Therefore, you must assign a strong
password for the SYSTEM account. This ensures that a blank or weak SYSTEM user password is not exposed.
Alternatively, you can create another database user account with the same authorization as the SYSTEM user.

 Recommendation
For security reasons, we recommend that you change the SYSTEM logon password immediately after
installing the SAP HANA database server. Alternatively, a safer option is to create another database user
account as a substitute for the SYSTEM user.

https://service.sap.com/sap/support/notes/978292
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9.3.1 Password of a Database User

A strong password is the first step to securing your system. A password that can be easily guessed or
compromised using a simple dictionary attack makes your system vulnerable. A strong password has the
following characteristics:
· Contains alphabetic, numeric, and special characters
· Is at least seven characters in length
· Is NOT a common word or name
· Does NOT contain a name or user name
· Is significantly different from previous passwords

To change the password for a database user, in the SAP HANA studio, proceed as follows:
Make sure that all sessions using this database user are disconnected.
Log on to the SAP HANA studio as a database administrator.
In the SAP HANA Systems list, navigate to the corresponding database instance.
Choose Security → Users and double-click the database user for which you want to change the password.
The <instance name> - <Database User> tab appears on the right.
Enter and confirm the password.
In the upper right toolbar, click  (Deploy) to save the new password.

Note that, if you have changed the password for the database user for server connection, you must reconfigure
the SAP Business One system. For more information, see Reconfiguring the System.

9.3.2 Creating a Superuser Account

To create a superuser account for maintaining administrative tasks for SAP Business One, version for SAP HANA,
in the SAP HANA studio, proceed as follows:

Log on to the SAP HANA studio as a database administrator.
In the Systems list, navigate to the database instance for which you want to create a superuser account.
Choose Security → Users, right-click Users, and choose New User.
The <instance name> - New User tab appears on the right.
On the <instance name> - New User tab, do the following:
o In the User Name field, enter the name of the new user.
o Select the Password checkbox, and then specify and confirm the password for the new user.
o In the Session Client field, do not enter anything.
o On the System Privileges tab in the lower area, choose . In the Select System Privilege window, add all

necessary system privileges.
o If necessary, in the System Privilege pane on the left, select each privilege, and then select the Grantable

to other users and roles checkbox in the Details pane on the right.
In the upper right toolbar, click  (Deploy) to save the new user.
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 Note
When the new user first logs on to the SAP HANA studio, they must change the password.

9.3.3 Database Privileges for Installing, Upgrading, and Using
SAP Business One

To install, upgrade, and use SAP Business One, you must grant the following database privileges to the
corresponding SAP HANA database user:
· Roles:

o PUBLIC

o CONTENT_ADMIN

o AFLPM_CREATOR_ERASER_EXECUTE (grantable)
· System privileges:

o CREATE SCHEMA (grantable)
o USER ADMIN (grantable)
o ROLE ADMIN (grantable)
o CATALOG READ (grantable)
o IMPORT

o EXPORT

o INIFILE ADMIN

o LOG ADMIN

This is needed if this database user is used to run the migration wizard to migrate your company
databases from the Microsoft SQL Server to the SAP HANA server.

· SQL object privileges:
o SYSTEM schema: CREATE ANY, SELECT
o _SYS_REPO schema: SELECT, EXECUTE, DELETE (all grantable)

The SBOCOMMON schema is created during the installation of SAP Business One Server, and the COMMON schema is
created during the installation of the analytics platform. If you use different SAP HANA users for installing
different components, you must pay special attention to grant the following object privileges as appropriate:
· SBOCOMMON schema: SELECT, INSERT, DELETE, UPDATE, EXECUTE (all grantable)
· COMMON schema: SELECT, INSERT, DELETE, UPDATE, EXECUTE (all grantable)

Grant Roles and Privileges to Database Users

To grant roles or privileges to a database user, follow the steps below:
In the SAP HANA studio, connect to your system as a super user (for example, SYSTEM).
In the Administration Console, under the Security folder of your system, under Users, double-click the
database user.
The details of the database user are displayed on the right.
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In the right panel, add required roles or privileges.
To apply the changes, click the  (Deploy) button or press F8 .

9.3.3.1 Database Role PAL_ROLE for Pervasive Analytics

A database role PAL_ROLE is created during the upgrade/installation process of the app framework. All database
privileges necessary for using pervasive analytics are assigned to this role on the condition that you have installed
the AFLs properly (for more information, see Host Machine Prerequisites); AFLs being missing do not prevent the
setup program from creating PAL_ROLE, but you will have to manually assign database privileges after the
upgrade/installation (see the troubleshooting section below).
During the upgrade/installation process or when you change the database user for server connection in the
System Landscape Directory, PAL_ROLE is automatically assigned to the database user.

 Note
If you change the database user for server connection in the System Landscape Directory, PAL_ROLE is
not automatically unassigned from the previously used database user. Similarly, if you change the
security option for your company schema (for example, from using a specified database user for each
SAP Business One user to using the admin user for all), PAL_ROLE is not automatically unassigned from
the database users self-generated for the old option.
You need to release the PAL_ROLE assignments manually.

Troubleshooting Missing Database Privileges for PAL_ROLE

If required database privileges are not granted to PAL_ROLE (for example, because you install the AFLs after you
install or upgrade the app framework) or PAL_ROLE is not properly assigned to the relevant database user, you
will have difficulty using pervasive analytics. To solve this issue, follow the troubleshooting instructions below.

Step 1: Ensure PAL_ROLE has all necessary database privileges

In the SAP HANA studio, connect to your SAP HANA database instance as the database user that was used to
upgrade the app framework.
In the Security folder, under Roles, double-click the role PAL_ROLE.
The details about the role are displayed in the right panel.
Check if PAL_ROLE has the following database privileges:
o Granted roles:

o AFL__SYS_AFL_AFLPAL_EXECUTE

o AFL__SYS_AFL_AFLPAL_EXECUTE_WITH_GRANT_OPTION

o Object privileges:
o SYSTEM.afl_wrapper_generator: EXECUTE
o SYSTEM.afl_wrapper_eraser: EXECUTE

If any database privileges are missing, grant the privileges to PAL_ROLE.
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Step 2: Ensure PAL_ROLE is assigned to the database user being used for server connection

Log on to the System Landscape Directory, edit your server, and check the database user name.
This database user is being used for server connection.
In the SAP HANA studio, connect to your SAP HANA database instance as the database user that was used to
upgrade the app framework.
In the Security folder, under Users, double-click the name of the database user being used for server
connection.
The details about this database user are displayed in the right panel.
If the granted roles do not include PAL_ROLE, grant PAL_ROLE to the database user.

9.3.4 Stored Procedures

You must not rename or remove any of the stored procedures in the SAP HANA database; otherwise, errors could
occur when running SAP Business One, version for SAP HANA.

9.3.5 Restricting Database Access

SAP Business One, version for SAP HANA has a mechanism to protect the database from easy changes through
direct access.
The advantages of restricting access to the database are:
· End users are not exposed to database credentials and so cannot change the databases directly, which

protects the databases from being changed or attacked.
· Database credentials are stored in the System Landscape Directory (SLD) schema and end users can access

the database only after the application performs a successful site user authentication through the System
Landscape Directory.

In SAP Business One, version for SAP HANA, the System Landscape Directory (SLD) is the central repository for
credentials information, including the database user ID and password (one for all SAP Business One, version for
SAP HANA users).
The database credentials are stored safely in the SLD schema, with additional encryption. The workflow is as
follows:

Database consumers such as SAP Business One client applications, DI, and services have to provide the SAP
Business One, version for SAP HANA credentials (SAP Business One, version for SAP HANA user ID and
password) to authenticate against the SLD.
Following successful authentication, the SLD supplies its credentials and SAP Business One, version for SAP
HANA uses them to connect.

Changing Security Levels

You can apply different security levels of database access through the SLD for each company:
To access the SLD service, in a Web browser, navigate to the following URL:
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https://<Server Address>:<Port>/ControlCenter

In the logon page, enter the site user name and password, and then choose the Log On button.

 Note
The site user name is case sensitive.

On the Servers and Companies tab, select the appropriate server.
The companies that are registered on the server are displayed in the Companies area.
In the Companies area, select the company for which you want to define the security level and choose the Edit
button.
In the Edit Company window, select one of the following options and choose the OK button:
o Use Database Admin User: SAP Business One accesses the database using an SAP HANA administrator

account.
To grant read-only authorization to non-superusers for queries (system and user-defined) in SAP
Business One, you must manually create a read-only database user and assign it to the company. For
more information, see Queries.

o Use Specified Database User: The system automatically generates a pair of database users without
administrator privileges. SAP Business One accesses the database using one of the database users,
depending on the specific database transaction.

o Use Specified Database User for Each Business One User: Most secure and recommended. The system
automatically generates a pair of database users without administrator privileges for each SAP Business
One user. SAP Business One accesses the database using one of the database users, depending on the
logged on SAP Business One user and the specific database transaction.
Whenever a new SAP Business One user is added, a pair of corresponding database users is added.

For the second and third options, you do not have to manually create a read-only database user for queries.
For more information, see Queries.

 Caution
Do not change the names or system privileges of the automatically-created database users.

If you selected the second or third option, you can configure the SLD service to automatically change the
password of the automatically-created database users on a regular basis, as below:

On the Security Settings tab, select the Change Database User Password Every <Number> Days
checkbox.
Enter the number of days between password resets.
Choose the Update button.

9.4 Network Security

We strongly recommend installing SAP Business One in trusted environments only (corporate LAN with firewall
protection).
To work with SAP Business One outside your corporate networks, you can use the SAP Business One Browser
Access service. Alternatively, you can use Citrix or similar third-party solutions. For more information, see
Enabling External Browser Access.
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9.4.1 SSL Encryption

For more information about the SSL encryption, see SAP HANA Security Guide on SAP Help Portal at
http://help.sap.com/hana_platform.

9.4.2 Communication Channels

TCP/IP provides the communication channels between the following:
· SAP Business One server, version for SAP HANA ⇔SAP Business One license server, version for SAP HANA
· SAP Business One server, version for SAP HANA ⇔ SAP Business One clients, version for SAP HANA
· SAP Business One server, version for SAP HANA ⇔ Agent of SAP Business One remote support platform
· SAP Business One license server, version for SAP HANA ⇔ SAP Business One clients, version for SAP HANA
· System landscape directory ⇔ SAP Business One clients, version for SAP HANA

The communication port depends on the SAP HANA instance number in the format of 3<SAP HANA instance
number>15. If the instance number is 00, the communication port is 30015, and if the instance number is 01, the
communication port is 30115.
The default ports for the SAP Business One license server is 40000 for license communication and 40001 for the
license naming service.

9.5 Application Security

SAP Business One, version for SAP HANA provides features to ensure that unauthorized access to the application
does not occur.

9.5.1 Password Encryption

In SAP Business One, version for SAP HANA, a strong algorithm is used for data encryption and decryption. The
site user ID and password are encrypted and saved in the System Landscape Directory.

 Note
You should set a site user password that is at least as strong as that defined in company password policy,
and change it frequently.

You can change the site user password using the System Landscape Directory. To do so, proceed as follows:
To access the SLD service, in a Web browser, navigate to the following URL:
https://<Server Address>:<Port>/ControlCenter

In the logon page, enter the site user name (B1SiteUser) and password, and then choose the Log On button.

http://help.sap.com/hana_platform
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 Note
The site user name is case sensitive.

On the Security Settings tab, in the Site Password area, choose the Change button.
In the Change Site Password window, enter the current password, and then enter and confirm the new
password you want to use.
To save the new password, choose the OK button.

9.5.2 Queries

The query wizard and query generator enable you to define queries on the database. These tools are designated
for SELECT sentences only and cannot be used for any kind of update operation. To protect your data, we
recommend that you make sure users have the appropriate permissions. However, the data results returned are
not filtered according to the user’s authorization.

Granting Read-Only Authorization for Query Results

To enable an SAP Business One user to view the results of both system and user-defined queries, you can directly
grant the user full authorization to the Execute Non-select SQL Statement authorization item in the General
Authorizations window in the SAP Business One client application (Main Menu → System Initialization →

Authorizations → General Authorizations).

However, we recommend that you grant read-only authorization to all non-superusers in one of the following
ways:
· [Recommended] Do the following:

Configure SAP Business One to access your company using database users without administrator
privileges.
Grant No authorization to all non-superusers in the General Authorizations window.
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This way, users with No authorization to the Execute Non-select SQL Statement authorization item can
access the database only through a read-only database user.

· If you configure SAP Business One to access your company using a database administrator user, do the
following:

Apply No authorization to all users to the Execute Non-select SQL Statement item.
Create a read-only database user in SAP HANA and define the user password.
Assign the database user to the company in the Read-Only DB User window in the SAP Business One
client application. For more information, see the SAP Business One online help.

For more information about configuring the way SAP Business One accesses your company, see Restricting
Database Access.

9.5.3 Add-On Access Protection

When you install an add-on, SAP Business One, version for SAP HANA creates a unique digital signature using the
MD5 technique (message-digest algorithm). SAP Business One, version for SAP HANA identifies the add-on by
validating its digital signature.

9.5.4 Dashboards

 Recommendation
When you receive dashboard content from your partner, before uploading it to the server, we recommend
that you copy this content to a computer that has a state-of-the-art virus scanning solution with the most
current virus signature database installed and scan the file for infections.

Dashboards are an element of the cockpit, which is delivered as part of SAP Business One, version for SAP HANA.
They present an easy-to-understand visualization, such as a bar or pie chart, of transactional data from SAP
Business One, version for SAP HANA. With SAP Business One, version for SAP HANA, SAP delivers predefined
dashboards for financials, sales, and service. In addition, SAP Business One, version for SAP HANA partners and
customers can create their own dashboards.
For more information about creating dashboards for SAP Business One, version for SAP HANA using SAP
Dashboards, look for How to Develop Your Own Dashboards on sappartneredge.com. Customers can find the
document in the documentation area of SAP Business One Customer Portal at
http://service.sap.com/smb/sbocustomer/documentation.
For creating dashboards using the Dashboard Designer, see the online help documentation.

9.5.5 Security Information for the Integration Framework

The subsections below outline the security aspects related to the following solutions:
· DATEV-HR solution
· Mobile solution

https://partneredge.sap.com/
http://service.sap.com/smb/sbocustomer/documentation
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· Request for quotation (RFQ)

9.5.5.1 Security Aspects Related to the DATEV-HR Solution

This scenario requires maximum levels of data security and sensitivity, because it exports personal data. The
DATEV-HR scenario generates employee data for DATEV eG using SAP Business One data. The integration
framework writes the data to a specified directory in the file system. Make sure that only authorized persons have
access to the folder.
Ensure that only authorized persons have access to the integration framework administration user interfaces.
Alternatively, collect confirmations from all users who have access that they are aware that this data is sensitive,
and that they may not distribute any data to third parties or make data accessible to non-authorized persons.

9.5.5.2 Security Aspects Related to the Mobile Solution

After the mobile user enters the correct user name and password, the front-end application passes the mobile
phone number and mobile device ID (MAC address), together with the user name and password, to integration
framework.
After receiving the information, the integration framework verifies the following:
· Whether the user is enabled as a mobile user
· Whether the necessary license is assigned to the user
· Whether it can find the telephone number and device ID pair in the SAP Business One user administration
· Whether the user name matches the telephone number and the device ID
· Whether the user has been blocked by the SAP Business One system
· Whether the provided password is correct

Then the user is allowed to access the system.
The password is encrypted while it is transmitted to the integration framework, which decrypts the password after
receiving it.

9.5.5.2.1 Using HTTPS

To make communication safer, you have the option to use HTTPS for the sessions in the integration framework.
On the server side you can configure the communication protocol (HTTP or HTTPS). On the client side, you have
the option to switch to the HTTPS protocol. By default, the solution runs with HTTPS, and the integration
framework allows incoming calls through HTTPS only.
SAP Business One mobile apps require a valid SSL certificate. For more information about obtaining and installing
valid certificates, see SAP Note 2019275.

https://service.sap.com/sap/support/notes/2019275
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9.5.5.2.2 License Control

All mobile users have to be licensed before being allowed to access the SAP Business One system through the
mobile channel. License administration is integrated with the SAP Business One user and license.
The mobile user also needs the assignment of the B1i license. Authorization within the SAP Business One
application depends on the user’s SAP Business One application license.

9.5.5.3 Security Aspects Related to the RFQ Scenario with
Online Quotation

 Note
The configuration information for the RFQ integration solution is available in the integration framework.
To access the documentation, logon to the integration framework, choose Scenarios ® Control, and for
the sap.B1RFQ scenario package, choose the Docu button.

You must provide vendors included in the RFQ process access to the online purchasing document on the
integration framework server.
You can accomplish this by restricting access to the server to a minimum. To restrict access to the server,
configure the network (NAT) firewall as shown below:
· Only allow external access to the particular hostname / IP-address
· Only allow external access to the configured server port.

Default: port 8080 for HTTP, or port 8443 for HTTPS
· If applicable and available for the particular firewall, configure the restricting URL:

http://<hostname>:<portnumber>/B1iXcellerator/exec/ipo/vP.0010000100.in_HCSX/com.sa
p.b1i.vplatform.runtime/INB_HT_CALL_SYNC_XPT/INB_HT_CALL_SYNC_XPT.ipo/proc?

9.6 Data Storage Security

The security of the data saved in SAP Business One, version for SAP HANA is generally the responsibility of the
database provider and your database administrator. As with your application infrastructure, most of the
measures that you should take depend on your strategy and priorities.
There are a few general measures, as well as database-specific measures, that you can take to increase the
protection of your data. Details are provided in the following sections:
· Adopting an appropriate backup policy
· Exporting the configuration file
· Importing the configuration file
· Configuration logs and user settings
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9.6.1 Backup Policy

To safeguard your data on the SAP HANA database, you must follow the relevant instructions in the SAP HANA
Administration Guide at http://help.sap.com/hana_platform. In addition, we recommend that you set up a
backup policy to regularly back up the entire SAP HANA instance and export each company schema.
To back up an SAP HANA instance, you need to manually create a cron job, as described in Backing Up SAP HANA
Instance Regularly. To export a company schema, you can use the backup service provided by SAP Business One.

 Note
For more information on using the remote support platform for server backup and company schema
export, see SAP Note 2157386.

9.6.1.1 Backing Up SAP HANA Instance Regularly

We recommend that you follow the procedure below to set up a backup schedule for the entire SAP HANA
instance. In case of database failure, you can recover the instance. The following procedure describes how to set
up a regular backup schedule for an SAP HANA instance.

 Note
With the back service, you can also manually back up the SAP HANA server instances in the System
Landscape Directory.
As of release 9.1 PL11, the backup service also supports backup of remote SAP HANA database servers.
The backup files are all stored on the machine where the backup service is installed.

Procedure

Make the following preparations:
o Create a backup user with the BACKUP OPERATOR system privilege and create a user key in the user

store, as below:
In the SQL console of the SAP HANA studio, execute the following SQL statements as an
administrative user (for example, SYSTEM):
create user <Backup User Name> password "<Password>";

alter user <Backup User Name> DISABLE PASSWORD LIFETIME;

grant backup operator to <Backup User Name>;

Log on to the Linux server as the <sid>adm user and execute the following command in a terminal:
hdbuserstore set USER4BACKUP localhost:3<Instance Number>15 <Backup User
Name> <Password>

For example: hdbuserstore set USER4BACKUP localhost:30015 BackupUser Pwd01
o Determine the oldest data backup that you want to retain on your SAP HANA server.

For example, your average data backup set is 8 GB per day and 400 GB of disk space is allocated to the
SAP HANA server. Then we recommend that you retain backups of the past 2 weeks and no more than 3

http://help.sap.com/hana_platform
https://service.sap.com/sap/support/notes/2157386
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weeks. In this case, your backups on the SAP HANA server are no more than 160 GB (approximately 20
days’ backup sets).

o Make sure that the sid user (for example, ndbadm) has the privilege to execute crontab.
Do the following to set up a regular automatic backup schedule:

Under the home directory of the sid user (for example, /usr/sap/NDB/HDB00/), create a shell with the
following script:
source $HOME/.bashrc

date="$(date +"%Y-%m-%d")"

time="$(date +"%Y-%m-%d %H:%M:%S")"

backup="backup data using file ('$date')"

echo "daily backup  :"  $time  "Start" >> $DIR_INSTANCE/backup.log

$DIR_EXECUTABLE/hdbsql -U USER4BACKUP -x $backup

time="$(date +"%Y-%m-%d %H:%M:%S")"

echo "daily backup  :"  $time  "End" >> $DIR_INSTANCE/backup.log

 Note
If you create the file on Windows, you must be sure to convert all line breaks (end of line, EOL) to the
Unix/Linux format. To do so, use either of the following methods:
o Before transferring the file from Windows to Linux, convert the line breaks to the Unix/Linux format.

For example, in Notepad++®, from the menu bar, choose Edit → EOL Conversion → UNIX/OSX
Format.

o On Linux, in the folder where you store the shell file, run the command dos2unix <Shell File
Name>.

Schedule the backup job in cron as the sid user, using the command crontab -e.

 Example
The shell is named as backup.sh and you want the backup job run at 05:30 a.m. each day:
30 05 * * * /usr/bin/sh /usr/sap/NDB/HDB00/backup.sh

Perform the following administrative tasks every day or based on your backup schedule:
o Check the latest backup and store a copy at an external location, as below:

In the SAP HANA studio, double-click the Backup folder under your system.
In the Backup editor, on the Backup Catalog tab, check the status of the latest backup.
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Copy the backup to a storage location or medium somewhere other than the SAP HANA server.
You can find the backup's current location in the backup details as well. In the example shown in the
above screenshot, the backup set includes six files, whose names all start with 2013-12-21; you
must copy all six files for recovery purposes.

o Delete all backups that are beyond the determined time point to ensure that there is enough space for
SAP HANA database's normal operations, as below:

In the Backup editor, on the Backup Catalog tab, right-click the oldest backup that you want to retain
and choose Delete Older Backups.
In the Backup Deletion of System xxx window, on the Specify Backup Deletion Settings page, select
Catalog and backup location and File system, and then choose the Next button.

On the Review Backup Deletion Settings page, choose the Finish button.
Confirm the deletion.

SAP HANA starts to delete selected data in the background. You can continue with other operations.
Note that this operation deletes both data backups and log backups.

Perform the following administrative tasks on a regular basis, as appropriate:
o Check the backup.log file to monitor backup activities. This file is generated in the same storage place as

the shell script.
o Delete backup copies on external storage that are old enough.

For more information, see SAP Note 1950261.

https://service.sap.com/sap/support/notes/1950261
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9.6.1.2 Exporting Company Schemas

You can use the backup service to export company schemas, import company schemas, and make regular export
schedules.

Prerequisites

· You have installed the backup service on the SAP HANA database server.
· You have logged on to the System Landscape Directory in a Web browser (URL: https://<SLD Server

Address>:<SLD Port>/ControlCenter).

9.6.1.2.1 Manually Exporting Company Schemas

Procedure

In the System Landscape Directory, on the Servers and Companies tab, in the Servers section, select the
server on which you want to perform export operations for a company schema.
In the Companies section, select the company for which you want to perform export operations.
Choose the Export Schema button.
In the Export Schema window, choose the OK button.

 Note
If the company schema is being exported in the background or you have already started to import a
schema to replace it, you will have to wait for the process to complete before you can choose the OK
button.

Result

In the System Landscape Directory, on the Servers and Companies tab, in the Companies section, the following
information is updated for the selected company:
· Export/Import Status: Displays the export result.
· Last Export/Import: Updated with the finish time of the export.
· Last Successful Export: Updated only if the export is successful.

On the Linux server, you can find the schema export at <Backup
Location>/<Server_Port>/<SID>/<Schema Name>. The naming convention for the schema export is
bck_<Timestamp>. Depending on your setting during the installation of the backup service, the schema export
may or may not be compressed in a zip file. The bck_actual symbol link points to the latest schema export.
To review the log for the export operations, select the company and choose the Show Export Log button.
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9.6.1.2.2 Creating Export Schedules for Company Schemas

You can define a schedule for exporting each company schema regularly.

Procedure

In the System Landscape Directory, on the Servers and Companies tab, in the Servers section, select the
server on which you want to perform export operations for a company schema.
In the Companies section, select the company for which you want to perform export operations.
Choose the Schedule Export button.
In the Schedule Export window, define the export schedule.
The company schema will be exported according to the specified frequency and time. By default, no export
schedule is set for any company schema.
To save the schedule, choose the OK button.

Result

In the System Landscape Directory, on the Servers and Companies tab, in the Companies section, the Export
Schedule field is updated for the selected company.
The company schema now runs on the defined export schedule. For more information, see the descriptions in the
Result section of Manually Exporting Company Schemas.

9.6.1.2.3 Importing Company Schemas

You can import a company schema in either of the following ways:
· Import the schema under the original name.
· Import the schema under a different name.

The export and import operations are based on SQL statements. You can manually execute these SQL statements
in the SAP HANA studio to export or import a schema (these procedures are introduced in the following sections).
If you want to manually import a company schema, do not use the with replace option. For example, import
<Schema Name>."*" as binary from '<Backup Folder>/bck_actual' with replace. Company
schemas usually reference objects in the SBOCOMMON schema. Using the with replace option would overwrite
the contents of the referenced objects in SBOCOMMON and may cause problems. Therefore, for manual import, you
must always use the with ignore existing option.
In addition, the following fields in the System Landscape Directory reflect only the status of operations invoked by
the backup service (in other words, export or import operations triggered by SQL queries in the SAP HANA studio
do not update these fields):
· Export/Import Status
· Last Export/Import
· Last Successful Export



178
CUSTOMER
© 2016 SAP SE or an SAP affiliate company. All rights reserved.

SAP Business One Administrator’s Guide, version for SAP HANA
Managing Security in SAP Business One, version for SAP HANA

Importing Company Schemas Under Original Names

Procedure

In the System Landscape Directory, on the Servers and Companies tab, in the Servers section, select the
server on which you want to perform import operations.
Choose the Import Schema button.
In the Import Schema window, in the Source section, select a source schema and then an export.
To start the import process, choose the OK button.

Result

This operation is equal to the following SQL statement:
drop schema <Schema Name>;

import <Schema Name>."*" as binary from '<Backup Folder>/<Backup>' with ignore
existing threads 10;

Data in the existing schema is completely replaced with data in the specified schema export.
The Export/Import Status and Last Export/Import fields for the company are updated with the import status and
time, respectively. To review the schema import log, select the company and choose the Show Export Log button.

Importing Company Schemas Under Different Names

You can use the following characters for a company schema name:
· Underscore (_)
· A-Z
· 0-9

Note that lower-case English letters and spaces are not allowed. In addition, the schema name must start with A-
Z.

Procedure

In the System Landscape Directory, on the Servers and Companies tab, in the Servers section, select the
server on which you want to perform import operations.
Choose the Import Schema button.
In the Import Schema window, in the Source section, select a source schema and then an export.
In the Destination section, do the following:

Select the Rename Target Schema checkbox.
In the Target Schema field, enter a new name.

 Note
If a schema with the specified new name already exists on the SAP HANA database server, before
executing the import command, you will be prompted to confirm whether or not you want to overwrite the
existing schema.

To start the import process, choose the OK button.
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Result

This operation is equal to the following SQL statement:
import <Schema Name>."*" as binary from '<Backup Folder>/<Backup File>' with ignore
existing threads 10 rename schema "<Schema Name>" to "<Schema New Name>";

The specified schema is imported into the SAP HANA database and renamed as specified. The old company
schema still exists.

 Example
import SBODEMOUS."*" as binary from
'/usr/hana/shared/backup_service/backups/HANAServer_30015/NDB/SBODEMOUS/bck_actu
al' with ignore existing threads 10 rename schema "SBODEMOUS" to "SBODEMOUS2";

The latest backup of company database SBODEMOUS is imported into the SAP HANA database server and
renamed as SBODEMOUS2. The old company schema SBODEMOUS still exists.

The Export/Import Status and Last Export/Import fields for the company are updated with the import status and
time, respectively. To review the log, select the company and choose the Show Export Log button.

9.6.2 Exporting Configuration Files

To secure your data, we recommend that you export your security configuration file right after you finish installing
the server tools (Linux) and the SAP Business One server, version for SAP HANA.
The configuration file contains the following important information:
· Site user password
· Database information
· Algorithm information

To export the security configuration file, proceed as follows:
To access the SLD service, in a Web browser, navigate to the following URL:
http://<Server Address>:<Port>/ControlCenter

In the logon page, enter the site user name (B1SiteUser) and password, and then choose the Log On button.

 Note
The site user name is case sensitive.

On the Security Settings tab, in the Configuration Import & Export area, choose the Export Configuration File
button.

 Caution
The site user password is required if you later import the security configuration file to restore the
configured security settings. Thus, keep a record of the site user password when you are exporting the
configuration file, especially if you want to change the site user password after the configuration file is
exported.
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9.6.3 Importing Configuration Files

If the server on which you install the SLD service crashes or is corrupted, you must restore all the security settings
after the new license server is started,

Prerequisites

· You have a record of your old security configuration file. For more information, see.
· You have placed the appropriate configuration file on the server under the directory: <SLD Installation

Folder>/Common/SLD/incoming/ (default: /opt/sap/SAPBusinessOne/Common/SLD/incoming/).

Procedure

To access the SLD service, in a Web browser, navigate to the following URL:
http://<Server Address>:<Port>/ControlCenter

In the logon page, enter the site user name (B1SiteUser) and password, and then choose the Log On button.

 Note
The site user name is case sensitive.

On the Security Settings tab, in the Configuration Import & Export area, choose the Import Configuration File
button.
In the Import Configuration File window, do the following:

Select the configuration file that you want to import.
In the Site User Password for Export field, specify the site user password you had when the configuration
file was exported.
To import the file, choose the OK button.

9.6.4 Configuration Logs and User Settings

In SAP Business One, version for SAP HANA, configuration changes are logged in files formatted as
xxx.pidxxxxx (xxxxx after pid can be the date, such as 20100325, so that you can find the latest log file) under
%UserProfile%\AppData\Local\SAP\SAP Business One\Log\BusinessOne.
The configuration changes include the following:
· Adding or removing users
· Changing a user to a superuser or non-superuser
· Changing user passwords
· Changing user permissions
· Changing password policy
· Changing company details
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 Note
To find the logs containing changes to company details, do the following:

In the SAP Business One Main Menu, choose Administration → System Initialization → Company
Details.
In the menu bar, choose Tools ® Change Log….

However, the following configurations cannot be logged:
· Changing data ownership authorizations
· Changing data ownership exceptions
· Changing license settings

If you fail to log on to SAP Business One, version for SAP HANA, the log is recorded in the Event Viewer. To access
the event viewer, choose Start → Control Panel → Administrative Tools → Event Viewer.
Any specific user settings are saved in a file named b1-current-user.xml under
%UserProfile%\AppData\Local\SAP\SAP Business One\Log\BusinessOne. In this situation, if a user
changes his or her settings in SAP Business One, version for SAP HANA, the changes are saved in this folder and
do not affect other users' settings.

9.7 Deployment

SAP Business One, version for SAP HANA is deployed on a machine with a Linux operating system. The
application contains a Tomcat server and works with an SAP HANA database server. When you install SAP HANA,
a non-root system user is created. The database server and the Tomcat server run with the same non-root system
user.
Once the Tomcat server is installed and deployed, it is necessary to protect the entire installation against any
unauthorized access to prevent unintended or malicious modification. By default, only the database user has
read, write, and execute permissions for the Tomcat directory. Other system users have read permission only.
To initialize company schemas on the SAP HANA database server, SAP provides a web-based Administration
Console. The Administration Console is a security sensitive application and access is limited to the Linux root
user. We recommend that the root user configure Tomcat to allow the Administration Console web access to the
local machine only (by default it is not configured). For more information about setting a request filter, see
Request Address Filter on the Apache Tomcat Web site.

http://tomcat.apache.org/tomcat-6.0-doc/config/valve.html#Remote%20Address%20Filter
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10 Troubleshooting

If SAP Business One, version for SAP HANA does not work as expected, you can check the following
troubleshooting information to identify your issues and find solutions, before contacting technical support.

Restarting SAP Business One Services on Linux

If one of the following services fails, you may need to restart the server tools:
· SLD service
· License service
· SBO Mailer service
· Analytics Platform service (SAP Business One analytics powered by SAP HANA)

 Note
For release 8.82 as well as release 9.0 PL10 and lower, you can stop and start the analytics platform
service using the following commands:
o Stop: /etc/init.d/b1ad stop
o Start: /etc/init.d/b1ad start

To restart the server tools, log on to the Linux server as root or the <sid>adm user (for example, ndbadm) and
then run the following command:
/etc/init.d/sapb1servertools restart

In addition, to stop or start the server tools, run the following commands respectively:
· /etc/init.d/sapb1servertools stop

· /etc/init.d/sapb1servertools start

Starting Samba to Access and Upgrade the Shared folder

To access the shared folder b1_shf on your Linux server, you must start the Samba component. Similarly, you
must start Samba when upgrading the shared folder; otherwise, the shared folder is not listed as a candidate for
upgrade in the setup wizard.

 Recommendation
Add Samba to the startup program list for your Linux server. This way, Samba is automatically launched
when the server is rebooted.
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Fixing Errors about Corrupt Installation or Registry Files

When upgrading or uninstalling the server tools, the SAP Business One server, or SAP Business One analytics
powered by SAP HANA, you may encounter errors that inform you of corrupt installation or registry files. The
possible causes are:
You have changed the installation or registry files improperly.
You have deleted the installation or registry files without running the proper uninstallation process.
To solve the issue, do the following:

Reinstall the SAP HANA instance that is used for installation.
Delete the entire directory where the corrupt installation files reside.
Clean up the InstallShield registry file /var/.com.zerog.registry.xml. To do so, remove all product
elements that contain one of the following:

o id=”e7fcf679-1f07-11b2-8b14-bdc7bfb1d41f”

o id=”2d5396f9-1f0f-11b2-984f-f5753618c50c”

Start the installation again.

Changing Xming Mode to Install Components on Linux

If you use Xming to provide a graphical interface on Windows when installing components on Linux, you may
encounter difficulty entering information into the wizard (for example, specifying the System Landscape Directory
server name). A possible solution to this problem is not to set Xming in the multiwindow mode, which is usually
the default option.
You can change the mode of Xming by using commands or the Xlaunch wizard. For more information, see
http://www.straightrunning.com/XmingNotes/.

Troubleshooting Service Layer Connection Problems

If you cannot connect to the Service Layer, there may be problems with the load balancer or a balancer member.
To identify the cause and fix the problem, do the following:

To access the balancer manager, in a Web browser, enter the following URL:
https://<Balancer Server Address>:<Port>/balancer-manager

If you cannot access the balancer manager, log on to the load balancer machine as root and restart the load
balancer using the following command:
/etc/init.d/b1s<Load Balancer Port> restart

In the balancer manager, check the status of each load balancer member. If a member is running abnormally,
log on to the load balancer member machine as root and restart the member using the following command:
/etc/init.d/b1s<Load Balancer Member Port> restart

If you can access the balancer manager and the status of all load balancer members is OK, but you still
cannot connect to the Service Layer, check the error log files on each machine on which Service Layer
components are installed. The error log files are located under <Installation
Directory>/logs/ServiceLayer with access log files and SSL request log files as below:
o access_<Load Balancer/Member Port>_log_<Date>: Records the requests sent or distributed to

the load balancer or the load balancer member.

http://www.straightrunning.com/XmingNotes/
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o error_<Load Balancer/Member Port>_log_<Date>: Records the errors which the Apache server
encounters.

o ssl_<Load Balancer Port>_log_<Date>: Records the SSL requests sent to the load balancer and is
relevant only to the load balancer.

 Note
The log format is defined by the corresponding Apache configuration file (httpd-b1s-lb.conf for the
load balancer and httpd-b1s-lb-member-<Port Number>.conf for load balancer members), which
is located under <Load Balancer/Member Installation Folder>/ServiceLayer/conf. For
more information, see the documentation about the mod_log_config module at
http://httpd.apache.org/docs.
We recommend that users do not modify Apache configuration files. However, if you need to modify the
configuration files, be aware of the following points:
o After changing an Apache configuration file, you must restart the respective Service Layer

component in order for the changes to take effect.
o After you upgrade the Service Layer to a higher version, all changes made by you will be lost. On the

contrary, changes made by tools like the Service Layer configurator will be kept. For more
information, see Service Layer in the post-installation chapter.

If you want to restart all local Service Layer components (load balancer and load balancer members), use the
following command:
/etc/init.d/b1s restart

The start and stop commands are also valid for the Service Layer. For example, /etc/init.d/b1s stop
stops all local Service Layer components.

Imported Company Schema Is Not Displayed in the Company List

Prerequisites:

· You currently use database user A for database connection. To verify this, in the System Landscape
Directory, on the Servers and Companies tab, edit your server and review the Database User Name field.

http://httpd.apache.org/docs
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· Both database users in question (A and B) have all the necessary privileges, as described in Database
Privileges for Installing, Upgrading and Using SAP Business One.

Scenario:

In the SAP Business One client, create a new company TESTDB (schema name).
In the SAP HANA studio, do the following:

Connect to your server as either database user A or B, and then export the company schema TESTDB.
Connect to your server as database user B and import the company schema TESTDB.

Open the SAP Business One client or log on to the System Landscape Directory.

Problem:

The imported company schema is not displayed in the company list.

Cause:

Database user A does not have access to or modification privileges on the imported company schema.

Solution:

In the SAP HANA studio, connect to your server instance as database user B.
Grant to database user A full object privileges on the imported company schema.

Cannot Use Excel Report and Interactive Analysis

Prerequisite:

You have installed Excel Report and Interactive Analysis to a folder that is not in the %ProgramFiles% directory.

Problem:

After installing Excel Report and Interactive Analysis, you cannot use it: the add-in cannot be loaded in Microsoft
Excel.

Cause:

The Excel Report and Interactive Analysis add-in was only partly installed.

Solution:

Make the Excel Report and Interactive Analysis add-in available in Microsoft Excel
In the Windows menu, choose SAP Business One Excel Report and Interactive Analysis .
An error message is displayed and informs of a failed installation.
Ignore the error message by clicking OK.
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In Microsoft Excel, activate the Excel Report and Interactive Analysis COM add-in.
For instructions on how to manage add-ins, see the Microsoft online help.
In the Windows menu, choose SAP Business One Excel Report and Interactive Analysis again.
This time the installation is successful.

You can now launch Excel Report and Interactive Analysis from within the SAP Business One client or from the
Windows menu.

Fixing Java Heap Issues

When initializing large-sized company schemas in the Administration Console for SAP Business One analytics
powered by SAP HANA, you may encounter a “Java heap” issue.
The Java heap is the part of the memory where blocks of memory are allocated to objects and freed during
garbage collection. Use the JAVA_OPTS environment variable to specify the maximum allowed Java heap size. By
default, the value is set to JAVA_OPTS=-Xmx4096m.
To fix this issue, set JAVA_OPTS to a higher value, and then restart the Tomcat server.

Turning on Trace and Log for Excel Report and Interactive Analysis

Problems may arise when you use Excel Report and Interactive Analysis. To analyze the cause of problems, you
can turn on ODBO trace and log in Microsoft Excel to generate a log file, which provides details for the OLE DB and
MDX API and the operation of the SAP HANA client layer.
To turn on trace and log for Excel Report and Interactive Analysis, do the following:

In Microsoft Excel, choose Data → From Other Sources → From Data Connection Wizard.
In the Data Connection Wizard window, select Other/Advanced, and choose the Next button.
On the Provider tab of the Data Link Properties window, select SAP HANA MDX Provider, and choose the Next
button.
On the Advanced tab, select Enable ODBO provider tracing. Specify a location to store the log file and choose
the OK button.

The application generates a log file in the specified location to assist with troubleshooting.

Setting Connection Configuration & Timeout Variables for SAP Business One
analytics powered by SAP HANA

SAP Business One analytics powered by SAP HANA provides environment variables that you can use to configure
connections and timeout settings. You may need to set these variables to fix related issues.
If you want variable settings to be effective not only for the current session, you must add them to the
<Installation Directory>/tomcat/bin/B1Astartup.sh file.
The following table provides an overview of the variables and their default values.

Variable Description Default Value

CONNECTION_MAX_ACTIVE Specifies the maximum number of active
threads for the connection pool.

1000
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Variable Description Default Value

CONNECTION_MAX_IDLE Specifies the maximum number of idle threads
for the connection pool.

10

CONNECTION_MAX_WAIT Specifies the maximum waiting time. 5000 (microseconds)

LICENSE_CONNECTION_TIM
EOUT

Specifies the amount of time, in seconds, to
wait for the license server connections.

6 (seconds)

Changing Logging Levels in the Tomcat Server

If SAP Business One analytics powered by SAP HANA does not work as expected, as the system administrator,
you may need to change to a lower logging level in the Tomcat server (Linux server) to get more information about
the system's behavior.

 Note
The log file analyticService.log is located by default under
/usr/sap/SAPBusinessOne/AnalyticsPlatform/tomcat/logs.

To change the logging levels in the Tomcat server, do the following:
Open the log configuration file log4j.xml using a text editor.

 Note
By default, the configuration file is located under
/usr/sap/SAPBusinessOne/AnalyticsPlatform/conf.

In the configuration file, change the logging level according to the standards of Apache log4j. For more
information, see the Apache documentation at http://logging.apache.org.
Restart SAP Business One analytics powered by SAP HANA. For more information, see the troubleshooting
section “Restarting SAP Business One Services on Linux”.

Diagnosing SAP Business One Client Connectivity Issues (or Ensuring Correct
Network Settings for SAP Business One Clients)

If it takes a much longer time than usual (for example, 4 minutes) for your SAP Business One client to connect to
SAP HANA, you may need to check your network settings, including but not limited to:
· TCP/IP properties
· Firewall settings
· Mapping of the hostname to the IP address
· DNS
· Default gateway
· Network card
· Ipv4 versus Ipv6 (for example, are you using Ipv4 while your network actually supports Ipv6?)

In addition, you can use the PING command to determine the IP address of your client or server machine, and help
identify network problems.

http://logging.apache.org/
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Blocking Security Alerts

If you are using Microsoft Windows Internet Explorer, and have not installed an appropriate security certificate, a
security alert may appear in the following scenarios:
· Using enterprise search
· Designing pervasive dashboards
· Using cash flow forecast
· Checking ATP
· Scheduling deliveries

To install a security certificate, proceed as follows:
In the Web browser, navigate to the following URL:
https://<Server IP Address>:<SLD Port>/IMCC

Click the Continue to this website (not recommended) link.
In the toolbar, choose Safety → Security Report.
The Certificate Invalid window appears.
In the Certificate Invalid window, click the View certificates link.
The Certificate window appears.
On the General tab of the Certificate window, choose the Install Certificate… button.
The Certificate Import Wizard welcome window appears.
In the welcome window, choose the Next button, and in the Certificate Store window, select the Place all
certificates in the following store radio button.
In the Certificate Store window, choose the Browse button. In the Select Certificate Store window, select the
certificate store Trusted Root Certification Authorities, and choose the OK button.
In the Certificate Store window, choose the Next button, and in the Certificate Import Wizard complete
window, choose the Finish button.
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In the Security Warning window, choose the Yes button.
A message appears indicating that the security certificate was imported successfully.
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11 Getting Support

We recommend that you assign a contact person who can deal with issues concerning SAP Business One, version
for SAP HANA. This contact person should follow the support process described below. If a problem cannot be
solved using this process, contact SAP support.

 Note
Before you contact SAP support, check the version information of your SAP Business One application,
version for SAP HANA.
To view the version number, from the SAP Business One Help menu, choose About.

You can get support from your partner using either the Customer Portal or the Hotline.
The Hotline is a number provided by your partner that you can call to get support during official support hours.
The partner support staff logs the problem on SAP Service Marketplace. The partner support staff tries to solve
your problem. If they are unsuccessful, they forward the problem to the SAP Support team.

 Recommendation
You can log your problem message in SAP Business One Customer Portal at
http://service.sap.com/smb/sbocustomer/documentation. This lets you track the status of the
message. Your SAP Business One partner can provide a user name for this portal. There you can find
more information about how to create a message and track its status.

11.1 Using Online Help and SAP Notes

If you have a question or problem concerning SAP Business One, version for SAP HANA, check the online help by
pressing F1 . Note that the Help menu in the application provides more help options.
If online help does not provide an answer, search for corresponding SAP Notes, as follows:

Log on to the SAP Business One portal as follows:
o If you are a partner, log on to sappartneredge.com.
o If you are a customer, log on to https://service.sap.com/smb/sbocustomer.

Choose the SAP Notes option.
You can either display a note directly by providing the number of the note, or you can search for a note by
entering key words. Think about the keywords to use, and choose the application area.
The application area for SAP Business One starts with “SBO”.

 Example
Problem Message: “The performance of the SAP Business One, version for SAP HANA program is not
acceptable. Executing all operations takes a long time. The problem occurs only on one front-end.”
Use: Keywords Performance and SAP Business One. Specify the component SBO-BC*.
Do not use: Phrases such as SAP Business One runs long or SAP Business One is too slow.

http://service.sap.com/smb/sbocustomer/documentation
https://service.sap.com/smb/sbocustomer
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11.2 Using the Support Desk

You can use the support desk to search for known solutions in the SAP support database on SAP Service
Marketplace. The support desk establishes a direct link to SAP Service Marketplace, which stores all the known
solutions to known problems.
For more information, see the online help for SAP Business One, version for SAP HANA on the SAP Business One,
version for SAP HANA product DVD or in the documentation area of SAP Business One Customer Portal at
https://service.sap.com/smb/sbocustomer/documentation.

Prerequisites

You have a valid S user ID number.
An S user has authorization to access online support functions offered by SAP. The S user ID information is
shipped with the SAP Business One, version for SAP HANA product. If this information is missing or incorrect,
contact your SAP Business One partner.

Procedure

To find solutions on SAP Service Marketplace, proceed as follows:
In the SAP Business One, version for SAP HANA menu bar, choose Help →Support Desk → Find a Solution.
The Support Desk – Find a Solution window appears.
In the Search Term field, enter one or more words for which to search.
You can search for key words or phrases of up to 60 characters.
Choose the Find button.
The system calls up the connection to SAP Service Marketplace.
Specify your S-user ID and password.
The system defaults your search criteria and the application area to SBO* and starts the search.

https://service.sap.com/smb/sbocustomer/documentation
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Appendix

Appendix 1: List of Prerequisite Libraries for Server Component
Installation

The following table lists the prerequisite third-party libraries and their version requirements:

Third-Party Library Version Requirements Remarks

cyrus-sasl ≥ 2.1.22-182.20.1 /

glibc ≥ 2.11.3-17.31.1 /

glibc-i18ndata / /

keyutils-libs ≥ 1.2-107.22 /

krb5 ≥ 1.6.3-133.48.48.1 /

libaio ≥ 0.3.109-0.1.46 /

libcom_err2 ≥ 1.41.9-2.7.1 /

libcurl4 ≥ 7.19.7-1.18.1 /

libgcc46 ≥ 4.6.1_20110701-0.13.9 /

libgcc_s1 ≥ 4.8.3+r212056-2.17 /

libgcrypt11 ≥ 1.5.0-0.13.14 /

libgpg-error0 ≥ 1.10-0.7.29 /

libidn ≥ 1.10-3.18 /

libldap-2_4-2 ≥ 2.4.26-0.12.1 /

libstdc++46 ≥ 4.6.1_20110701-0.13.9 /

libstdc++6 ≥ 4.8.3+r212056-2.17 /

openssl ≥ 0.9.8h /

pam ≥ 1.1.5-0.10.17 /

python ≥ 2.6.8, < 3.0.0 /

zlib ≥ 1.2.3-106.34 /

xorg-x11-libXext ≥ 7.4-1.18.1 For GUI installation

xorg-x11-libXrender ≥ 7.4-1.16.1

xorg-x11-libs ≥ 7.4-8.26.36.1
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 Note
To check whether any of the prerequisite libraries are installed, and whether they are of the correct
version, do the following:

Insert the SUSE Linux Enterprise Server 11 installation DVD into the DVD drive on your server.
Start YaST.
In the software management module of YaST, search for the corresponding library.
If the checkbox for the library is not selected, select the checkbox and choose Accept to install the
library.
If required, update the library to the latest version.

Appendix 2: List of Integrated Third-Party Products

SAP Business One, version for SAP HANA integrates with various third-party products, some of which are
licensed by SAP; others are not.
The third-party software products listed in the table below are fully or partly integrated with SAP Business One,
version for SAP HANA but are not licensed by SAP:

Third-Party Product Supplier

SEE4C v7.1 MarshallSoft Computing, Inc.

Victor Image Processing Library v6.0 Catenary Systems Inc.

Visual Parse++ 5.0 XPF (Cross-platform edition) Sandstone Technology Inc.

ComponentOne VSFlexGrid 7.0 Pro (UNICODE) ComponentOne

DynaPDF 3.0 DynaForms GmbH

InstallShield 2011 (ISSetup.dll) Flexera Software LLC

InstallAnywhere 2011 Enterprise Flexera Software LLC

The following third-party products are owned by SAP and are fully or partly integrated with SAP Business One,
version for SAP HANA. These products may also include third-party software.
· Chart Engine 620 Release
· SAP Crystal Reports 2011 for SAP Business One (Runtime)
· SAP Crystal Reports 2013 for SAP Business One (Runtime)
· SAP Crystal Reports 2011 for SAP Business One (Designer)
· SAP Crystal Reports 2013 for SAP Business One (Designer)
· SAP License Key library 720
· SBOP Business Intelligence Platform 4.0 .NET SDK Runtime FP3
· SAP JVM 8.1
· SAP HANA Platform Edition 1.0
· SAML2 library (JAVA)
· SAP HANA EclipseLink Platform plugin
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· SAPGENPSE
· SAP Cryptographic Library (libsapcrypto.so)
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Appendix 3: List of Localization Abbreviations

Abbreviation Localization

AR Argentina

AT Austria

AU Australia

BE Belgium

BR Brazil

CA Canada

CH Switzerland

CL Chile

CN China

CR Costa Rica

CZ Czech Republic

DE Germany

DK Denmark

ES Spain

FI Finland

FR France

GB Great Britain

GT Guatemala

HU Hungary

IL Israel

IN India

IT Italy

JP Japan

KR Korea

MX Mexico

NL Netherlands

NO Norway

PA Panama

PL Poland
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Abbreviation Localization

PT Portugal

RU Russia

SE Sweden

SG Singapore

SK Slovakia

US United States

ZA South Africa
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